Data manipulation

Click the cursor in the - cell for the new car and add “Ford’. The new 1D
number will automatically appear in the field, as you sc,t thIS field as an
AutoNumber type. Move the cursor and enter the Colour rand
in the same way. You can always use copy and paste for some data. For example, if
you need to make sure the spclhng of Escort is correct, copy and paste it from
record 67 above. For the and 5Peice fields, enter only the numbers (and
decimal point if this is required). Do not attempt to enter any other characters like
the currency symbol. As you press the <Enter> key after addmcr the prices Access
will set the data into currency format. The Vales field will automatxmﬂv default to
No. Move into this field and enter Yes in this cell. As you enter each item of data
Access will automatically save it.

Check your data entry carefully using visual verification. This is when you
compare the original data on paper (in this case, in Task 11b) with the data that you
have entered into the computer. Any data entry error in a database mayv cause you
errors when you try to use the database to search or sort. Save the database.

Open the file that you saved at the end of Task 11b.

Add a new field to the database called PDate. Add the purchase date of 30 September 2009
for the next record.

Open the database and open the table

Field Name

tblCars in Design View. Move to the empty "1 o

row below the “2iet field and enter the i =w

Fieldname : v e
In the Data Type box use the drop- down\ e

list to select the Date/Time type.
Choose the most appropriate Format for
the question. In this case, the task asks for a
Long Date format.

Save the database and select the :
Datasheet View. Move the cursor into the e e i
PDate field for the new record (the Silver Ford Escort) and use the Calendar icon
to select the correct date.
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Activity 1 1b

Open the file saved in Activity 11a. Add these three items of stationery to the database.

Code | Type Description Quantity | Colour | SPrice | PPrice | Discount
44282 | Lever Arch File | Laminated Lever | 1 Red 57.22 12896 | N
Arch Files
44283 | Lever Arch File | Laminated Lever | 1 Yellow | 57.22 | 2896 | N
Arch Files
47478 | Spine Label Eastlight Spine 100 30 13.86 | Y
Lables

11.4 Performing searches

In Access you can search for data using a Query. This will allow you to select a
subset of the data stored in your table. Each query is created and saved and can be
used again later. Even if new data is added to the table, when you open a query
again it will select the subset from all the data, including the new data.

Task 11d

Open the file that you saved at the end of Task 11c.

A customer would like a car made by Ford. Find the customer a list of all the cars in the
garage made by Ford.

Open the database that you saved at the end of Task 1lc. You do
not need to open the table that you created earlier. Select the
Create tab and find the Other section on the right. Click on the
Query Wizard icon.

This is the easiest way of performing a search and opens the
New Query window. Select the Simple Query Wizard and click on .0

In the Simple Query Wizard window,
make sure that the table name has been
selected in the Tables/Queries box. As this is
your first query this is the only option in this
box, but each time you create a new query it B —
will be shown here. If you select a previous vt el St s
query rather than the table, you are likely to
get incorrect results.

For Task 11d, it would be appropriate to
show the customer all the fields except the 11>
field, the price that the garage bought the car
tor (the - field) and the date the garage
purchased the car (the ¢ tield). Move all
of the fields into the query using the double
arrow key.

Select the 117 field, the "I'rive field and the | mewes = ° 775
tield in turn and click on the single —~ fsiate e e s

arrow to remove them from the selection. ?(
When you have got only the required fields,

click mea> . Select _mex> again. |

Guery Query Mato!
{Wizard Designr ~ :

Which fields do you want in your query?

(ou can chaose from more than ene t2ble of query,

TR

Which Relds do you wantin your quary?

You can chaose from more then one table or query.

e ey




Data manipulation

Enter a name for the query. This query
may be turned into a report at some point
and the name you give the query may become [}
the title for the report. You may therefore _—
wish to add your name to the query name.

Select the radio button for Mochfy the —_ |
query design before clicking on .

This opens the query in D631gn Vlew

— Datasheet View can be seen by selecting the : e
drop-down list under the View icon. Comed Lo ] oo e ]
However, at the moment the query will still
contain all of the records as we have not yet performed the search.

To perform the query, move the cursor into the Criteria: row of the field
and type Ford. You do not need to use speech marks, as Access will put these in for
you. This will extract only the cars made by Ford.

What e do you vant for your quesy?
Grabam Brown Ford Quary

That's o e information the vazard reeds to create your
auery.

Do yau vant to open the query or modify the query's deagn?

¥ Dpen the Guery to view informationt,

7 Propedy Sheet
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Now select the Datasheet View to see the results of the query. The number of
records can be seen at the bottom of the window in this view. There should be 25
Ford cars in the query. Save the query.

Task iie
Open the file that you saved at the end of Task 11d.
The manager would like to see all the details of all the Fords that need valeting.




Information and Communication Technology

Hint Create the query in a similar way to the one for Taskl 1d. Select all the tfields and
.. Y * ; fur
This is called an when you Modlfy the query de51gn enter Ford in \the Criteria: row of the
AND Query, column and Yes in the same Criteria: row tor the ¥ column. The sclection will
because the Vake look like this and only two cars will be found using this search.
has to be Ford AND
the ¢ field has Feid: {ptake]  ([Model) [ [Colou  (PPricel  ((SPrcel  fear)  (Berar) | (vale i (PDate]
'to be Yes. hsbit: oiCars thiCars LtbiCars thiCars JipICars itbiCars i thtCars ‘tolCars AbICars 1@
th H : H ! H i :
sl @ o owm ow @ o®m @ ®w @ m
Critefia: I "Ford” Yes
R v
b L&l > ‘F

Task 1 if

Open the file that you saved at the end of Task 11e.
The manager would like to see all the details of all the cars made by Ford or Vauxhall.

Create the query in a similar way to the one for Tasklle. In the Simple Query
Wizard window, make sure that the table name has been selected in the
Tables/Queries box. If you select one of the previous queries rather than the table,
vou are likely to get incorrect results.

Select all the fields and when you Modify
the query design, enter Ford or Vauxhall in

‘ Make] [Mode]}
the Criteria: row of the ! - column. The o icars jtotcars jrotcars
g e . - . . i show : @ !

selection will look like this and 37 cars will be L e rord Ol

tound using this search. or
Task Iig

Open the file that you saved at the end of Task 11f.
The Sales Manager would like to see all the details of all the cars in stock not made by Ford.

Create the query in a similar way to the one for

| fietd: {0 | vk {Med
Task11f. Select all the fields and when you L Tabie [totcans oo Hofcars
: ; Sotk: / :
Modify the query design, enter Not Ford in z show @ g
the Criteria: row of the | column. The A NotTFord”

selection will look like this and 43 cars will be
found using this search.

Taslc iih
Open the file that you saved at the end of Task 11g.
The manager would like to see all the details of all the cars that have alloy wheels.

By examuining the data in the database you can see that the text “Alloy Wheels’ could
appear in thL Extras field. It may not be the only extra that a car has, there could be
other extras listed betore it or after it within the field.

To find all the cars with this extra you must create the query in a similar way as
for Task1lg. Select all the fields and when you Modify the query design, enter
*Alloy Wheels* in the Criteria: row ot the ; columin. The stars tell Access that




Data manipulation

Click the cursor in the : cell for the new car and add ‘Ford’. The new ID
number will automatically appear in the {13 field, as you set this field as an
AutoNumber type. Move the cursor and enter the »and
in the same way. You can always use copy and paste for some data. For example, if
you need to make sure the spelling of Escort is correct, copy and paste it from
record 67 above. For the and 5rice fields, enter only the numbers (and
decimal point if this is required). Do not attempt to enter any other characters like
the currency symbol. As you press the <Enter> key after adding the prices Access
will set the data into curr ency format. The Vulet field will mtomamcallv default to
No. Move into this field and enter Yes in this cell. As you enter each item ot data
Access will automatically save it.

Check your data entry carefully using visual verification. This is when you
compare the original data on paper (in th1s case, in Task 11b) with the data that you
have entered into the computer. Any data entry error in a database may cause you
errors when you try to use the database to search or sort. Save the database.

Open the file that you saved at the end of Task 11b.

Add a new field to the database called PDate. Add the purchase date of 30 September 2009
for the next record.

Open the database and open the table

tblCars in Design View. Move to the empty "5, o ‘ )
row below the ¥ :ict field and enter the o .
Fieldname ! : R i

In the Data Type box use the drop- down\gm‘ e

list to select the Date/Time type.
Choose the most appropriate Format for
the question. In this case, the task asks for a
Long Date format.

Save the database and select the
Datasheet View. Move the cursor into the i
PDate field for the new record (the Silver Ford hsco1t) and use the Calendar icon
to select the correct date.

lsnm Date
‘lona Time
{Medium Tine a;)wn
\henhme w738
o Cantral

tane

isDlsy tayzet far the

Fréx FLfor et oa o

67 Ford Escont Sitver £3,450.00 £4,295.00 2004 Ajr Conditioning Centratlocking
69 Ford Escort Siver £4,350.00 £5,285.00 2002 Alarm Centrattocking AlloyWheels —  Yes
{New)} K

Fr 5a St

L1202 4
7 8 910 1
14 15 16 17 18
21 22 3 24 25 25
2329 3 .

Mo Tu We Th

8B G e




Information and Communication Technology

Activity 1 1b

Open the file saved in Activity 11a. Add these three items of stationery to the database.

I
Code | Type Description Quantity [ Colour | SPrice | PPrice Discounﬂ
44282 | Lever Arch File | Laminated Lever | 1 Red 57.22 12896 | N
Arch Files
44283 | Lever Arch File | Laminated Lever | 1 Yellow | 57.22 |28.96 | N
Arch Files
47478 | Spine Label Eastlight Spine 100 30 13.86 | Y J
! Lables | : |

11.4 Performing searches

In Access you can search for data using a Query. This will allow you to select a
subset of the data stored in your table. Each query is created and saved and can be
used again later. Even if new data is added to the table, when you open a query
again it will select the subset from all the data, including the new data.

Task i 1d

Open the file that you saved at the end of Task 11c.

A customer would like a car made by Ford. Find the customer a list of all the cars in the
garage made by Ford.

Open the database that you saved at the end of Task 11c. You do

not need to open the table that you created earlier. Select the PN e
Create tab and find the Other section on the right. Click on the W aih [?ef,‘f;f, 2o
Query Wizard icon. e,

This is the easiest way of performing a search and opens the ‘
New Query window. Select the Simple Query Wizard and click on .

In the Simple Query Wizard window,
make sure that the table name has been :
selected in the Tables/Queries box. As this is | e m———

o s o mere o b o e
your first query this is the only option in this
box, but each time you create a new query it
will be shown here. If you select a previous
query rather than the table, you are likely to
get incorrect results.

For Task 11d, it would be appropriate to
show the customer all the fields except the
field, the price that the garage bought the car
for (the 7""+1v2 field) and the date the garage
purchased the car (the 172 field). Move all
of the fields into the query using the double
arrow key.

Which fields da you wiant in your Quary?

‘025 can cheoge from mare than ane table or query,

Select the 11> field, the ¥ ¥ rice field and the | fwss: " 7
P e £ . o N N - Avaiable Fields: Sedected Fields:
e freld in turn and click on the smglc\ -

arrow to remove them from the selection.
When you have got only the required fields,
click _text> . Select _pext>. again.




Data manipulation

Enter a name for the query. This query
may be turned into a report at some point
and the name you give the query may become
the title for the report. You may therefore _—
wish to add your name to the query name.

Select the radio button for Modify the
query design before chckmg on _ o

This opens the query in Design V1ew
Datasheet View can be seen by selecting the
drop-down list under the View icon.
However, at the moment the query will still
contain all of the records as we have not yet performed the search.

To perform the query, move the cursor into the Criteria: row of the > field
and type Ford. You do not need to use speech marks, as Access will put these in for
you. This will extract only the cars made by Ford.

Simple Query

What ote do you want fos your query?
‘Grabm Bromn Ford Query

That's o the informabion the wizard needs to areate your
query,

Do you wiant t open the cuery or madify the quary's design?

Open the MY to view information.

ralnsert Rows

;(9 @ Union :
* @ passThrough
Make Append Update Crasstab Delete

X Delete Rows 4 Delete Columns i
i Totals 2

2 Show ) P ¢ - .
32, D3ta Detintion 1 Taple o Builder 3 Return: Al h]Pammntrs

- QuerySetup

-
@\ 4
t T n
Fretd: kmake} “Model {{Catour] { [SPrice) {reaq *{Extras} | pvatet)
Table: Roicars thiCars JthiCars  thicars thiCars itbiCars “tuiCars
sert: | : : : H :
Shows el . & w : @ : fed) & ) )
Criteriar
or:
g‘ Bl »

Now select the Datasheet View to see the results of the query. The number of
records can be seen at the bottom of the window in this view. There should be 25
Ford cars in the query. Save the query.

fie

S

g
128K

Open the file that you saved at the end of Task 11d.
The manager would like to see all the details of all the Fords that need valeting.
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Create the query in a similar way to the one for Taskl1d. Select all the fields and

Hint
This is called an when you Modify the query design, enter Ford in the Criteria: row ot the
AND Query, column and Yes in the same Criteria: row for the column. The selection will

look like this and only two cars will be found using this search.

because the Miake
has to be Ford AND

the vaiet field has ; : : : — =
Fieid: [ Maxe] (Mode} 1[Colour) [PPrice] +[5Price) Hrean] | {Extras] i[Valey i [PDate] e~ l
to be YeS. Tabte: (toiCass  tbiCars ‘1biCars toiCars  itbiCars tbiCars tbiCars tbiCars  (thiCars E}
Sort: : { : : { {
sows | . @ 1 ®m . @ L ® @ ] @ g
Critesia: | Fora™ Yes
or: A
q s »

Task Hif
Open the file that you saved at the end of Task 11e.
The manager would like to see all the details of all the cars made by Ford or Vauxhall.

Create the query in a similar way to the one for Tasklle. In the Simple Query
Wizard window, make sure that the table name has been selected 1in the
Tables/Queries box. If you select one of the previous queries rather than the table,
you are likely to get incorrect results.

Select all the fields and when you Modify
the query design, enter Ford or Vauxhall in
the Criteria: row of the | column. The
selection will look like this and 37 cars will be
found using this scarch. :

| Make] | Model)
| thiCars ithiCars

i & :
“Fard” Or “Vauxhall®

Criterta:
an

Task g

Open the file that you saved at the end of Task 11f.
The Sales Manager would like to see all the details of all the cars in stock not made by Ford.

Create the query in a similar way to the one for

N ~ ; Field: | ID) Ly | Mod
Taskl1f. Sclect all the fields and when you | Tamte |ocars oo s
. . . i Sort: i |
Modify the query design, enter Not Ford in  show @ @

the Criteria: row of the » column. The — —> tot Fore”

selection will look like this and 43 cars will be
tound using this search.

Task ilh

Open the file that you saved at the end of Task 11g.
The manager would like to see ail the details of all the cars that have alloy wheels.

By examining the data in the database you can see that the text “Alloy Wheels’ could
appear in the Extras field. It may not be the only extra that a car has, there could be
other extras listed before it or after it within the field.

To tind all the cars with this extra you must create the query in a similar way as
for Taskl1g. Select all the fields and when you Modify the query design, enter
*Alloy Wheels* in the Criteria: row of the Fxirias column. The stars tell Aceess that




Data manipulation

Hint

To search for
something that is at
the start of the
data, use Text*, for
example BI* in the
Colour field will
find all the cars
with the first
Colour Blue or
Black, but would
not find colours like
Light Blue. Placing
the star at the start
of a search string
will only find those
things ending with
the search string.

11.5

you are performing a wildcard search. The
selection will look like this and 35 cars will be
found using this search.

| [Extras]
ItblCars

| [Valetj
{tblCary

! [ !
Like “*Alloy Wheels*" l

an

Task i1

Open the file that you saved at the end of Task 11h.
The Sales Manager would like to see details of all the cars in stock for sale for less than or
equal to £4125.

Create the query in a similar way as for | R colour srice vear
7 . | Table: |tblCars ;tbtCars itbiCars
Taskllg. Be careful not to use any symbols like | so |
- y - i aw: : W
< or £ in the query name. Select all the fields | crteria <=4125
|
i

and when you Modify the query design, enter
<=4125 in the Criteria: row of the > column. The selection will look like this
and 18 cars will be found using this search.

Similar mathematical formulae can be used, with < for less than, > for greater
than, >= for greater than or equal to and = for equals. These mathematical
formulae cannot be used for queries involving text fields, but can be used for any
numeric, date or time fields.

Activity tic
Open the file saved in Activity 11c.

Search the database to find the following information for your manager. For each search
show all the fields in the table.

Find all the blue stationery items.

Find all the blue or black stationery items.

Find all the items where the colour is not blue.

Find all the red items where the discount is yes.

Find all the items where the type contains the word ‘file’.
Find all the items where the description contains the word ‘file’.
Find all items with a quantity of less than or equal to 10.
Find all items where the quantity is 10.

Find all items with a quantity of greater than 1.

Find all items with a quantity of greater than or equal to 10.
Find all items where the sales price is less than £10.

oW NOUTEh, WN =

—_

Producing reports

The word ‘report’ can be quite confusing. A dictionary definition is ‘a document that
gives information about an investigation or a piece of rescarch’. For the practical
examinations a report has this generic meaning: ‘a document that gives information’.
This is often confused with a report created in Access. The report created in Access
will often be the most suitable report for a task, but sometimes it may be better to
produce a report in a word processor, copying and pasting information into a
document. For each task, you will need to decide which method is the most suitable.
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Hint

You must create
the query first and
then base the
report upon the
query.

Task 11]

Open the database that you saved at the end of Task 11i.
Produce a report which:

® shows all the cars made by Ford

@ displays only the !
a landscape page

@ has your name on the left in the header of each page

@ has a title ‘All Ford cars in stock’ centre aligned at the top of the first page

@ has a subtitle 'request for Mr David Watson' right aligned at the top of the first page.

fields within the width of

Open the database saved in Task 11i. Select the Create tab and -
find the Reports section. Click on the Report Wizard icon to
open the Report Wizard window.

In the Tables/Queries box you need to
select the correct query. For this task, the
report will be based upon the query to select
only the Fords (you created this query in
Taskl1d). Use the arrow buttons to move the
correct fields from the Available Fields: into
the Selected Fields: box like this, then click
on _ext>_. Grouping is not needed at IGCSE
level, so click on Taees again. For this task,
you are not asked to sort the report (which
will be covered later in the chapter), so click
on _metz. again to get this.

The task told you to select a single landscape
page. The page orientation is chosen using the

Wihich fields do you want on your feport?

You can choose from more than one Labla or query.

Orentaton

Orientation radio buttons. Select Landscape. Use sutied E;:*‘

the Layout section to choose how the page will be
laid out; in this case a tabular format has been
selected. Click on wlietz.

Choose the style for your report and click on
~tex> . Change the report name, so that it is “All
Ford cars in stock’ (which is the title from the
task). As you still need to add the subtitle and
ensure that the layout is correct, select the Modify
the report’s design radio button and click on
nish .. The design view of the report will look
similar to this.

Adpst the field width =0 a1 fieks fiton
apage.

ontrol from Dezall




Data manipulation

Each section of the report is shown with a light blue bar. The top section is the
Report Header. Anything that you place in this section appears only once at the
start of the document. Anything that you place in the Page Header is shown at the
top of each page, in this case the fieldnames. Similarly, information in the Page
Footer is shown at the bottom of each page. The Report Footer appears at the very
end of a report, although in this example the Report Footer is empty (it is not
shown in white) and therefore will not be shown in this document. The Detail
section is the most important, as this single row is where the data 1s shown for each
car. This single row will appear as many rows (as many as there are Ford cars in the
database) and display the details of each record.

The task tells you to place your name on the left in the header of each page. Move
the cursor to the top of the light blue bar showing the Detail row; click on this so
that the cursor changes into an arrow. Hold the left mouse button down and drag
the top of the detail row down about 5 millimetres. Select all of the controls
(objects) in the Page Header by drag ing (and holding) the left mouse button.
Move all of these controls ———
down the page about
5 millimetres, so that they
look like this. —————

The Design tab should
already be selected. Find
the Controls section and
click on the Label icon.

Drag a new control
into the Page Header and
type your name into this
control. In this example,
when you move the cursor
out of the control and
click anywhere else on the report it does not show the text clearly. This label needs
editing so that the text is visible and it is left aligned. Select the control and use the
tools in the Font section of the Design tab to set the font
colour to white and the alignment to left.

To see what the report will look like at any time, find
the Views section of the Design tab and select the
Report View. Use this section to change back to the Design View at any time.

The title ‘All Ford cars in stock’ needs to be centre aligned. Click on the control
containing this label, and use the drag handle to stretch the control to
28.2 centimetres (almost the edge of the page). If you stretch the control further to
the right it will add
another page width to the
final printout, wasting
paper when it is prmted ! ‘ «
and no longer fitting to a single page WldC Once the control ﬁts thc page W1dth
then centre align the label using the Center icon.

To add the subtitle, drag the light blue bar for the Pagé
Header down about 5 millimetres. Add a new label, the
full width of the page, in the Report Header, just below
the title. Type the text ‘request for Mr David Watson’ into this control. Set the font
colour to white as before and right align this subtitle using the Align Text Right
icon. The design view of the report looks like this.

1z Te
E_%Dateandﬂme: Box
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Activity 11d
Open the database that you saved at the end of Activity 11c. Produce a report which:

@® displays all the data in the table within the width of a landscape page

® has your name on the right in the header of each page

@ has a title ‘All stationery in stock’ centre aligned at the top of the first page

@® has a subtitle ‘request for the manager’ right aligned at the top of the first page.

Taslk tik
Open the database that you saved at the end of Task 11j.
Produce a report which:

@ displays all the data for all the cars with alloy wheels within the width of a portrait page
@® has your name in the report header followed by ‘Cars with alloy wheels'.

Open the database saved in Task 11j. Select the Create tab and in the Reports
section click on the Report Wizard icon. In the Report Wizard window, select the
query for alloy wheels (that you created in Taskl1h) in the Tables/Queries box. As
the task says ‘display all the data’, use the arrow buttons to move all the fields from
Auvailable Fields: to the Selected Fields: box. Go through the wizard as you did for
the previous task, making sure that you set the page Orientation to Portrait. When
the wizard has finished, the report is created and looks similar to this.

You can see that Access
has attempted to malke all

Graharn Brown Alloy Wheels

1D Make Madat Cologr PPrice 0 SPrce Year Extess thc ﬁelds flt aCross tllc
v# Ford Escor Green HRUHNE BUHARH 198 ArConditioning Al 14 page, burt this has not
10 Ford Escart Darkblue BEBRHR 11500 19 Alloy Wheels "

been successtul as not all
of the data is fully visible.

54 Ford Escert RS tutbo Silver HAUAFH BERWEE JBN Alarm Central Locki

55 Focrd Mordeo Blue BARARE SHHBHE JBE Alloy\Wheels Alorm 1

In the practical examinations you must show all of the required data in
full. Select the Create tab, and in the Views section click on the View
icon. Use the drop-down menu to sclect Design View.

Find the control for the 17 field in the Detail section of the report.
Use the left drag handle to make this control a little larger. It should
change from this to this.

y

55

| & Rz Fantid




Data manipulation

You can see that the control for the label in the Page Header has also been
stretched. Use the View icon to change back to Report View to see the effect that
this has made to the report. The left column now displays all of the figures
(including the top row). |

Graham Brown Alloy Wheels

D Make Model

Coloiir: PPrice SPrice Yedr Brds

fet: PDate

62 Ford Escort Green BARBHY HHRHHF PHH Aic Conditioning All ##
20 Ford Escort Dark blue H#EBEBH £333500 HHH Alloy Wheels (13
54 Ford Escort RS turbo Sitver HHEENR HEHHUE ¢4 Aam Central Locki 48
sg Fard Mondeo Blue RAHBEE BHARER 1HE Alloy Wheels Alarm 1§

To make more space available for widening some fields, you will need to reduce
the width of other fields. The i« field has taken more of the page width than it
needs. Use the drag handle on the right of this field to shrink the field. Use the
Report View to make sure that all of data 1s visible (you will need to scroll down
through all the data), but space is
not wasted. Repeat this for the

dods '1nd ' ¢ fields. Stretch
the Ui 2 and Yo fields
so that all the data is visible. The
Design View of the report should
look like this. /
At the moment, ignore the ©:vas field, as this s the longest field. Stretch the
and " ot fields so tlnt all the data and labels fit within the width of the page. Make
sure all the data and labels are fully visible. The data and labels may be different widths
to those shown here, depending on
the formats chosen for each field. Now
stretch the ©xis field until the
< control j ]ust reaches the edge of
the page but no further.

Change to Report View and
the report appears like this. You

[ #sgegotic
Lttty

can see that all of the oxreos still  f v » .
do not fit within the space. ——— " arew  ten o 70005 rags o0 2000 A Centiaring Aloyheds Mo
In Design View, move into wed e Dactlee  cussson  g3uised e Aley et "o
. 54 Ford Sacon RStuba  Siver £ai9500 334500 1393 Al CenteolLocking Alley®  Ne
the Detall ROW and drag the 59 Ford stendeo Bl 245500  £3,24500 2002 AlloyiWheels Alsm Ne
bottom handle of the control for

the +uirux fleld down so that the
control becomes exactly twice as high.
Change to Report View and
check that all the data and labels fit
within the width of a single page,
like this.
Save this report.

£1,48580  £3.24500 189

55 Ford Mondeo Bluz £218500 5314500
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Hint

The Discount field
can appear as
Yes/No, True/False
or as a tick box. All
of these would be
correct for this
guestion.

Fint

If you need to
export the report
without any
formatting, select

the Text File option.

Activity lle
Open the database that you saved at the end of Activity 11d.

Produce a report which:

® displays all the data for all the items where the quantity is greater than or equal to 10
within the width of a portrait page

® has your name in the header of each page

® has a title ‘Quantity >=10" centre aligned at the top of the first page.

Exporting data

Sometimes whole reports, queries or the data within them need exporting into
other packages to be manipulated as part of a report for someone, or to create a
graph or chart.

Task 1 i

Export the report saved in Task 11k into rich text format so it can be included in a word-
processed document.

sl ] In the Navigation pane, find the report that
o you saved in Task 11k and right click the
mouse button on the report name to get the
drop-down menu.

Select the option to Export. This will open
another drop-down menu. You need to export
mto.rtf format, so select Word RTF File.
«— This opens the Export - RTF File window.

k' Click on the “Bowe:. button to select a
folder to save the document into. In the
practical examinations you will need to use
this file for another task, so select the tick box
for Open the destination file after the
export operation is complete, then click on
:. The exported file will appear. Close the Export ~ RTF File window.

) Gransm Brown Alloy Wheels
3 Grshan Srown Ford AND Velet
5 Granim Brown Ford ORVawr.
! Granan Brown Ford Query
“§ Granam Brown HOT Foid
"3 Gratsm Brown Sats preetet..

B auFord carsin stock

Hide 1n this Graup MO RIE Fite:o

; Delete €11 Databare

iien L TentRie

HOAL Documant

g 3

Task iim

Export all the details of all the cars with alloy wheels into a format that can be used to
produce a graph.

The best package within the Office suite for creating graphs is Excel. You have just
exported the report on all the details of the cars with alloy wheels into.rtf format.
However, if you try to export the report into Excel you will not be able to do so, as
the report holds its title and formatting as well as the data. Instead, you need to
export the query for ‘alloy wheels’ rather than the report.
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Hint

If you need to
export the data
into.csv format
(comma separated
values), Export it
first into Excel, then
save it in.csv format
from Excel.

=== .
ZH wicars: Tadte
T cohiorpeirim dltor Wheets, ™%
31 Graham Beawn Ford AND Valel
T Graham Brovm Ford ORVaur...| |
3 Gratam Brown Ford Query

Coflect and Update Data-nsa Eaail

Right mouse click on the query name,
then select Export, followed by Excel
from the drop-down menus to open the

| grarepomtint

Export — Excel Spreadsheet window.
Rather than reformatting the data, select
the tick box for Export data with
formatting and layout, and the tick box
tor Open the destination file after the

23 Graham Brown NOT Fara

! mename * Yeord RIF Fe
F Guham brown sl pe 6l e i ok Group

19 aarord caes instock Delete

Bl Graham Brown Rioy Wheeh

Lotgs 123 File

smemmaoaess_ €XPOIt operation is complete. Click on
... Close the Export - Excel

épreadsheet window.

Activity T1f
Export the report saved in Activity 11g into:

@ rich text format
@ a format that can be used to produce a graph
@ a comma separated value format.

Hiding data in a report

There are times when information in a report needs to be hidden in some way. In
real applications a single report would be created for more than one task, and some
data would be hidden. This process is often done automatically using a created
report and a programming language. Although that is beyond the scope of this
book, the ability to hide fields within a report is useful. An example of this is when
an invoice would be produced for a customer, and the same document is used as a
delivery note, so that it shows the details of the items ordered but the costs are
hidden. In Access this can be done in one of two ways, the first is to make a control
invisible; the second is to use a background colour that matches the text colour.

Task [ in

Open the report created in Task 11k.
Hide all the labels and data for the Valet and PDate fields from the report. Hide the PPrice
data (but not the title) by setting a black background.

Before starting this task it is wise to back up the report that
you created in Task 11k. In the Navigation pane, right £ —
mouse click on the report name and select Copy. Move the | | 5 :i:;;::;wm,
cursor onto the whitespace in the Navigation pane and ) Groham sevam P 10 Vi
right mouse click again.

Grzham Brown Ford OR Vaure...
Graham Brown Ford Quary
Graham Brown NOT Ford

E  Layout Wiewr

2 gesgavien
s

| Reame

¢ Hude tn this Group
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Select Paste from the drop-down menu, renaming the report if required. Open the
report in Design View. Right mouse click on any of the field controls and select
Properties from the bottom of the drop-down menu to open the Property Sheet pane.

A BET Aq Gis)
T o) Page Humbers 2
1ago e Label Button "

9 Ty DsteandTime  pox < FiEl e

Graup Guighnes

tection typr:

Format | Data | Event [ Op

Visitle

T Graham Srown Ailoy Wheels

Grsham Brown Ford AND Valet

Graham Biown Ford OR Vaurhsil

Yop 0301em

Graham Brown Fotd Quecy

Graham Srown HOT Ford Back Style Tansparent
Back Color WEFFFFF
Botder Style Transparent
Border width Haihne
Border Calar 2164680
Special Etfect Flat

Font Hame Corbel
Font Size 1

Text atign

Font Weight Hotmal
Font Underhhe Ho

) Granam Brawn Sales price less than ..

2] AllFord cars in stock

J  Graham Brown Afloy Wheels

5 Grahsm Bown Alioy eheels masked

| Designview < - Hurm fock
E

Select the four controls for the 2w+ and
st fields (two for the labels and two for the
data). These can be selected together by holding
down the <Shift> key and clicking the left
mouse button on each of the controls in turn.
These should be highlighted like this.

In the Property Sheet pane, select the
Format tab. Many of the options in the
Property Sheet have small drop-down menus,
which you can use to select pre-defined options; the arrow for the drop-down menu
appears when you click in the cell. Use the drop-down list in the Visible section to
select No, which will hide these controls.

To set a black background for the "1« data, in the Detail row of the report
select the control for :*7"++:<. Move the cursor into the Property Sheet pane,
selecting the Format tab. Find the Back Color section and use the (=] icon to select
the colour palette.

Selection type: Multiple selection

¢.101em

‘Transparent
#FEFFFF
rder Style “Transparent
ordter Width Hairling
Border Color #IEAGBD
Speciat Effect Flat
Font Name ‘Carbel
Font Size 10
Tadt tinn

e

=T 23 page tumber

Graham Brown Alloy VWheels

Graham Broven Ford AND Valet = e - iS116em
. . : o i il Back Style Transparent
<F Granam Brown Ford OR vauwshail it . Back Color £ =
Bordes Style
Bordes Width
Graham Biown HOT Faid e Border Color
Y Spraal Eect

H1 Granam Brown Ford Query

F Granam Brown Sates price less than ..
13ham Brown $ales p Soro Bars

&1 Ford cars In Qock 1 _ 4 i i Faot Hame

; c Font Size.
4 Graham Brown Atiay Wireels T 5 Test Align
Font Weight
Font Undettine
Font Ttahc
Fore Color
ne Spaang

Bl Granam Brawn Aoy Wheels masked

s
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Hint

If you wish to
change the display
formats of any
field, this can also
be done in the
Property Sheet
pane using the
Format tab.
However it is better
to set the
formatting for the
fields in the Design
View of the table,
as changing the
display properties
will not change the
way that the data is
stored and this
could lead to errors
if fields are used for
calculations.

Select the black colour rather than the white background. You will notice that the
colour code for this control has changed from #FFFFFF to #000000. You will
learn more about this in Section 15.7. Change from Design View into Report
View to see the changes. Save the changes to the report design. Close the report.

Datatase TNs L Acionat |

i tolCars: Table

Graham Brown Alloy Wheels : {

Graham Brown Alloy Wheeis

Graham Brown Ford AND Valet

Graham Brown Ford OR. Vaushalt 1D Make: 1 Colous PPrice

Graham Brown Ford Query Graen £2,925.00 2004 AirCondiicning Alloy Wheels  Escors

3 Graham 8rown NOT Ford

Graham Brewn Sates price lazs than .. 10 Ford Dark blue £3135.00 2003 Alloy Wheels Escort

All Ford cars in stock

) 54 Ford Sitver £3,24500 1593 Alam Centrallocking Alloy  Escort RS turbo
A Graham Brown Allay Wheelz Whaels
d  Graham Brown Allgy Wheels masked 59 Ford Blus £3.24500 2002 Alloy Whesls Alarm Mondeo

1g Ferd Sityar £375500 2004 AirConditioning Alloy Whasls  Mendec

o Lotk

Open the report created in Activity 11e.

Hide the label and data for the § field in the report and hide only the data in the
= field by setting a black background.

Producing labels

You may be required to produce other forms of output from your database, for
example producing labels to advertise a product or address labels for mailing letters
to customers.

e 3 pop
ie 11
iask g

s}

Open the file that you saved at the end of Task 11n.

Find all the cars with a sale price of less than £4000 and for these cars produce labels which:
@® have a page orientation of portrait

@ fit two side by side on the page

@ have a 16 point centre aligned headlng 'Speaal Offer at the top of each label

@ show only the fields ¢ i+ and £xiras, sorted into make and
model order

@ have your name at the bottom right of each label.
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Design a new query to extract
only the cars with a sale price
of less than £4000, selecting
only the !
.5 e and e
; fields from the table as | 3 &
you step through the Simple 3 commmomrason
Query Wizard. When you
have sclected these cars close
the query and click the left
mouse button on the query so
that it is highlighted like this.
From the Create tab, find the / ;
Reports section and click on the Labels |f
icon. This opens the Label Wizard.
Select any label format that contains two e
labels across the page; in this case, use e i -
the C2244 labels as they are slightly — 7
deeper than the C2166 labels (and it is
therefore easier to fit all the dara and
labels onto each label). Click on Znext>. .
The next screen asks for the font size
and colour of the text on the label. Leave
this set to a small size (it 1s easier to
enlarge this later if needed, than to reduce
it), like 8 points high. Click on etz
Type the text ‘Special Offer’ in the
grey arca as the top row of the label.
Press <Enter> to move down to the
second row. Each field needs moving
onto the label — use the right arrow to
move cach field into the label, pressing o] s o] [
<Enter> after cach one to create a new
row. You can type labels for each row if
you wish to do so. When all of the fields
have been moved across, add a final row || oo ratoype e
with your name, then click on _aext> . oo ke
Move the “i2kc, then Hiodo fields s s
across into the right to sort the labels e
by make and model as specified in the
task, then click on “hext. .
Give the labels an appropriate name (o) [sme TR ) [omen ]
and select the radio button for Modify
the label design. Click on _gren .

73 Graham Brown HOT Fard

Al Ford cars in stock

B Granam Brown alloy Vinees,

| This wizard creates standard tahels or astom fabels.
What label size would you kke?
Praduct number: Dimensions: Number across:

{110 mm x 156 mm
Label Type
@) Metric 0; Sheet feed & Contnuous

Construct your label on the right by choosing fiekds from the le ft. You may also.
type taxt that you would ike to se on every label right onto the prototype.

What would you Fke on your maiing label?

Construct your fabet on the right by choosing fialds from the laft. You may also
type text that you would ke to see on every label right onto the prototype.
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Select the Home tab and use the text formatting tools to change this into this.
Notice how the heading has been set

to 16 point and centre aligned and the

other fields moved down. f he :

11.6

: field has been given more space, so that
Li="Make: ~ & {Make] - o
i e SO all the data should be visible. This will
,=‘Cobur,\'al€obus) i o b N - N -
e s LT need checking when the labels are
I - r ="Year: " & [Year]

SEias. - & (Exbas)

= [ produced, and edited again if necessary.
A Your name at the bottom of the label
’ i should also be right aligned.

Check the labels’ layout using the Office button followed by Print and _#
Print Preview. Save the labels.

Activity 1 1h
Open the database that you saved at the end of Activity 11q.

Find all the items where the discount is Yes and the sale price more than £30. For these cars
produce labels which:

@ have a page orientation of portrait and fit two side by side on the page
@ have a 20 point right allgned headlng ‘Discount Offers’ at the top of each label

@ show only the fields ? rand % , sorted into ascending order
Q have your name centre aligned at the bottom of each label.

Using formulae in queries

You are sometimes asked to perform calculations at run time. This could be done in
one of two ways. The first method is by creating a calculated field, so that each
record has a calculation performed on it and the results are stored in a query. The
other method is to calculate on all (or a selection of) the records, for example to add
(sum) the data from a number of records.

Task ilp
Open the file saved in Task 110.
Produce a new report from all the data which:

@ contains a new field called it which is calculated at run time. This field will subtract
the purchase price from the sale price

@ hasthe: field formatted to currency with 2 decimal places

@ contains a new field called 11 to calculate the percentage profit for each car at run
time. This field will divide the profit by the sale price

@ has the Percent field formatted as a percentage value with no decimal places.

To create a field that 1s calculated at run time, you must first open a query. For this
task, the query will not be used to search for data, but be used to perform the
calculation. Select the Create tab, then click on the Query Wizard icon and in the
New Query window sclect the Simple Query Wizard. In the Tables/Queries box
select the table tblcars as the source of the data. Select all fields using the double
arrow key. Click on _pext> twice, name the query Profit calculation, sclect the radio
button for Modify the query design, then click on s .
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In the design view of the query, use the bottom scroll
bar to scroll to the right and find the first blank field
like this.

Move the cursor into the Field row for the first
blank field. Enter the name (+o#i¢) that you wish to
give this calculated field followed by a colon. The
colon tells Access that the next section is a
calculation. Within the calculation, you must place
square brackets [] around each fieldname so that
@ / Access looks up the data from the relevant field.

e ey fus) o fost For this task, you need to subtract the purchase
o price from the sale price. The tfinished calculation will
appear like this.
In the Views section select the Datasheet View.
Calculate the profit for three or four cars by hand or
using a calculator, and compare with the results in
the query to check that you have entered the formula
correctly.
The formatting of the calculated field will be performed in the
report. The task requires you to create a second calculated field so it
would be sensible to include the new field now and complete the
formatting later.

@
L%

B , ; I A

{FDate] [Profit: [SPrice] [PPrice]

iEbECars

Ei B
. To create a new field ‘;tht: (SPricel-{PPrice] %PEKEM; FromsFiee
Use + for addition, called , follow the

- for subtraction, *
for multiply and / same proacdulc, this time

for divide. adding a formula to divide

the profit by the sale price.
Again, check the calculations with a calculator to ensure that you have not made an
error entering the formula. Save and close the query.

Create a new report using the Report Wizard as shown in Section 11.5. In the
Tables/Queries box sclect the profit calculation query as the source of the data.

Select all fields using the double arrow key. Click on _test> three times before
sclecting a page Orientation of Landscape. Click on “sext>. twice more naming the
report Profit calculation. Select the radio button for Modify the report’s design,
then click on ~_grisn

Move to the Detail row of the report and right mouse click on the control for
the ©+«:01 data. Sclect Properties from the drop-down menu to display the
Property Sheet pane.

Select the Format tab

%1 for this control, and use
Q2+ v 42301 Rk
=l the drop-down menu for
Tata | Event | theri P the Format option to
Format el

select a Currency
formatting style. Click on
the View icon to go into

1 iDacimal Places
<1 iviginle
‘Width
‘Height

_iGenerat Number 3455, 7"9

Ewre G 4s=ua
|Fixed 3435.79

Standard 343879
T e her ! 2§,’§,‘;{§§,c B Report View and check
: e 1 ¥ B3k Styje v T N M M
LRI | lBack Cotor e 4 that the formatting for this
\ ‘ 3 - ‘ ; order Sfx(ée lr:rv%parem | H f‘ ’ld . e g _{D
‘ | %“Pigé’i&{?agé] - Borda: Width . Mainine i T1C 1S correct and
i 3 it Border Cotar FLHAEBD { . .
Eispesial ffect Flat 1 contains 2 decimal places.

In this example it does.
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11.7

Repeat this process for the I it field, left mouse clicking on the control for

in the Detail row of the report. For this field select thc Percent formatting
sty e from the drop-down list. Again, go into Report View to check that the
formatting for this field is correct and contains 0 decimal places. In this example, the
data is displayed in with percentage formatting but has 2 decimal places.

Click on the View icon to return to Design View. Right click the mouse button
on the Percent control in the
| Setection type: Test Bax Detail row. Find the Decimal

Percent - | Places option and select 0
from the drop-down list.

Go into Report View to
check that the formatting for
this field is now correct and
contains 0 decimal places. This
1s fine, but some field widths
need adjusting so that all data
and labels are fully visible.
Adjust these before saving the
completed report.

;Normal

Activity 111
Open the file saved in Activity 11h. Produce a new report from all the data which:

@ contains a new field called #ro#it which is calculated at run time. This field will subtract
the purchase price from the sale price

@ contains a new field called P« to calculate the percentage profit for each car at run
time. This field will divide the profit by the sale price

@ contains a new field called t. This field will divide the profit by the quantity

@ has the ¢ and iy ; fields formatted to currency with 2 decimal places

@ has the Farcern field formatted as a percentage value with 1 decimal place.

Using formulae in reports

Other calculations may be needed on the data selected. These include calculating the
sum (total), average, maximum or minimum values of selected data, or counting the
number of items present in the selected data. All of these functions can be produced
within a report in Access.

Task lig
Open the file saved in Task 11p.
Produce a new report from all the data which:

@ displays at the bottom of the report the total profit if all the cars were sold
@ displays at the bottom of the report the maximum, minimum and average profit values
@ displays the number of cars in this report.

You can use the report from Task 11p to help you with this task. Close this report
(if 1t is open) and right mouse click on it once in the Navigation pane so that you
get the drop-down menu. Select Copy, then Paste a new version into the pane with
a name that relates to Task 11q. Open this report in Design View.
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Click the left mouse button on the bottom edge of the Report Footer and drag

|_ this down about 2 centimetres, so that this footer is now visible. Select the Design tab

and then click on the Text Box icon from Controls section. Move down into the
Report Footer and
click the mouse
button and drag to
assistng mopery /2 place a new control, in
e this case a text box
directly below the
- column. This
positioning is
important as this
control will be used to

¥ calculate the total
T - .
‘L’T Fore] et | profit for the data in
this report.
I the Property

Sheet pane is not
showing, right click the mouse button on the text box that you have just created, then
select Properties from the drop-down menu. In the Property Sheet, select the
All tab, find the Control Source row and type the formula =SUM([Profit]) into
this row. The Property Sheet will change to this.

dd Exsti
Fields &

Name Yo7

) ControtSource " {=Sum(Profitl _ _
Control Source | Format __Cunency

Format_

Decimal Places :

isible o e .

Jext Format Plain Text

Datashezt Caption
idth

DecimajPlaces 2
isile X e
iText Format Py
Pl Datasheet Caption 3
s wan i

gt 0303¢m U Height " o503\m
e | T R .
i Syte Toniparent ; et I i

‘Back Colar | {wFFFFFF i {Back Style . {Transpakent e
Border Styte (Transparent ! Back Color FEEFFFEN 1 . . O
Border Width | Hairfine . ‘Border Style | Transpar B
JBorder Cator \746458D ; iBorderwigth Hairfine §
S san e ‘ BorderColor [ =62680 i
< o ‘Special Effect Flat I Pl
oRsGR e Scroli Bars . .None =l ‘l

The round brackets are part of the SUM function, the square brackets tell Access
that this is a field (in this case the P+ofit field calculated at run time). Format this
control as Currency and set it to 2 decimal places.
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Move the cursor into the label for this text box and type in the Caption “Total
profit’. This can be entered in the label or in the Property Sheet pane using the
Caption row like this.

Add Existing ¢
Fields ¢}

.

labei2s

“Mgbel2s

Caption ‘Total profit
Visible iYes
Width 11.746¢m
Height 10.503¢m
Top {0.106cm
Left 19.8%4cm
Back Style Transparent
Back Color #FFFFFF
Border Style Transparent

— Border Width Hairline
=Sumi((] Border Color #46A6BD
Special Effect Flat
Font Name Corbel
Font 5ize 10
Text Align General
Font Weight Normal
Font Underline

Change to the Report View and make sure that the control is in the correct place
and appears to give the right answer (it is not too large or too small).

Rather than repeating this process four more times, it will be quicker to copy and
paste these controls and edit each one to give the required results. Use the lasso tool
to highlight both the Text Box and its Label. Click the right mouse button and
select Copy, then click the right mouse button on the background in the Report
Footer and use <Shift> and <Insert> to paste the copies of these controls. Using
<Shift> and <Insert> pastes the new controls directly under the existing ones and
you do not need to reorganise the controls. It also extends the bottom of the Report
Footer as needed. If you right mouse click and use Paste from the drop-down
menu, this pastes the controls in the top left-hand corner of the Report Footer and
you then have to drag and position each set of controls. Repeat <Shift> and
<Insert> until you have five sets of controls like this.

ot EoRteF Tl
CEPOR EODICE:

}
Tofit

ESum{{Profit

{ESum([Profit]




Information and Communication Technology

== e In the last four controls containing labels,
Towlgrofic | || | =fumilPiofih change the Captions to ‘Maximum profit’,
W =HaxtiPtofil] ‘Minimum profit’, ‘Average profit’ and
Minimpm profit | | | =Min({Piofit]] ‘Number of lcars’. Select the second Text Box
- — : (for the maximum profit) and change the
Average profiy | | pvalPiofitl) formula so that it becomes = MAX([Profit}]).
Nurm % qunt({P Change the formulae for the minimum profit

- so that it becomes =MIN([Profit]) and for
the average profit so that it becomes =AVG([Profit]). In the final control to count the
number of cars, change the formula so that it becomes = COUNT{([Profit]). The
controls should look like this.

In the Property Sheet pane for the final Text Box, change the format back from
Currency to a Standard number. Set this control to 0 decimal places. Check the
layout and calculations in Report View. The completed calculations look like this.
Save the report.

.:my B :; Z:Z:Z: 20:7 If you need to show evidence of tllle
B ‘ tormulae that you used for the practical
fowal profic £86.520.00 examinations, use screenshot evidence of
Maximum profit £2,705.00 the calculated controls.
Minimum profit £600.00
Hint Aversge profit £1.278 24
If you are using Number of cars 68

screenshot evidence
of calculated
controls, make sure - .
that each control is Activity E lj o _ _
wide enough to Open the file saved in Activity 11i. Produce a new report from all the data which:
show all of the
formulae in full. If
you do not show all
the formulae,
marks will not be
awarded.

@® displays at the bottom of the report the maximum and minimum percentage profit for all
the items in stock

@ displays at the bottom of the report the average profit per item

@ displays the number of items in stock

@ uses appropriate formatting for all data.

11.8 Sorting data

Although Access has the ability to sort your data in both tables and queries, it is
easier to save the sorting until the data is produced in an Aceess report.

Task lir

Open the database that you saved at the end of Task 11q. Produce a report which:

@ displays all the data for the cars made by Ford or Vauxhall

@ fits within the width of a single page

@® is sorted into ascending order of make and model, then into descending order of sales
price

® has your name in the report header followed by ‘Ford or Vauxhall’.
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You created the query in Task 11f. To
produce this report, select the Create tab
and click on the Report Wizard icon. In the
Tables/Queries box select the Ford or
Vauxhall query. Select all fields using the
double arrow key and then click on _test>~
twice to obtain this view.

“Use the drop-down lists to select the
field, then the 1 tield and finally :
the iee fleld. For the 5Price field, click Lot (e loten ] (oo ]
on _ascendng. to the right of this field and it will
toggle (change) to Desendng”. When these ficld
have been set as shown, click on _next> . Set the Orientation to Landscape and run
through the final stages of the wizard, giving this report a suitable name. This
process is the same for other data types such as dates.

Activity 11k
Open the file saved in Activity 11]. Produce a new report from all the data which:

@ displays all the blue or black items
@ fits within the width of a single page

@ is sorted into ascending order of colour and type and then into descending order of
description

@® has your name in the report header followed by ‘Black or blue items’.
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CHAPTER

12

in this chapter you will [earn how to:
create an integrated document
combine text and database extracts
combine text and graphs or charts
produce evidence of your methods
ensure the consistency of display

& use precision framing.

For this chapter you will need these files from the CD:
B MEMO.RTF LETTER.RTF

For this chapter you will also need your worked copies of:
& Task 11e & Activity 10h

1 Task 11q Activity 10i

. Activity 10a Activity 10

1 Activity 10b Activity 10k

! Activity 10¢ Activity 10l

Activity 10d Activity 10m

# Activity 10e Activity 10n

Activity 10f Activity 11c

= Activity 10g 2 Activity 11k

12.1 What is an integrated document?

In the examination you may be asked to create a document that contains text and
other objects. These may include:

® images including screenshots of your work

@ data taken from a database or spreadsheet

@ graphs or charts

@ short pieces of html

@ cascading stylesheets.

If you are asked to create a document, select your word processor, in this case
Microsoft Word. Sometimes the word report is used instead of document, as mentioned
in Section 11.5. This means ‘a document that gives information’. It does not mean a
report created in Microsoft Access (although there are times when it might be
appropriate to use this) and will nsually mean a report created using a word processor.

12.2 Importing objects

In Chapter 10 you learnt how to import and edit text from a file, clip art and images
trom a variety of different sources. Many of these skills will be needed in any
mtegrated document that you produce.




[ntegration

Hint

Keyboard shortcuts:

You can use <Ctrl>
and <G> to copy to
the clipboard and
<Ctr> and <V> to
paste the current
contents of the

clipboard.

12.3
Hint
Make sure that the

image you have
captured can be
seen clearly by the
examiner.

12.4

To import text from a website, open the webpage in a web browser, in this case
Internet Explover, and highlight the text that you wish to use. Right click the mouse
within this highlighted text and select Copy from the drop-down menu. Move into
the word processor and right click the mouse in the position you want to place the
copied text. Select Paste from the drop-down menu.

The same method is used to copy an image into your document from a webpage.
However, note that in most countries, copyright laws mean that it is illegal to copy
any text or image from a website without the permission of the owner of the
copyright. For the practical examinations, copyright of the material on the websites
that you will be asked to use will be owned by CIE, or permission to use the
material for the examination will have been obtained by CIE.

Showing evidence of your methods

In the practical examinations, you may need to show the examiners how you answered
the question. Using a series of screenshots is the quickest and easiest way of doing
this. A screenshot is where you ‘capture’ an image of what is displayed on the screen at
the time. This is copied and stored temporarily in the clipboard of the computer and
can be pasted into a document. As well as using these basic tools provided within the
Windows environment, there are other ways of doing this. There are a number of
packages available that will produce screenshots, some of which are available as
freeware. If you are already know how to use one of these packages, using them may
save time in the practical examination. Because there are so many different packages
available and each works in a different way, they are not covered in this book.

To take a screenshot and capture an image of everything that is displayed on the
screen at any time press the <Prt Scr> (or <Print Screen>) key on your keyboard.
If you have more than one window open and wish to capture only the current
window hold down the <Alt> key and press <Prt Scr>. Paste the contents of your
clipboard into the word processor and edit the image (cropping and/or resizing, as
described in Sections 10.7 and 10.8) to show only the sections that you require.

Showing evidence from Access

You have already produced queries, reports and calculated controls in Access in Chapter
11, but it is not always easy to produce the evidence of this for the practical examinations.
If you have created a report containing a tick box, always print this directly from the
report or use screenshot evidence. If you try to export a report containing tick boxes in
rich text format for example, the tick boxes will not be included in the exported
document. If you use screenshots and the evidence is in more than a single screen, make
sure that you take a number of screenshots showing all of the evidence.

Task 12a
Open the file saved in Task 11q.

Show evidence of the formula and formatting used for the calculated controls for the
‘Average profit’ and ‘Number of cars’ within the report.
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Hint

If you need to
include an Access
report in the
document, perhaps
because calculated
totals are also
required, export
the reportin .rtf
format and insert
this into the word-
processed
document using the
techniques shown
in Section 10.1.

12.5

Open the report for Task
11q in Design View. Click
the left mouse button on the

;;natl,l)a!a lEvent Other| Al

B

Text Box containing the o o . B X
calculation for the average ! : ‘ B quend .
profit. If the Property Sheet et , o || e pormat R
pane is not visible, click the - Ser——— ‘ e
right mouse button on this ENG & e
control and sclect Properties o ] ) Tangparet
from the drop-down menu. == e e w‘wé\ Sovder e Tt
Select the All tab in the Wi prof | INJ =Mnfofi] : e
Auerage proft % =PwvglProfitle
Property Sheet pane. frenspron] | | L opallien Saoigars ot

Screenshot the window
using the <Prt Scr> key and
paste this into a word-processed document. Crop the image so that the relevant
sections can be seen. Enlarge the image so that the text can casily seen, like this.—

Repeat for the
control for the » f
number of cars. Left Setection type: Text Bex
click on the Text e : B
Box, take another meat,i‘;?a‘ta Eﬁwjﬂ (‘)‘mer‘\ Al k

‘Font Size

e T et :
SCl'CCDShOt alld paste iContros Source ‘=Count{Profit]) T
[ y i Farmat B iStandard
this into your . B8 1D cimal Places. o
word-processed i
document. Agam, sl
crop and resize the 0503am
. 12.984em
image so that the —\ ' ~ 22499
. Total grafit | | 1 =3um(Pi ‘Transparent
relevant sections can [ - i SFFERFE
. VidRTTIoTTy PTH TN ‘( FVEA T I “g B

be casily seen. \; o Tanspaent

Minirpm profit | =Min([Profit]) e
Remember to add i Barder Color o FA8AEB

[Average profi J i =Avg([Profitl} :Spguai Effect fHat
your name to the i Scroft Bars ‘None

Numbgr of i Ptofi Fant Mame i COTORY
document before ! Font Size TN

saving it.

Activity 12a
Open the file saved in Activity 11k.

Show evidence of the formatting used for the
to display the black or blue items.

v and Ferice fields within the report

Combining your document and a database exiract

In the practical examinations you may need to take a database extract and place this
into a word-processed document. Using an Access query rather than an Access report
is often the easiest method of combining this information. Copying the query and
pasting it into the document (as described below) gives instant results. Be careful to
format the new text to match the existing document, to ensure the table fits within
the margin (or column) settings and to maintain consistency of line spacing with the
original document.
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Taslk I 2b

Open the file MEMO.RTF and place only the
fields of all the Ford cars that need valeting as a table after the text ‘... that need to be
cleaned:'.

Open the database that you
saved in Task 11le. Open the
query for the Ford cars and
valeting is Yes in Design View.
In the Show: row of the query
click on the tick boxes to
remove the ticks from the fields
that you do not need in the
extract.

Save the changes to the ——= : . e :

query and close the query. In . GField: 1D | (Make |Model [Colour PPrke Sorke Year Eitras |
R . . : Table: (toldars tblCars Qb!Cars itblcars ‘tbigdars tblV!s itbiCars | thiCar:
the Navigation pane, right Jow j y. v
mouse click on this query and Citera: o
on

use the drop-down menu to )
select Copy.

Open the document MEMO.RTF Ll
in your word processor. Move the

f_—j. tblé?sfable o ord Fiesta
cursor to the end of the text “... that |51 cranam 8\ Ford Ao vaet (- ard Escort
. = A . X Py Open
need to be cleaned:’ and click the & Graham Browk Ford Query

Design View

right mouse button. Select Paste

from the drop-down menu.
— The document now looks like this.

Delete the top row from the table,

and move the table so that it aligns
with the left margin of the document.
To do this, click in the table and
adjust the ruler settings for the table.
Set the font style in the table so that it
matches the text in the paragraphs.
The document now looks like this.

Export >

"Zs Coliect and Update Data via E-mait
censme e s

Hide in this Group

Delete

[ Object Properties

™ Adswecasan
s CresGumd
3

come U

R Rerpnlcuptome: comeants
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12.6

12.7

12.8

Activity 12b

Use the file that you saved in Activity 11c.
Extract all the items that are red and the discount is yes, and show all fields except
Place this extract into the file LETTER.RTF after the text ‘...red in colour.’

Combining your document and a graph or chart

In the practical examinations, you may need to insert a graph or chart into a word-
processed document. You should treat the graph or chart as an image and use the
same methods, like copy and paste. Make sure that you have dlsplayed all of the data
and labels in full in your graph before copying it into the document. This will be

shown in more detail in Chapter 14.

Ensuring consistency of display

It is very important that the finished integrated document looks like a single piece of
work. Every part of a finished document should look the same in terms of font style,
line and paragraph spacing, paragraph settings, margin settings and headers and
footers. The headers and footers should align with the margin settings of the page,
not the default settings for your word processor. When you include tables or
database extracts in your document these should have the same margin setting and
font styles as the body text. All bulleted and numbered lists should also appear in the
same style. In the practical examination, if you are not very careful about this you are
likely to lose a large number of marks. This can be relevant in a question that is
assessing your knowledge and understanding, if a question asks you to prepare a
report, document or presentation on a topic; you are likely to be marked on both
the subject content and on the quality of the document that you produce.

Precision framing

Make sure that objects like tables and charts always fit precisely into the column or
page margins, unless you are told in the question to do something different.
Examiners are unlikely to allow more than 1 or 2 millimetres overlap if images or
other objects fit outside the column width or margins.

Activity 12¢

Open each activity that you completed in Chapter 10. Check the consistency of presentation,
page breaks and that all objects placed within a document fit precisely in the margins.
This activity does not have model answers on the CD.
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13

Output data

In this chapter you will learn how to:

& use sequential numbering to save files

save files in different formats

print a draft copy of the final version of a document
print e-mails with a file attachment

print a table, query or report in a database

print a graph or chart.

For this chapter you will need no additional materials.

13.1 Saving documents

Version numbering

It is always wise to save each piece of work as you are producing it. You should save
every 5 to 10 minutes, so that if there is a problem — a hardware fault or power cut
for example — you only lose a few minutes’ work.

It is always sensible to name your files with sequential numbers. For example, as
each chapter of this book was being written, each was saved with a different version
number so that different versions can be identified. When producing your work, if
you want to go back to something from an earlier version, it is always available.

\

@ <« Docurfents » 0417 Totbook » Chapterl5 » old versions - ‘ 43 | [ Search 2 !
Links N?’“E : Date modified Type Size Tags “
5“’& Documents @Ch_lS_version_Z 15/12/2008 2330 Microsoft Office ... 4,156 KB
. B} Ch_15_version_4 16/12/200816:44  Microsoft Office ... 1425KB
B Pictures ) Ch_15_version_7 17/12/20082334  Microscft Office .. 1817 KB
B Music @) Ch_15_version 9 20/12/2008 21:40 Microsoft Office ... 2103KB
More » &) Ch_15_version 13 0670172009 16:44 Microsoft Office ... 3,565 KB
Folders ) Ch 15_version 15 08/01/2009 18:39 Microsoft Office ... 3,753KB
Desktop , VB cn 15 version 16 08/01/2009 20:21 Microsoft Office ... 4,095 KB
%) Documents &) Ch_15_version_17 15/01/2009 22:47 Microsoft Office ... 2971 KB
g 5 0417 Tedbook @Ch_lS_versinn_lB 18/01/200912:31 Microsoft Office ... 3430KB
| Chapter ) Ch_15_version_19 19/01/2009 18:54 Microsoft Office .. 3,255 K8
Chapter10 @]Ch_lS_version_ZO 20/01/2009 17:19 Microsoft Office ... 3,255KB
. Chapter1 1| E)Ch_15 version_ 21 23/01/200919:28 Microsoft Office ... 3461 KB
;} Chapter12 B Ch_15_version_22 25/01/2009 11:06 Microsoft Office ... 3551 KB
; Chapter 13 @] Ch_15_version_23 27/01/2009 20:36 Microsoft Office ... 4,147 KB
% Chaptes 14 ] Ch_15_version 24 28/01/2009 19:07 Microsoft Office ... 4315KB
: Chapter 15 ) Ch_15_version_25 29/01/2009 18:01 Microsoft Office ... 5144 KB
b HTML BB Ch_15_version_25 jr co... 02/02/200911:18 Micrasoft Office ... 5199 KB
T oldversions ) Ch_15_version_26 29/01/2009 18:05 Microsoft Office ... 5143KB
e CD ) Ch_15_version_27 02/02/200911:34 Microsoft Office ... 5145 KB
; Chapter 16 @] Ch_15_version_28 05/03/2009 20:32 Micresoft Office ... 5146 KB
e - - @ Ch_15_version_29 03/03/2009 20:39 Micresoft Office ... 5,146 KB
... old versions b - " . s
26 tams

o
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Saving a document in
different formats

‘&ve a copy of the document

Word Document

Save the document in the default file
farmat.

Documents and data can be saved in
different formats. In earlier chapters,
you have learnt how to import
different file types, and how to export
using different data types in Access.
Saving a document has already been
covered in earlier chapters, but to
save a document in a different file
format, click on the Office button { :
followed by Save As and select ———/|, & peome > |y
Other Formats. —

This will open the Save As gl sena

Fublish b

Word Template
Save the document as a template that can
be used to format future documents,
Word 97-2003 Document

Save a copy of the document that is fully
compatible with Word 97-2003.

Adobe PDF

Find add-ins for other file formats

§ Leam about add-ins ta save to other
formats suth as PDF or XPS,

window and you can choose the
file type using the Save as type:
drop-down list. This list may vary
from the one shown, depending
upon the configuration of your
software.

The most common formats
that you may need to use are
text format (listed as Plain
Text), and Rich Text Format.

Liose

) Worg Options || X Exit Word |

Type

13.2

Select the one that you require

and click on [Save.).

Printing data and
documents

For all of the different
applications used for the practical
examinations, you can use the
Office button followed by Print
and Print Preview to check that
the object that you want to print
is correct before sending it to the
printer. Please note that 4/
documents, data, graphs, charts,
presentations, etc. must be clearly
labelled with your name, centre
number and candidate number in
order for it to be marked.

5 Templates

Old versions

More »

Source CD
i Worked copies
- @Ch_ﬁ_vusiun_,l

Folders

.
|

Chapter12
Chapterl3
¢ Answers for 0D
5 Oldversions
.5 Source CD

.4 Worked copies

- \ e
Filename:  Ch 13 _version_1 \

Save as type:

AT Soed Macro-Enabled Document

Word 97-2003 Document

Word Template

Word Macro-Enabled Template

"Word §7-2003 Template

Single File Weh Page

Web Page

{Web Page, Filtered
Rich Text Format

o Phain Text
Word XML Document
Word 2003 XML Document

4 Vide Folders

‘Works 6.0 - 20

Printing any document created in colour on a black-and-white printer can cause
problems. This book has sections of coloured text designed to outline key clements;
for example, words in the glossary are shown in red, instructions are in blue and
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Hint

Not all property
windows have
these settings. Each
will depend upon
the printer that you
have installed. In
this case, the
Document
Properties window
can also used to
change between
Color and Black &
White printing.

Hint

Always check that
that the document
that you are
printing is free
from errors before
sending it to the
printer. Use the
Print Preview
feature to help you.

tieldnames are in orange. If a page containing these three colours was printed on a
black-and-white printer, each of the three colours would appear as a similar shade of
grey. It would be impossible to identify which words were glossary terms, instructions
or tieldnames. The use of colour in images is equally important; some colours appear
identical in greyscale, particularly colours like red and green. You must be able to
change the colour settings within your documents, diagrams and charts to enable the
different sections to be distinctive when they are printed in black and white.

Printing a draft copy or final
version of a document

You have already practised many of the
skills needed for this chapter. There is
often no difference between a draft copy
and a final copy of a document in terms
of the way that it is Jaid out. In some
cases, draft documents may be produced
to a lower quality than final copies, so
you do not waste expensive printer
consumables. In the practical
examinations, there will be no need to
change your printer settings or include
watermarks on your documents, unless
you are asked to do so in the question
paper. If the question paper asks you to
show how to set a draft copy, click on
the Office button followed by Print
and select Print again from the new

Preview and print the document

T LT o
Select 2 printer. number of copifes, an
other printing options before printi
Quick Print

Send the document directly to the defautt
printer without making changes.

Print Preyiew

. L. Preview and make changes to pages before
printing.

Prepare

"?@n Send >

7 pyblish

1 Close

list to open the Print window.
Click on Properties to show the
Document Properties or Printing
Preferences window.

In the Document Properties
window you can change the Quality
Settings from the current value (in

' m Paper/Qualty ‘L

Trey Selection

Paper Source:

Iedia: Plain Paper v

Quality Settings

£ e B losma3 © Diat Elcustom

this case Normal) to Draft.
You may need to screenshot this
process as evidence for the
examination.

Although this feature has been
demonstrated using a document in

Color

" Blagk & White g§ @ Color

=

the word processor, similar settings
can be changed in other packages.
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Printing emails with a file attached

Open your email browser (5 017 Text ook
or editor. Enter the address -
of the person that you are
sending the message to in
the To: box, and any — |
copies in the Cc: and Bec: T osee PR,
boxes. Add the subject in

the Subject: box and — |
attach the file to the email—]
The details of the file
attachment should be Hi Dave,

visible within the WilldOW, The chapter is finished. | have attached it to the message. Please let me know what you
along with the other items |} tink
entered. The examiners | Regards
will check very carefully i’aham
that each of these items is =
correct. In this email the address, subject and attachment are all clearly visible. Check
that there are no errors in the text of the email. If you need to send evidence of this
as part of the practical examination, copy the screen using <Alt> and <Prt Scr>,
before pasting this into a word-processed document.

Ly To:

' david.w.watson@hotmail.com

- Cc | another@hodderducation.co.uk

| b Subject: | 0417 Text Book

| 0 ECh 12 version 4.docx (679 KE) 4

%] Add photos

ayout &+ G Stationery v A Aalv ABlo- B F U »

Printing from Microsoft Access

You have already covered many of the skills required for this in Chapter 11. This
section shows you how to produce printouts of each area in Access. Do not forget
that screenshots can be very useful as evidence, although documents containing a
number of screenshots can be very large files and take a long time to print.

One way to print a table or query is to open the table or query, and copy and
paste the data into a word-processed document. This document can be edited (to
add your name and other details), saved and printed. A table or query can be printed
directly from Access by double clicking on the table name or query name in the
Navigation pane to open it and clicking on the Office button followed by Print.

Use a report in Aecess if you need to show calculated controls and improved page
layout. Printing a report uses the same method as printing tables and queries. The report
can be opened and printed using the Office button followed by Print. Reports can be
exported for inclusion in a word-processed document as outlined in Chapter 11.

Printing a graph or chart from Microsoft Excel

One way to print any graph or chart is to open the graph/chart, and copy and paste
the graph/chart into a word-processed document. You can add your name, candidate
number and centre number and any other text that you require before saving and
printing. A graph or chart can be printed directly from Excel by opening the
graph/chart and clicking on the Office button followed by Print.
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Data analysis

In this chapter you will learn how to:

B create the layout for a spreadsheet model

enter text and numeric data into a spreadsheet

use editing functions such as cut, copy and paste

enter formulae and simple functions into a spreadsheet
replicate formulae and functions in the spreadsheet

test the data model

select subsets of data within a spreadsheet

sort the data within the spreadsheet

change the display and format of cells within a spreadsheet
change the size of rows and columns within a spreadsheet
adjust the page orientation

save a spreadsheet

2 print a spreadsheet displaying formulae or values

# create a graph or chart

2 label a graph or chart

extract segments from a pie chart

add a secondary axis

set axis scales

change chart colours to print in black and white

create, rename and delete files using an operating system
& access folders/directories within an operating system.

o

2

For this chapter you will need these source files from the CD:
CLASSLIST.CSV ROOMS.CSV
CLIENT.CSV

B CLUBS.CSV
COSTS.CsV
EMPLOYEES.CSV
ITEMS.CSV
JOBS.CSV
OPERATORS.CSV
PROJECT.CSV
RAINFALL.CSV

14.1

What is a data model?

For data analysis, you will use a spreadsheet model to explore different possible
answers. These models are often financial, mathematical or scientific. Tt is sometimes
called using a “what if’ scenario or ‘what if modelling. It lets you change data in the
spreadsheet to see what will happen to the results. In the practical examinations, you
may be asked to build a simple spreadsheet model and change data within the
model, or even change the model itself, to produce different results.




Information and Communication Technology

Hint

Remember that a
column holds up

the roof and you
can see a row of

houses.

Spreadsheet basics

12

You will use the spreadsheet Microsoft
Excel to create your data model. A
spreadsheet is a two-dimensional table
split into rows and columns. It looks
like this.

It is made up of a number of
individual cells, like this. This cell
(with the darker outline) is the cell
that has the cursor within it. To help
us to use individual cells in a

spreadsheet, each cell has an address. In this example the cell with the cursor in it is
called cell E9 and the cell that has been coloured red is called cell C4. The red cell
and all of the yellow cells are in column C, and the red cell and all of the blue cells

are in row 4.

bl S
Task 14a

Create a spreadsheet to multiply any two numbers together and display the resuit.

Each cell in a spreadsheet can hold one of three things. It can contain:

@ anumber
@ text, which is called a label

@ 2 formula, which always starts with an = sign.

Move the cursor into cell Al and click the
left mouse button. Type in the label
‘Multiplying two numbers’. Move the cursor
down into cell A2 and enter a number.
Repeat this for cell A3. In cell A4, enter the
tormula =A2*A3 so that the spreadsheet
looks like this.
You will see that the formula is not
visible in the sheet and that the cell A4 only
contains the answer to the calculation within
this cell. The formula for the cell containing
the cursor can be seen in the formula bar.

If you have created the spreadsheet as
shown, you should be able to change the
contents of cells A2 and A3 to multiply any
two numbers together. The changing of cells
to see the results 1s called modelling.

pMetobo b Sheatl ~Shestd- She
| Relaay s el \@m
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Hint

If you do not show
all of the contents
of the cells in your
practical
examinations you
will lose a
significant number
of marks.

14.2

If you enter large numbers
into cells A2 and A3 the result
in cell A4 may not appear as
you expect it to. It may look
like this.

This tells you that the
number is too large to fit into
the column. To expand the

- ulti |ﬁ two nurﬁbers
width of column, move the e "
cursor to the end of the column 222,

heading for column A like this. 1.01£+08]
Double click the left mouse
button to expand the column
width to fit the longest item
stored in this column. The
spreadsheet now looks like this.
You can see how the label and

all of the data are fully visible.

|

S

1 |Multiplying two numbers
222

101133210]

o

I
|

Creating a data model

Task 14b

Create a spreadsheet to display the times table for any number you choose to enter. Print
your spreadsheet, showing values and formulae.

For this task, you need to design and create the data
model to calculate and display the times table for any
number that you choose. You must therefore have a
single cell that contains the number to use for all the
calculations. In this model you can place a simple
number like 2 in cell Al, so that you can easily tell if
you have made a mistake with your formulae later on.
Type the label “Times Table’ in cell B1.

You are going to create the times table in cells A3 to
B12, with those cells in column A holding the number to
multiply by and those cells in column B holding formulae
to calculate the answer. Move the cursor into cell A3 and
enter the number 1. Move into cell A4 and enter the
number 2. Rather than repeating this process another
eight times for the numbers 3 to 10, highlight the cells
A3 and A4, as shown here. Move the cursor to the drag
handle in the bottom right corner of these cells.

jie AR Sheet1
; erdgerts:
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Click and hold the left mouse button on the drag handle, dragging it down to the
bottom right corner of cell A12. This replicates (copies) the cell contents. Excel
realises that the numbers in cells A3 and A4 increase by 1, so uses this pattern as it
replicates the cells down.

/

(R, Micrasoft Exgh - Task 10 2=

a3/ -

@ Microsoft Excel i}ask,lO_Z m b

~
=
3
Y
wn
i
=}
g
o
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Hint

Make sure that
your name (and in
the examination
your candidate
details) are
included in either
the header or
footer. To do this

Move the cursor into cell B3 and enter the formula =A3*8$A$1. The $ symbols in

use the Insert tab, the reference to cell Al will be used by Excel to keep that cell reference the same
in the Text area when this cell is replicated into cells B4 to B12. Use the drag handle in cell B3 to
select the icon for replicate this formula into the cells down to B12. The results should look like this.
Header and Footer Without checking the formulae, you can see that this has produced the correct results
3 gfai?'fertﬁ“r for the two times table. Change cell Al to another number to check that the formula

m

works correctly. Print this values view of the spreadsheet using the Office button,

relevant section. . . .
followed by Print and then Print again.

.
E;_‘ Microsoft Excel - Task 10 2

l

Displaying formulae

To display (and then print) the formulae used

in the spreadsheet, select the Formulas tab "

and find the Formula Agditing section. Click T Jravsat

on the Show Formulas icon. The spreadsheet > SAG*SAST

now looks more like this. 3 |eastsast
Each of these formulae contains both 4 =accsast |

absolute and relative referencing. In cell B3, the 5 [FA7"9ASL

reference to cell Al (with the $ symbols) is an 5 =A~~8:$A$1~

absolute reference and the reference to cell A3 ; :ﬁ?ofg;

1s a relative reference. You can see from this ° CA11%6AS1

view that the reference in cell B3 to cell A3 has 10 =A127SAST

been changed as the cell has been replicated, as it
uses relative referencing, but the reference to cell
Al has not been changed during the replication,
because absolute referencing has been used.

To return to the view of the spreadsheet
that shows the values, click on the Show
Formulas icon again.
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More editing tools

Other standard Windows editing tools can be used in Excel, like cut, copy and paste.
These can be used to copy the contents of one cell into another cell. An alternative
method of replicating cell B3 into cells B4 to B12 is to enter the formula in cell B3,
right mouse click on this cell and select Copy from the drop-down menu. Highlight
the cells B4 to B12 and right mouse click, selecting Paste from the drop-down
menu. This will paste the formulae, adjusting the cell references for A3 as this is a
relative reference but retaining the absolute reference. The result is identical.

Accuracy of the data entry

When you are asked to ‘create a data model that looks like this’, make sure that you
copy the model in the question paper exactly as shown. Do not try to make
improvements or add enhancements (like colour and formatting) unless asked to do
so. This is very important. Some students loose marks by trying to ‘improve’ the
spreadsheet, for example by trying to left align a column containing numbers. Excel,
quite correctly, should automatically right align numbers, so by left aligning this
data it is now formatted incorrectly. Do not insert rows or columns, or remove rows
or columns containing blank spaces, unless instructed to do so.

When you type data into a spreadsheet (or any other form of document) you must
make sure that the data that you have entered is identical to the original source
document or examination question paper. A large number of marks can be lost by
rushing the data entry and not checking that it has been entered with 100 per cent
accuracy. This is even more important when working in a spreadsheet because one error,
for example a mistyped number or decimal point in the wrong place, could cause all of
the data in the spreadsheet to be incorrect. Care must also be taken when entering a
formula, as one small error is likely to stop the spreadsheet working as it is expected to.

Using formulae

Simple mathematical operators can be used to add, subtract, multiply, divide and
calculate indices (powers) of a number. Each mathematical operator is placed in a
formula, as you did in Tasks 14a and 14b. For addition use the + symbol, for
subtraction use the — symbol, for multiplication use the * symbol and for division
use the / symbol. Indices are calculated using the ™ symbol, so the contents of cell
A2 squared (x*) would be typed as =A2 "~ 2.

Task l4c

Open the file OPERATORS.CSV. Place two numbers of your choice in cells B1 and B2.
Calculate in cell:

® B4, the sum of the two numbers

@ BS5, the difference between the two numbers

@ B6, the product of the two numbers

@ B7, the contents of cell B1 divided by the contents of cell B2

@ B8, the contents of cell B1 to the power of the contents of cell B2.

Check that the formulae have worked before printing your spreadsheet showing the values
and again showing the formulae used.



Information and Communication Technology

Open the file OPERATORS.CSV in Excel. Extend the MUmber X 1 4
width of column A so that all the labels are fully visible (see mumber YW >
Task 14a). Move the cursor into cell Bl and enter the

number 4, then into cell B2 and enter the number 2. These M’L Y W 4+2=0 ‘

numbers have been chosen so that you can easily check your | X-Y 4-2=2 |
calculations. It is wise to perform all calculations by hand XY 4%2=86
before entering the formulae, to make sure that you XY 4/2=2
understand the formulae that you are using and to sece the XY 4°2=16

results of the calculation before the computer has

shown you its results. These calculations may look like this.

@ Addition: Move the cursor into cell B4. The sum of the two numbers is needed
in this cell, which means to add the contents of the two cells. There are two ways
of doing this: one method uses the + operator and the second uses a function.
You will be shown how to use the SUM function later in this chapter, but the
formula needed to enter in this cell for the + operator is =B1+B2. This can be
typed in followed by the <Enter> key, or you can type the = sign, click the
cursor into cell B1, type + and click in cell B2 before pressing the <Enter> key.

@ Subtraction: Move the cursor into cell B5. The difference between two numbers
is needed 1n this cell. Enter (using either of the methods described in the addition
section above) the formula =B1-B2, followed by the <Enter> key.

® Multiplication: Move the cursor into cell B6. The product of two numbers

The ~ symbol is means to multiply the two numbers together and you need to enter the formula

Zziei?tio::;‘g’smg =B1*B2, followed by the <Enter> key.

’ ® Division: Move the cursor into cell B7. This cell needs a calculation to divide the
contents of cell B1 by the contents of cell B2 using the tormula =B1/B2,
followed by the <Enter> key.

® Indices: Move the cursor into cell B8. This cell needs to calculate the contents of
cell B1 to the power of the contents of cell B2 using the formula =B1 "~ B2,
followed by the <Enter> key.

Hint

To check that the formulae have worked |3 First number - X
correctly, compare your original paper- _Z |Second number - ¥
based calculations with the values in the 2
spreadsheet. || 4 SumofXandY 8
. . 5 |Difference betweenXandY . 2

You‘ WIU.HOUCC that the values chosen 5 IProduct of Xamd v e
carlier in this task were carefully selected to |73\ givided by v s
make the maths casy. The more difticult 8 Xtothepowery 16

calculations are likely to be the division and
indices. These numbers were selected so

that the 4 divided by 2 gives an casy result 1 [Firet number - X
and the 4 to the power of 2 is reasonably 2 |secondnumber-y 2
casy (4*4). Ert ‘ T

Print the values, making sure that your 4 sumofXandY . =B1+B2
name is fully visible on the printout. Select 5 |Difference between Xandy =81-82
the Formulas tab, then click on the Show || 6 |Product of Xand Y =B1*B2
Formulas icon in the Formula Auditing 7_xdividedbyY =B1/B2
section to change the display to show the _|X tothe power =BirB2 .

formulae, which should appear like this. : .9~
Save and print the spreadsheet.
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Named cells and ranges

When an individual cell or an area of a spreadsheet is going to be used a number of
times within the formulae of a spreadsheet, it 1s often a good idea to give it a name.
This name should be short and meaningful. In the case of a large spreadsheet, it is
casier to remember the name of a cell, for example VAT or AveMiles, rather than
trying to remember the cell reference, for example AC456 or X232. Once a cell or a
range of cells has been named, you use this name in all your formulae.

Tasle 14d

Open the file SALES.CSV. This spreadsheet will be used to calculate bonus payments to sales
staff for a small company.

Name cell BT ‘Unit’. Name cells A5 to C7 ‘Rate’. Name cells B11 to G18 ‘Sold".

Open the file and find cell B2. You must name this cell “‘Unit’. Right click on the
mouse in this cell to get the drop-down
menu. Select the option to Name a New Name
Range... which will open the New Name

i . In the Name: box, Excel will )
window. In the N box, SoPe:  warkbook
suggest a name for the range. It uses the L

. Comment: | This is the price charged to the customer

layout of your spreadsheet to do this. For for each item sold.|
the practical examinations, ignore this

Name:  |unit

suggestion (in this case the name that it

suggests 1s too long to be used) and / ~
. . . : ) - =

overtype it with the word Unit, as Refers to: | ~sheet11¢B$1 B

instructed in the question. Add suitable
text in the Comment box so that the
window looks like this. To name the
range click on Loc..

When you move the cursor into cell
B1, you will sec in the Name Box that it

P aﬂfabf&' tanle

To create the named range for the rate, you must

highlight the cells between A5 and C7. Do this

by clicking on cell A5 and whilst holding down | New Name
the left mouse button, dragging the cursor to cell ||mme:  [rare
C7. Click the right mouse button within the Scape:
highlighted range to get the drop-down menu. Camment | This s the bors rate for achof the e |
Change the contents of the Name: box to Rate. | E
Check that the New Name window looks like ,

this before clicking on .. The name of the efrs o ;=Sheet1!sA$5:scs7 WE,% ;
range is only visible in the Name Box if only the 5 T =
cells in the range are highlighted. —
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Hint

An alternative
method is to enter
=SUM( then drag
the cursor to
highlight cells B4 to
B8, then type ) and
press the enter key.

-

The final named range can be created in a
similar way. Highlight cells B11 to G18,
Neme:  [sod — i then name this range Sold. Each of these
Scopes | workbook named cells and ranges will be used in
Cgmment: [ The number of items sold by all of the sales . | [|  other tasks. Save this spreadshect as
personnel during the 6 month period. Task_14d as an Excel spreadsheet.

New Name

| -

Refersto: | —sheet11$B$11:46$18 5 |

Using functions

A formula in Excel starts with an = sign. It could be a simple formula using
mathematical operators like =B1+B2, a complex formula using nested statements
(this will be explained later in this chapter) or a formula including functions. A
function has a pre-defined name like SUM or AVERAGE that perform a particular
calculation. There are many of these functions in Excel, many of which are beyond
the scope of this book, but each has a reserved function name. If a question asks you
to choose your own name for a cell or range, try to avoid using these function
names. This section does not contain all of the functions available or all those that
may be used in the examinations.

SUM

The SUM function adds two or more numbers together. In Task 14c, you used the
mathematical + operator and the formula =B1+B2 to add the contents of two cells
together. With only two cells to be added, this was the most efficient way of doing
this. If there had been more figures to add, particularly if they were grouped together
in the spreadsheet, using the SUM function would have been more efficient.

Task lde

Copy this spreadsheet model and calculate:

@® the total number of hours worked by all of these five
people

@ the average number of hours worked per person

@ the maximum number of hours worked by any of these five

£12.80

Name Hours
David Watson | 26

Graham Brown
| John Reeves

Rate of Pay

- N
whj\lO

people B e
@ the minimum number of hours worked by any of these five Total .
people. | Average
| Maximum

| Minimum

Open a new sheet and copy the labels and values exactly as shown in the task. Select
the Home tab and use the (bold) icon to embolden the cells shown. To find the
total number of hours worked you will need to click the cursor into cell B9 and use
SUM to add up the list of numbers. Enter the formula =SUM(B4:B8). This should
give the value 80.
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Rate of Pay £1280

2 |Name Hours =
- | David Watson ‘; 26!
Graham Brown ¢ 20)
John Reeves 17
7 |Brian Sargent 4
DanBray  { 1%
gl L 54: 55 ] B —
10 |Average [SUMinumberd, [number2], .} |

11 i Mavimom

An alternative way to use this function without typing it into cell B9 is for you to use
AutoSum. Move the cursor into cell B9, select the Home tab and find the Editing
section. Click on the AutoSum icon. This will place the SUM function into cell B9 —
and attempt to work out which cells you wish to add up (by looking at the layout of
your spreadsheet). It does not always get this range correct, so check carefully. If the
range is correct (as it is in this case) press the <Enter> key to accept the AutoSum. If it
is not correct, you can highlight the cells to be added before pressing the <Enter> key.

There are many ways of using the SUM function, some of which are shown in
Table 14.1.

h f al in th
~SUMI(B4:B8) —B4+B5+B6+B7+B8 Adds up the contents of all the cells in the range
B4 to B8
=SUM(D3,D8,D12) | =D3+D8+D12 Adds up the contents of the cells D3, D8 and D12

. Adds up the contents of the cells in the range D5
=SUM(D5:D8,F2) | =D5+D6+D7+D8+F2 to D8 and the contents of cell F2

Adds up the contents of all the cells within a
=SUM(MyRange) | None named range called MyRange; this can be used
with any named range

Table 14.1 Ways of using the SUM function

As you can see, the range of cells selected within these functions can include a number of
individual cells, ranges of cells, named ranges, named cells or a combination of these.
The average, maximum, minimum and count functions also work like this.

AVERAGE

To find the average number of hours worked, click the cursor into cell B10 and use
AVERAGE to calculate the mean (average) of a list of numbers. Enter the formula
=AVERAGE(B4:B8).This should give the value 16. There are many ways of using
the AVERAGE function, some of which are shown in Table 14.2 overleaf.
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Hint

Setting a cell as an
integer value will
truncate the
contents of a cell to
remove the
decimal/fraction

part of the number.

This is not the same
as formatting a cell
to 0 decimal places
which stops the
decimal/fraction
part from being
displayed but not
from being used in
a calculation.

=AVERAGE(B4:BS8) —(B4+B5+B6+B7+B8)/5 f:r'];“;a;ftgh;smea” of the cells in the
~AVERAGE(D3,D8,D12) | =(D3+D8+D12)/3 g?;‘;';t;;he mean of the cells D3,
=AVERAGE(D5:D8,F2) | =(D5+D6+D7+D8+F2)/5 f:r:;u;aggstzh;gn::; coefl ltpze cells in the

Table 14.2 Ways of using the AVERAGE function

MAX

To find the person who worked the most hours, click the cursor into cell B11 and use
MAX to select the largest (maximum) figure within the list of numbers. Enter the
formula =MAX(B4:B8).This should give the value 26.

MIN Rate of Pay £12.80
To find the person who worked the least number of

hours, click the cursor into cell B12 and use MIN to Name Hours

.. s i . i David Watson 26

select the smallest (minimum) ﬁgmc from the list. Enter Graham Brown 50

the formula =MIN(B4:B8).This should give the value 4. John Reeves 17

The finished spreadsheet should look like this. Save this Brian Sargent 4

Dan Bray 13

spreadsheet as Task_14e. Total 80

Average 16

Maximum 26

Minimum 4

Sctivity {4a

Open the file TUCKSHOP.CSV.

In cells B14 to B17, calculate the total number of days that all the students worked in the
school shop, the average number of days worked, and the maximum and minimum values.
Place your name on the spreadsheet. Print your spreadsheet showing the values. Print your
spreadsheet showing the formulae used.

Task 147

John Reeves did an extra four hours’ work. Change the spreadsheet that you created in Task
T4e to show the new figures. The manager wants to see the average number of hours
worked displayed as:

® an integer value

@ rounded to the nearest whole hour.
Print two copies of the spreadsheet showing these values.

Open the file Ch_14_Task_14e. Change the contents of cell B6 to 21 to add the
four extra hours that he worked. This gives an average value of 16.8 hours. Move
the cursor into cell C9 and enter the text ‘Integer’, then move into cell D9 and enter
the text ‘Rounding’. To get the first value requested by the manager, we have to set
cell B10 to hold an integer value.
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INT

In mathematics, an integer is the word used to describe a whole number (with no
decimals or fractions). Within Excel, the INT function takes the whole number part
of a number and ignores all digits after the decimal point. Move the cursor into cell
C10 and enter the formula =INT(B10).This should give the value 16.

ROUND

Move the cursor into cell D10 and enter | AT L B el D

the formula =ROUND(B10,0).This Rate of Pay £12.80
uses the ROUND function which takes

) Name Hours
the content of ce.ll B10 and 19unds the David Watson %6
number to 0 decimal places: if the next Graham Brown 20
digit is five or more the number will be John Reeves 7
increased by one. For example, in cell Brian Sargent 4
cree y onc. Xample, Dan Bray 13

B10 the value is 16.8, so the content of Total 80 | Iinteger | Round

D10 is 17, as it has rounded the value to Average 16 16 17
I ) hol ber. The - Maximum 26
the nearest whole number. The 5 [ Minimum 7

spreadsheet should look like this.

Rounding can be used with a number of decimal places, for example using
rounding for currencies with 2 decimal places can avoid calculation errors. Table
14.3 shows more examples of how you can use the ROUND function, using cell Al
which contains the number 62.5512.

Rounds the contents of A1 to two decimal

=ROUND(AT1,2) 62.55
places

Rounds the contents of A1 to one decumal
=ROUND(A1,1) 62.6 place. Note that the figure 5 in the ¢ 17 has
forced the previous figure to be rounded up

Rounds the contents of A1 to no decimal places.
=ROUND(A1,0) 63 Note that the figure 5 in the ¢ i2 has forced
the previous figure to be rounded up

Rounds the contents of A1 to the nearest 10. The
=ROUND(A1,-1) 60 negative value for decimal places allows this
function to round numbers in tens, hundreds, etc.

Rounds the contents of A1 to the nearest 100.
=ROUND{A1,-2) 100 Note that the figure 6 has forced the previous
figure to be rounded up from 0 to 1

Table 14.3 Ways of using the ROUND function

Save and print a copy of the spreadsheet showing the average number of hours
worked displayed as an integer value. Print a copy of the spreadsheet showing the
average number of hours worked rounded to the nearest whole hour.

By

W EF

\s
o
%

Activity
Create a new spreadsheet model to calculate:

the whole number part of 375.56411

375.56411 rounded to two decimal places
375.56411 rounded to the nearest whole number
375.56411 rounded to the nearest ten

375.56411 rounded to the nearest hundred
375.56411 rounded to the nearest thousand.

206089
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Task l4g

Open the file PROJECT.CSV. This file lists some workers and below each worker is the
number of johs they have still to finish for a project.

Place a formula in cell A22 to count the number of jobs that still have to he finished for the
project. Place a formula in cell A24 to count the number of workers on the project.

COUNT

For this task you will need to use functions that count different values. It is possible
to count the number of numeric (number) values in a list using the COUNT
function. Open the file, place the cursor in cell A22 and enter the formula
=COUNT(A2:A19). This will look at the range A2 to A19 (notice that you have
not counted cell Al which contains the title, nor cell A20 that may be used for
something else later) and count only the cells with numbers in them. It will not
count any blank spaces and should give the value 7.

A

COUNTA Project 142
The COUNTA function works in a similar way to the Laila Aboli Z
COUNT function. Rather than counting just the . .

. .. . Sri Paryanti
number of numeric values, this function counts the 7
number of numeric or text values displayed in the cells. David Watson
It will not count any blank cells within the range. In 2
Excel there is not a count function for just text values, so Graham Brown
the COUNTA and COUNT functions will both be used 12 |

. John Reeves

to calculate the number of workers on the project. Place
the cursor in cell A24 and enter the formula o Brian Sargent
=COUNTA(A2:A19)-COUNT(A2:A19). This will 6

look at the range A2 to A19 and count the cells with Dan Bray
text or numbers in them, then subtract the number of
cells with numbers in to leave only the cells with text in
them, in other words the names of the employees. It

should give the value 9 and look like this.

Thirumalar Asokmani
3

Lea Cabusbusan

2

Number of workers
who have not finished

7
Number of workers on
the project
9

Number of workers who have not finished

Number of workers on the project
=COUNTA(A2:A19)-COUNT(A2:A19) 7

=COUNT(A2:A19) f

s
.

s a9

Open the file CLASSLIST.CSV. This spreadsheet lists all the students in a class. If a student has
attended any clubs during the year, the number of times they have attended is recorded in
the cell below their name. Place a formula in cell A71 to count the number of students in the

class. Place a formula in cell A74 to count the number of students who have attended extra clubs
this year.
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Hint

Note in examples
one and three in
Table 14.4 that the
range $B$3:$B$21
has been set as an
absolute reference
so that this range is
always in the same
place if the formula
is replicated. Also
note that examples
three and four have
cell A24 set as a
relative reference
so that it will look
for the next job
title when the
formula is
replicated. Named
ranges are absolute
references, but you
must show
screenshot evidence
that you have
named the range
correctly in the
practical
examinations.

Open the file STAFF.CSV. This file lists some workers on another project and lists each
worker’s job.

Place formulae in cells B24 to B28 to count how many of each type of worker are employed
on the project.

Place a formula that uses both absolute referencing in cell B31 to count the number of
employees with less than five years’ experience.

Place a formula that uses both absolute referencing in cell B32 to count the number of
employees with ten or more years’ experience.

For this task, you need to count how many people have each type of job. Open the
file and place the cursor in cell B24. The function needed for this task is
COUNTIE, which looks at the cells within a given range and counts the number of
cells in that range that meet a given condition. The condition 1s placed in the
function and can be a number, a string, an inequality or a cell reference. There are a
number of ways the COUNTIF function can be used: any of the formulae given in
Table 14.4 can be entered in cell B24 and will give the correct result.

Replicate this formula into cells B25 to B28. As these cells are to be replicated,
methods three and four in Table 14.4 are the most efficient, as you do not have to
edit each formula with a different name for each row. If an examination question asks
you to show evidence of absolute and relative referencing, then method three would
be the most appropriate. If named ranges are required or absolute and relative
referencing are not asked for in the question method four is the most efficient.

> = v' R o - -~
Counts the number of cells in the range B3 to B21
that contain the word ‘Director’

L e e S

=COUNTIF($B$3:$B$21, " Director")

Counts the number of cells in the named range Job
(B3 to B21) that contain the word 'Director’. This only
works if cells B3 to B21 have been named 'Job’

=COUNTIF(Job, *Director")

Counts the number of cells in the range B3 to B21 that

OUNTIF($8$3:9B$21,A24) contain the same text as the contents of cell A24

Counts the number of cells in the named range Job
(B3 to B21) that contain the same text as the contents
of cell A24. This only works if cells B3 to B21 have
been named "Job’

=COUNTIF(Job,A24)

Table 14.4 Alternative formulae using the COUNTIF function

To count the number of employees with less than five vears’ experience, place the
cursor in cell B31 and enter the formula =COUNTIE($C$3:$C$21,"<5").This
will look at the range C3 to C21 and count the cells with a number value of less than
five. The speech marks around the <5 are needed to tell Excel that it is dealing with
another formutla (in this case an inequality), rather than searching for the symbols
<5. The spreadshect should show the valtue 8.

To count the number of employees with ten or more years’ experience, place the
cursor in cell B32 and enter the formula =COUNTIF($C$3:$C$21,">=10").
The value calculated should be 5. Save your spreadsheet as Ch_14_Task_14h.
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Activity 14d

Open the file that you saved in Activity 14c¢. This spreadsheet lists all the students in a class.
Next to each student’s name is the colour of the house that they are in.

Place formulae in cells E2 to E5 that use both absolute and relative referencing and count
the number of students in each house.

Place a formula that uses in cell E7 to count the number of students with less than five clubs.
Place a formula that uses in cell E8 to count the number of students with 12 or more clubs.

IF

An IF function contains a pair of brackets and within the brackets three parts, each
separated by a comma. An example of an IF function is =IF(A1=5,A2%*0.05,"No
discount"). The first part is a condition; in this example, it is testing to see if cell A1
contains the number 5. The other two parts are what to do if the condition is met,
and what to do if it is not met. If the condition is met a number or label could be
placed in the cell, or a reference to another cell, or even a calculation that needs to be
performed. The same range of options applies if a condition is not met. In this
example, if the condition is met, the result of multiplying the contents of cell A2 by
the figure 0.05 is displayed in this cell. If the condition is not met this cell will
display the text ‘No discount’.

Task 14i

Open the file that you saved in Task 14h. Add a new label ‘Category’ into cell D2.
Place formulae in cells D3 to D21 to display ‘Very experienced’ for employees with ten or
more years’ experience and otherwise to display ‘Not experienced’,

A : T D

Open the file and place the cursor in cell

D2. Enter the label ‘Category’. Place the 1 Project 153

cursor in cell D3 and enter the formula: Job Years exp Category
_ _ r 0 1o Programmer 3 Not experienced
_IF(C3> - 10) Vel’y CXPCLICHCCd b} NOt ) Programmer 2 Not experienced
experienced"). The reason that C3>=10 3 jsriparant Analyst 12 Very experienced
. . . .6 iBishen Patel Sales 5 Not experienced
is used rather than C3>9 (which iIn many  ; supinder singn Engineer 7 Not experienced
circumstances would be a more efficient 8 jSergio Gonzalez Programmer 5 Not experiencad
. 9. Rupinder Vas Sales 6 Notexperienced
formula), is because one employee has 0.2 10 Heari Ramos sales 10 Very experienced
D . o a At e p .11 [John Mortlock Programmer 14 Very experienced
ycars .(,XPCI lence. AS th(’ ddt& dO('S not AH 12 [Cameron Garnham Analyst 7 Not experienced
contain whole numbers, there could be an 13 srianuthrie Director 3 Not experienced
1 o xr 1 9 5 vears experie N hi 14 Julia Frobisher Engineer 6 Not experienced
Clnp OY“ with >. }CEIIS Q\PU 1ence so thts 15 .Dan McNevin Programmer 9 Not experienced
would not work for all data. Do not use 15 [patrick O'Malley Engineer 11 Very experienced
. . . 17 :Thirumalar Asoxmani Sales 10 Very experienced
absolute referencing in this formula as the 15 seanosyme Programmer 2 Notexperienced
reference to cell C3 needs to change when 12 teacabusbusan Programmer 1 Net experienced
. . . . 20 {Brian O'Driscoll Programmer 0.2 Not experienced
you replicate the formula. Replicate this 1 wimVanHoffmann  Engineer 2 Not experienced

formula so it is copied into cells D4 to b /
D21. Your spreadsheet should look similar to this.
Save your spreadsheet as Ch_14 Task_14h.

Activity He
Open the file that you saved in Activity 14d.
Add a new label '"New students’ into cell F1.

Place formulae in cells F2 to F6 to display ‘Add to this house’ if the number of students in
the house is fewer than six or to display ‘Full’ if the number is six or more.
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Hint

Note that as the
conditions are all
‘greater than’, they
have been placed in
reverse order. For
example, if the value
for experience was
40 and the condition
<5 was first, then
>=5 next and then
>=10: the first
condition <5 would
be not true, so it
would go to the
next condition; >=5
would be true, so
the result displayed
would be
‘Experienced’; it
would never get as
far as the test for
>=10.

Nested formulae and functions

A nested formula or function is having one formula or function inside another one.
Sometimes nested formulae could contain several formulae nested within each other.
If the nested functions include a number of IF statements, be careful to work in a
logical order, either from smallest to largest or vice versa (depending upon the
question). Do not start with middle values, this will give incorrect results.

Task §4}
Open the file that you saved in Task 14i.
Change the formulae in cells D3 to D21to display ‘Not experienced” if they have less than

five years' experience, 'Experienced’ if they have five or more years’ experience and 'Very
experienced’ for employees with ten or more years’ experience.

For this task, three conditions exist. If the value for experience is:
® >=10 then display “Very experienced’

@ > =5 then display ‘Experienced’

® <5 then display ‘Not experienced’.

Place the cursor into cell D3 and change the formula so that it becomes:
=IF(C3>=10,"Very experienced", IF(C3>=5,"Experienced","Not
experienced"))

Notice how the second formula (highlighted in yellow) has been placed as a ‘No’
condition within the first formula. Be very careful to get the brackets correct, each
condition has one open and one close bracket. When you work through this
formula, it checks whether the value is greater than or equal to ten first; if so, it
displays the correct text. Then if it was not true it would check if the value is greater
than or equal to five next, if so it displays the correct text. As there are no other
conditions that could occur, rather than having another nested statement the
resulting text has been placed.

Replicate this formula mnto cells D4 to D21. Your spreadsheet should look similar
to this. Save your spreadsheet as Ch_14_Task_14;.

Activity 147 A ® 5 2
Open the file that you saved in 1 Project 153
Activity 14e. 2 Name Job Years exp Category
Change the formulae in cells F2 to F6 3 iaila Aboli - Programmer 3 Not experienced
. . . 4 iGregMina Programmer 2.Not experienced
to dlsplay ’Add to thIS hOUSG' If th.e 5 Sri .fary‘ami Analyst 12 \/eryefperienced
number of students in this house is '5 | Bishen patel sales 5 Experienced
fewer than six, ‘ldeal number’ if there 7 |Rupinder Singh Engineer 7 Experienced
are between six and ten students and _§& ;Sergio Gonzalez Programmer 3 Experienced
' r H 3 |Bupinder Vas Sales b Experienced
Full” if the number is more than ten. ’/'?;G:Henri Ramos Sales 10 Yery experienced
11 :John Mortlock Programmer 14 Very experienced
12 Cameron Garnham Analyst 7 Experiznced
' Brian Guthrie Director 3 Not experienced
Julia Frobisher Engineer § Experienced
' {Dan McNevin Programmer 9 Experienced
16 Patrick O'Malley Engineer 11 ¥ery experienced
17 ‘Thirumalar Asokmani Sales 10 ¥ery experienced
i Sean O'Byme Programmer 2 Not experienced
iea Cabusbusan Programmer 1 Notexperienced
0 |Brian O'Driscoll Programmer 0.2 Not experiencad
1 {Wim van Hoffmann Engineer 2.Not experienced
nled
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You could use
named ranges
rather than
absolute
referencing for cells
B3 to B21 and C3 to
C21. One
alternative formula
in cell B35 which
uses the named
range 'Job’ created
earlier in the
chapter is
=SUMIF(Job,A35,$C
$3:$C%$21).

SUMIF

Task 14k

Open the file that you saved in Task 14j.

Insert the label ‘Total experience for:" in cell A34, the label ‘Programmer’ in cell A35 and
'Engineer’ in cell A36,

Insert a formula in cell B35 that uses both absolute and relative referencing to calculate the
number of years’ experience for the programmers.

Insert a formula in cell B36 that uses both absolute and relative referencing to calculate the
number of years’ experience for the engineers.

SUMIF works in a similar way to COUNTIEF. It compares each value in a range of
cells and if the value matches the given condition it adds another related cell to form
a running total.

Add the labels as required by the task into cells A34, A35 and A36. Move the
cursor into cell B35 and enter the formula =SUMIF($B$3:$B$21,A35,$C$3:
$C$21). The total for this cell starts at zero. This looks at the contents of cach row
in the range B3 to B21 and compares the value in each cell to the contents of cell
A35 (which contains the text ‘Programmer’). If these two items are identical it adds
the value from the same row within the range C3 to C21 to the total. When all rows
in this range have been checked the total is

: e : - A
displayed in this cell. This happens within S I

- . - Total experience for:
a fraction of a second as you press the

Enter> kev or chanee anv value within Programmer 262
<Enter> key or change any value withir lengineer %
these ranges. ' ‘ e

To total the hours for the engineers,
place in cell B36 the formula =SUMIF($B$3:$B$21,A36,$C$3:$C$21). The
results of these formulae should look like this. Save the spreadshect as
Ch_14 Task_14k.

Open the file CLUBS.CSV.

Insert a formula in cell B37 that uses both absolute and relative referencing to calculate the
number of clubs attended by students in red house.
Replicate this formula in cells B38 to B40 for the other coloured houses.

Using lookups

The term ‘look up’, as used in the practical examinations, means to look up from a
list. It does not mean that you should use the LOOKUP function, as there are three
variations of the LOOKUP function that can be used within Excel. These are:
LOOKUP, HLOOKUP and VLOOKUP.

LOOKUP

LOOKUP is used to look up information using data in the first row or the first
O

column ot a range of cells and returns a relative value. For the purpose of the

practical examinations, this is probably the least useful of the three formulae.
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HLOOKUP

HLOOKUP is a function that performs a horizontal look-up of data. This should be
used when the values that you wish to compare your data with are stored in a single
row. The values to be looked up are stored in the rows below these cells.

Task 141
Open the file JOBS.CSV.

Insert formulae in the Description column to look up and display the JobTitle using the
JobCode as the look-up value.

Open the file JOBS.CSV and click the left mouse button to place the cursor in cell
C6. Enter the formula =HLOOKUP(B6,$B$2:$H$3,2) into this cell. This
formula will look up and compare the contents of cell B6 with the contents of ecach
cell in the top (horizontal) row of the range B2 to H3. When it finds a match, 1t will
take the value or label stored in the second row which is directly under the matched
cell. The two at the end of the formula tells Excel to look in the second row of the
given range. Replicate this formula into cells C7 to C27. The results should look
similar to this. Save the spreadsheet as Ch_14_Task_141. \

1 | Project 160
2. | JobCode 1 2 3 4 5 6 7
¢/ JohTitle Director | Engineer Analyst | Sales | Programmer | Tester | Clerical
| Name JobCode | Description
Laila Aboli 5 | Programmer
[ Greg Mina 5 | Programmer
8 | sriParyant 3 | Analyst
_9 Bishen Patel 4 | Sales
10 | Rupinder Singh 2 | Engineer
rﬁf' Sergio Gonzalez 5 | Programmer

Experiment with

these settings. VYLOOKUP

Change the value in . . . .

cell B24 t0 5.2 See VLOOKUTP is a function that performs a vertical look-up of data. This should be
the result of this used when the values that you wish to compare your data with are stored in a single
change. Now column. The values to be looked up are stored in the columns to the right of these

change the exact cells. The look-up data can be stored cither in the same file or in a different file.
match condition

from False to True
in cell C24, See the

result of this

change. Try other Open the file TASKS.CSV.

numbers like 5.9 in Insert formulae in the CurrentTask column to look up the client, using the TaskCode for the
B4 to see what look-up value and the file CLIENT.CSV. Make sure that you use both absolute and relative

happens referencing within your function.
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14.3

Open the file TASKS.CSV and click the left

mouse button to place the cursor in cell C3. The Client
Task instructs you to use the file CLIENT.CSV Rootrainer
for the lookup. Examine this file by opening it in Quattichem

a new spreadsheet. Look at the layout of this file
to decide which type of look up formula to use.
CLIENT.CSV looks like this.
Because it 1s stored with the look up data in
vertical columns, a VILOOKUP is the most
appropriate formula to use. Enter the tormula
=VLOOKUP (B3, Client.csv!$A$2:$B$8 ,2,FALSE) into this cell. This formula
will look up and compare the contents of cell B3 with the contents of each cell in the
left (vertical) column of the range A2 to B8 within the file CLIENT.CSV. When
entering this formula, you can add the yellow highlighted section of the formula by
moving the cursor into this file and dragging it to highlight all of the cells in both
columns, so it includes the look-up value and the result. The number 2 in the
formula tells Excel to look in the second column of this range. The ‘False” condition
in the formula tells Excel to only

Hothouse Design
Avricom

>

Binnaccount
LGY
Rock ICT

display the match if it 1s an exact LA B e
match. If you set this to True it *t.+| Current client list
will find the nearest approximate 2 | Name TaskCode | CurrentTask
match. When it finds a match, 1t '2 .| Lalla Abol 6 LCY
will take the value or label stored | Greg Mina_ 4 Avricom
. N _ _ 57| Sri Paryanti 6 LGY
in the second column which is to =1,
. & | Bishen Patel 6 LGY
the right of the matched cell. 7 . .
Reol; his f i 0 7 g Rupinder Singh 3 Hothouse Design
eplicate this formula into cells | Sergio Gonzalez 5 Binnaccoant
C4 ro C24. o ‘9 | Rupinder Vas 1 Rootrainer
The results should look similar 10 | Bryan Revell 1 Rootrainer
to this. Save the spreadsheet as 11| Henri Ramos 7 Rock ICT

Ch 14 Task 14m.

Activity 14h

Open the file TUTORS.CSV. This lists a number of students and the initials for their personal
tutor.

Insert formulae in the Tutor Name column to look up the tutor’s name using the file
TEACHERS.CSV. Insert formulae in the Room Number column to look up the room number

using the file ROOMS.CSV. Make sure that you use both absolute and relative referencing
within all of your functions. Save your spreadsheet.

Testing the data model

Designing a test plan and choosing your test data are the most important parts of
testing the data model. Choose data that will test every part of a condition. Be
careful to test ecach part of the spreadsheet with normal data that you would expect
to work with your formulae, with extreme data to test the boundaries and with
abnormal data that you would not expect to be accepted. Carefully check that each
formula and function works as you expect it to by using simple test dara.

For example, to test the look-up used in Task 14m:
@ make sure that cach number between 1 and 7 (normal data) 1s used in the TaskCode
@ usc 0 and 8 and other abnormal data
@ usc decimal values between 1 and 7.
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14.4

Write down each number and the expected results, before trying each number in the
TaskCode column. Check that the actual result matches the expected result for every
entry. If not, change the formula before starting the whole test process again. A test
plan for this formula would be similar to that shown in Table 14.5.

Formula in cell C3 using data from cell B3:

Data entry in B3 Data type Expec‘:ted result Actual result
1 Extreme/Normal Rootrainer

2 Normal Quattichem

5 Normal Hothouse Design

4 Normal Avricom

5 Normal Binnaccount

%) Normal LGY

7 Extreme/Normal Rock ICT

o) Abnormal Error — value not available
& Abnormal Error — value not available
1.3 Abnormal Error —value not available
5.6 Abnormal Error —value not available
72 Abnormal Error — value not available
94 Abnormal Error —value not available

Table 14.5 Sample test plan for Task 14m

Many marks are lost in practical examinations by careless use of ranges within formulae
and functions. Check that everything works before using real data in your model.

Selecting subsets of data
This means getting Excel to search through data held in a spreadsheet to extract only
rows where the data matches your search criteria.

Searching using text filters

Task {dn
Open the file that you saved in Task 14m.

Select from all the data only the employees who are currently working on jobs for
Binnaccount.
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To remove the
AutoFilter, either
click on the tick box
for (Select All), or
use select Clear
Filter in the drop-
down list.

Open the file that you saved in Task 14m and highlight cells A2 to
C24. Select the Data tab and find the Sort & Filter section. Click
on the Filter icon to display an arrow in the top right corner of
cach column, like this.

For this task, you need to use this arrow to select the people working on the
Binnaccount task. When you click on the CurrentTask arrow, a small drop-down menu
appears like this.

< Al Iag

Aproat

helash O'Leary
atrick O'Mallay

u-i

i

hirumalar Asckmani o

TaskCodr xCurrentrask Lv

61GY
4.Avricom
61GY

6 LGY

3 Hothouse Design
5'Binnaccount
1:Rootrainer

1 Rootrainer

7-Rock ICT

2 Quattichem
2:Quattichem
1 Rootrainer
5:Binnaccount
1 Rootrainer
1 Rootrainer
5 Binnaccount
5:Binnaccount

3 Hothouse Design

2:Quattichem

7 Rock ICT
3:Hothouse DESlgn
5 Binnaccount

Current client list

Name

Sergio Gonzalez.
Julia Frobisher
Patrick O'Malley

Wim Van Hoffmann

Thirumalar Asokmani

5 Binnaccount
5 Binnaccount

5 Binnaccount

5 Binnaccount
5 Binnaccount

1 }cUrrent client tist

kheljash O'Leary
atrick O'Malle
hirumalar Aso

\» TaskCod{> CurrentTask

[

ean O'Byrne

j, SortAtoZ

st b
-

| Sort Zto A
Sort by Color

it

In the Text Filters section of the menu, click on the tick box for (Select All) to
remove all of the ticks from every box. Then tick only the Binnaccount box, before
clicking on ;<. This will display only the five selected rows like this.

The same method can be use to select more than one company from the list. By
selecting different drop-down menu options, searches can be made using different

criteria in different colnmns. Save the spreadsheet as Ch_14 Task 14n.

Searching using number filters

Open the file that you saved in Task 14m.

Select from all the data only the employees where the task code is between three and

six inclusive.
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Hint

The method shown
here is an
alternative to
selecting only the
boxes for three,
four, five and six.
Even though it may
seem easier to click
on the tick boxes
for this question,
you will need to
use the Custom
AutoFilter window
where a number of
options are
required. The
Custom AutoFilter
window also allows
you to select is not
equal to and to
perform wildcard
searches.

Open the file and set the AutoFilter arrows for cells A2 to C24 as in the previous
task. This time the search will be performed on the TaskCode column. Select the

drop-down menu for this column using the arrow. Select Number Filters to get a
sub-menu. Select Custom Filter... to get the Custom AutoFilter window.

Custom AutoFilter 41 sort Smallestto Largest

Z] sort Largest to Smallest
i Sort by Color >

Show rows where;
TaskCode

Use ? to represent any single character
Use * to represent any series of characters

This will allow you to set the search criteria to
greater than or equal to 3.

Custom AutoFilter / \

Show rows where:
TaskCaode

H
:is greater than or equal to

@and hor

£
I
iis I#ss than or equal to

Use * tg represent any series|of charafters

/

AND

less than or equal to 6.

The drop-down options in each box of the Custom AutoFilter window can be
used to select equals to, not equal to, less than, or greater than, as well as the options
shown. Save the spreadsheet as Ch_14_Task_14o0.

Searching using more than one criteria

Open the file that you saved in Task 14m.

Select from all the data all the employees except John Mortlock and Sean O’Byrne who are
currently working on jobs for Quattichem or Hothouse Design.
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Open the file and set the
AutoFilter arrows for cells A2 to
C24 as in the previous task. This
time the search will be performed
on both the Name and
CurrentTask columns. Select the
drop-down arrow for the Name
column, Text Filters and then
select Does Not Equal from the
sub-menu. This opens the Custom

Custom AutoFilter

Show rows where:
Name

i
i does not equal

& or

@ And

| does not equal

Use ? o represent any single character
Use * to represent any series of characters

Lok ]

AutoFilter window, enter the : —
initial letter J in the right box

(this speeds up the search). When you click on the arrow for the drop-down list it
will show you all the Names starting with P, so select John Mortlock’ from the list.
Select the AND operator and repeat the process for Sean O’Byrne, selecting does
not equal in the left box and typing S’ to find Secan O’Byrne, selecting his name
from the list in the right box. Click on _e¢ .

Select the search arrow for the
CurrentTask column. Select from
this menu only the two tick boxes

Custom AutoFilter

Show rows where:

for ‘Hothouse Design’ and Currentlask

‘Quattichen?’, or select Text |equals RARE otouse D=siarl
Filters and set up the OR search ©and @O )

like this. |equals [=] |quattichem

Save the spreadsheet as
Ch_14 Task_14p. The results of
this task should look like this.

Use ? fo represent any single character
Use * to represent any series of characters

A B c . Activity 14i

.1 Currentelientlist - Open the file that you saved in Task

Name 14h. Select from all the data:
7 {Rupinder Singh 3 Hothouse Design  a) all the students with a tutor called
 Carneron Garnham 2 Quattichem Chris Scott

2 Quattichem b) all the students who will be using

3 Hothouse Design rooms numbered between 22 and 74
inclusive

¢) all the students except Kiah and

Hartati with a tutor called Kate
Morrissey or Mike Arnott.

23V 8rian O'Driscoll

Searching using wildcards

A wildcard is a character that is used as a substitute for other characters. The *
(asterisk) character is often used to show a number of characters (including 0) and
the ? (question mark) is often used to show a single character. Excel uses these
wildcard characters, but AutoFilter also contains other features that simplify some of
these searches.

Open the file that you saved in Task 14m.
Select from all the data only the employees who have a name that starts with the letter *S'.
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Open the file and set the
AutoFilter arrows for the cells A2

: Custom AutoFilter {@ g

. . .| Show rows whi H
to C24 as in the previous task. : ogar::s where
This time the search will be
) performed on the Name column.
Hint B -
™ hod sh Click on the drop-down arrow for
he?en?se; no SNOWR this column and select Text
alternative ta Fxl.ters followed by Begins o
selecting Text With... from the sub-menu. This
Filters, then Equals opens the Custom AutoFilte ;
and entering S* window. Enter the initial S1n the

before clicking on
oK,

right box like this and click on ,
.. You should find these four —____1 |current client list
rows. Save the spreadsheet as 2 |Name

" TaskCodi v CurrentTask |~

Ch_14 Task_l4q. |Sri Paryanti 6 LGY
8 Sergio Gonzalez 5 Binnaccount
17 Shelash O'Leary 1 Raotrainer
20 |Sean O'Byre 3 Hothouse Design

T s B i A
Vask l4r

Open the file that you saved in Task 14m.
Select from all the data only the employees who have a name that ends with the letter ‘a’.

This 1s a similar process to the

. Custom AutoFilter
previous task. Use the same

Hint process, this time selecting the Sh°:'ar;’:s where:

The method shown  Text Filters from the menu, then e ol
i . - ends with vl a v

here is an the Ends With... option to & i -

alternative to
selecting Text
Filters, then Equals

obtain the Custom AutoFilter
window. Enter the letter a in the —7]

and entering *a l'ight box like this and click on Use ? to represent any single character
before clicking on ~%_. You should find this single Use * to represent any series of characters
SO row. Save the spreadsheet as Lok || concel |

Ch_14 Task 14r.

S ST .

CurrentTask £
4 Avricom

o

Open the file that you saved in Task 14m.

Select from all the data only the employees who have a name that contains the
characters ‘O"".
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Hint

The method shown
here is an
alternative to
selecting Text
Filters, then Equals
and entering *O’*

before clicking on
[T

The method shown
here is an
alternative to
selecting Text
Filters, then Equals
and entering ?ea*
then =9¢..

Again, select the Text Filters from
the drop-down menu in the Name
Shaw rows wheres ..
Name - column. This time select the

[—— I5 J Contains... option, enter the letter
; — O followed by an apostrophe to the
E [

right box and click on e¢.. You
should find these four rows. Save

Use 2 to represent any single character the spreadsheet as Ch_14_Task_14s.

Use * to represent any series of characters - = et

Custom AutoFilter

B .. . C

[¥]TaskCod{ ¥, CurrentTask [x!
17 {Shelash O'Leary 1 Rootrainer
atrick O'Malley 5 Binnaccount <
Né;(aSean O'Byme 3 Hothouse Design

"23 |Brian O'Driscoll 3 Hothouse Design

Open the file that you saved in Task 14m.
Select from all the data only the employees who have a first name that has the second and
third letters as ‘ea’.

Using the same methods as the
previous searches, select the Text
Filter from the drop-down menu Sh°';::;"e"5 where:
in the Name column. This time

select the Begins With... option
and add the characters ?ea to the
right box before clicking on Zac. *

This tells Excel that the first letter ),,J&presem any single character

can contain any character. Then ~— || Use * to representany series of characters
there must be the letters ‘ea’ ok
followed by any other characters. E—
You should find these two rows.

Custom AutoFilter

f begins with
@ And

LY

Save the spreadsheet as ) A B C

Ch 14 Task 14t. 1 Currentclient list ~ [
2 |Name - [¥|TaskCod{>|CurrentTask [/
:W ean O'Byrme : ~ 3'Hothouse Design
2 ILea Cabusbusan ‘ 7 Rock ICT :

[e—

Open the file that you saved in Task 14h. Select from all the data:

a) all the students with a forename that starts or ends with the letter ‘R’

b) all the students with a forename that contains the letters ‘eth’

¢) all the students with a forename that contains the letters ‘Jam” and who have a tutor
who uses room 60.

Sorting data

Before you try to sort any data, make sure that you select all of the data for cach
item to be sorted. One common error in practical examinations is to select and sort
on a single column. If you were to do this, the integrity of the data would be lost.
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You can sort into
descending order
rather than
ascending order by
selecting Z to A
rather than Ato Z
in the Order box.

Table 4.6 gives an example showing correct and incorrect sorting on the student’s
name for a spreadsheet containing their test results in Maths and English. The
yellow shaded cells show the areas selected for the sort. Note how the results for
each person have been changed when sorting without highlighting all the data.

Name M‘ahs | English ﬂ Name | Maths EnglishM EnZIish
Shelia | 72 75 Karla 52 75 Karla 72 75
Marcos | 64 34 Marcos | 64 34 Marcos | 64 34
Vikram | 61 44 - Shelia | 72 75 Shelia | 61 44
Karla 52 75 Vikram | 61 44 Vikram | 52 75

Table 4.6 Correct and incorrect data selection for sorting

5.8 B
asi [4u

Open the file SALARY.CSV.
Sort the data into ascending order of surname, then ascending order of forename.

Open the file SALARY.CSV. Highlight all the cells in the
range A2 to C43. Do not highlight row 1 or the column
headings would also be sorted within the employee
names. Select the Home tab and find the Editing section.
Click on the Sort & Filter icon to obtain the drop-down
menu. Select Custom
Sort... to open the Sort ot
window. In the Sort by
box select Surname from
the drop-down list. This
will be the primary sort
for this task. Make sure
that the Order box
contains A to Z to sort —T|
the data into ascending
order.

To add the
secondary sort to this
data you need to add a

LB AutaSum

Sort& Find &
Filter > Select~ |

[¥ My data has headers

=l

Sort

Copytevel, | 2

Gl

[ Zaacdtevel ][ X pelte evel

&} My data has headers

- Coumn o, SOTEON
SCCOI_ld ‘ICVCI to thc Sortby  |sumame «| [valies =
Sort window. Click on Thenby | Volues =

Zuaddtevel to add the
second sort level. In
the Then by box sclcc% {
Forename from the
drop-down list. Again,
make sure that the
Order box contains A to Z to sort the data into ascending order. Click on % to
perform the sort.

|~k
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14.6

The data should look like this. —_— A 8 T C

______ Forename ‘Sumame  Salary

Activity 14k 2 laila Aboli 25000
Open the file that you saved in Activity14h. Sort the 3 |Thirumalar: Asokmani 10000
data into descending order of tutor name, then & lea Cabusbusan 28000
ascending order of forename. 3 juam Chi 8500
_& iDan  :Dare . 14000

‘‘‘‘‘‘ Iubia Frobisher 18500

Using display features & [Cameron -Gamham 36000
5 Jake Garnham 12560

Many of the features described in this section can be 10 /lauren  Garnham 6200
applied to an individual cell, a range of cells, to one or .22 Jack. (Gonzalez 8200
more rows or columns, or to the entire spreadsheer, 2238l Gonzalez 26000
) R 13 |Brian Guthrie 43000

To apply the feature to the entire spreadsheet, clickin = 7 0" vonica 5000
the top left-hand corner of the sheet. 15 Jamal Khan 2000
16 Kristy  King 12300

17 Brett Ling 3200

IR {Mnllhr finag TN

—1 that row.

£
12

To select a row or rows, click on the
number or numbers to the left of the
row and it will select all the cells in

To select a column or columns, click on the column le{ter or letters to select all the
cells in the column or columns. To select a single cell, click in that cell. To select a
range of cells, drag the cursor to highlight a range of cells. If you need to select
different cells or ranges from different parts of the sheet at the same time, hold down

the <Ctrl> key whilst making your selections.

Enhancing data

To enhance data, first select the data to be enhanced.
All of the enhancement features are located using the
Home tab. The Font section contains icons ro allow
you to set the cell contents to underlined, stalic
(sloping) or bold.
The font size of a cell can be changed by either

typing a new size in the point size box or using the
drop-down menu to select a suitable size.

Cells can also be enhanced using different colours for
the background of the cell. Again, highlight the area to be
coloured and select the drop-down menu from the Fill
Color icon. The drop-down menu looks like this. There
are a number of standard colours as well as colours selected
by Excel for the current colour schemes. If the colour that
you want is not there, click on the colour palette icon.

If you are selecting colours, ensure that the
foreground and background colours contrast and can be
casily seen when printed. The foreground colour of a
cell (the tont colour) can be selected in the Font section.

. Blore Colars.

The Font Color icon is to the right of the Fill Color icon. The drop-down menu
trom this icon is the same as the menu for the background colour.
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Activity 141
Open the file that you saved in Activity 14g.
Set all the cells in rows 1 and 36 to bold and italic. Underline the cell containing your name.

Set cells A1 to C1 to have white text on a black background. Set the background colour for
each of the cells in the range A37 to A40 to match the colour of each house.

Formatting cells

Formatting cells containing numbers changes the way a cell is displayed, but does
not change the values held within it.

Tasic 14y

Create a spreadsheet model that looks like this. Place A | B €
a formula in cell C2 that multiplies the contents of cell 1 [First Second  Product
A2 by the contents of cell B2. 21 1.2 5
Format cell A2 as an integer. '

Create this spreadsheet as shown. In cell C2 enter a | B
the formula =A2*B2. The spreadsheet will look 1 First Second  Product
like this. > 5 1.2 5 5
To tormat cell A2 as an integer, place the cursor ‘ '
in this cell and select the Home tab. In the Number section, click on the arrow in
the bottom right corner to open the Format Cells window.

i
i

Format Cells e T B |

faonal Fomnat - Cell
Finatting v as Table v &

Shaw the Mumber tab of the
Format CeBs dislog box,

\
When this window opens, it should have the Number tab selected. The Format
Cells window will allow you to format cells in different currencies, into percentages
or even as dates or times.

For this task, you need to format this cell as
a number. Select the Number option in the
Category: section. Change the cell formatting—|
to 0 Decimal places:. Click on _gec. to set
the formatting. The spreadsheet will now look
like this.

Format Celi

Pt | Abont | Fant, | Border | FA o | Protecion |

Lroduct

affer somushred formating

&
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If you compare the two views of the spreadsheet, you can see that cell A2 has
changed. The contents still remain 1.2 but in the second view the answer for the
product appears to be incorrect. To change the contents of cell A2 to a whole
number, use the INT function.

Original Formatted

B A B (

Second  Product 1 First  Second Product
3: 6 2, . 5 6

Task 4w

Open the file COSTS.CSV. Format cells A1, D1, D3 and G3 as a bold 14 point font.
Format all numeric cells in row 2 into their respective currencies to 3 decimal places.
Format all numeric cells in columns C and D into pounds sterling with 2 decimal places.
Format the cells E5 to E15 into Euros with 2 decimal places.

Format the cells F5 to F15 into Japanese Yen with 0 decimal places.

Format all cells between G5 and G15 into percentage values with no decimal places.

Open the file COSTS.CSV. Click in cell Al. Select the Home tab, find the Format
—— section, then use the drop-down list to change the size of this cell to 14 point.
Click the mouse on the Bold icon to set this cell to bold.
Click on the Format Painter icon and click in cell D1. Click on the Format ——
Painter again and click in cell D3, then Format Painter again and cell G3. This
process should copy the formatting from cell Al into these other three cells.

obs a?rzntjobs
— beBor oy L B L F 6 I

_1 iCurrent jobs Exct 16 Europe  Japan xvjobs Exchange Europe Japan

2 . 11033 150.974. Es : 1 151
3 iCustomer Job refereEstimate  Cosi,, Increa _3 [Customer JobrefereEstimate  Cost i
4 UK :24 Europe  Japan 3 lncre 2 ‘ Uk Europe  Japan ¢
.S iAvricom 4023 2940 % 0  4633.86  634090.8 42.85 s Avricom 4023 2940 4200 4634 634091
6 LGy 4122 192000 2 D 264792 36233760 | 4122 152000 240000 264792 36233760
7 {Hothouse 4123 1050 1654.95 225461 42.85 4123 1050 1500 1654.95 226461
_8 !Binnaccou 4125 320 524.0675. 71712.65 484 Binnaccou 4125 320 475 524.0675 71712.65
9 {Rootraine 4126 16240 LoD 25596.56  3502596.8 42.85 Rootralne 4126 16240 23200 25596.56 3502596.8
10 {Rock ICT 4128 12250 17500 1930775 2642045 4285  10RockICT 4128 12250 17500 19307.75 2642045
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Hint

If the currency
symbol that you are
looking for (e.g. ¥)
may not appear in
the drop-down list,
there are a number
of text options
available. In this
case you can select
JPY which is the
international
standard code for
Japanese Yen.

Hint

An alternative to
this for percentage
values with no
decimal places is to
highlight the cell/s,
select the Home tab
and click the
Percent Style icon
in the Number
section.

Move the cursor into cell E2. In the
Number section, click on the arrow in the
bottom right corner to open the Format

Cells window in the Number tab. Inth%a

Category: section, select Currency.

Set the number of decimal places to  —]

three. Although this is not the correct
number of decimal places for Euros, it
was specified in the task.

In the Symbol: section, select an
appropriate Euro format from the list.

You may need to scroll down the list of /

available currencies to find it. The Sample~

]

7Y eEuro (123€)
234\ Finish (Firfand)
1,239 {e French Belgum)

sency formats are used for general monetary values. Uise Accounting formats to slign decmal
| oints ' colueen.

arca will show you what the formatting of
the cell will look like when you click on
.. When you have checked this
formatting, click on o .

Repeat this process for cell F2, but this
time selecting Japanese Yen. Some
currencies like Japanese Yen have no
decimal places and so would normally
need to be formatted to zero decimal
places, but in this task you were told to
set this cell to 3 decimal places. The
Format Cells window should look liké
this. Click on o

To format all the numeric cells in

Format Cells

| thember | | pbgrment [ Font.. | erder. A | Protection]

1 sample
¥150.973

{Accountng
jDate
i [Teme
i| ! |Percentage
[Fracton
| Scentiic
Text
Soedal
Custom

i
I
!
|
|
|

Currency formats ave used for general menetary vahes. Use Accountng formats to abgn decmal
pontsin a coummn,

ST

columns C and D, highlight all cells in the range C5 to D15. Then open the Format

Cells window and set the Category: to Cur

two and the Symbol: to pounds sterling (£)

rency, the number of Decimal places: to
. Repeat this process for cells E5 to E15,

selecting Euros with 2 decimal places, and for cells F5 to F15 with Japanese Yen set to
no decimal places (which are the appropriate formats for both of these currencies).

To format all cells between G5 and G15

into percentage values, highlight this

range, then in the Format Cells window set the Category: to Percentage. Set the
number of Decimal places: to 0. Resize columns as necessary. The tinished

spreadsheet should look like this.\

A

o B N ..b g £ . G

1 Current jobs Exchange turope Japan
2 V €1.103'  ¥150.974
3 |Customer Jobreference Estimate  Cost Increase
4 UK Eurcpe Japan % Increase
5 |Avricom 4023 £2,940.00  £4,200.00 €4,634  ¥634,091 43%
6 LGY 4122 £192,000.00 £240,000.00 €264,792 ¥36,233,760 25%
7 IHothouse Design 4123 £1,050.00  £1,500.00 €1,655  ¥226,461 43%
8 Binnaccount 4125 £320.00  £475.00 €524  ¥71,713 48%

[Rootrainer 4126 £16,240.00 £23,200.00, €25,597 ¥3,502,597 43%
30 |Rock ICT 8128 £12,250.00 £17,500.00 €19,308 ¥2,642,045 43%
11 |Quattichem 4129 £1,400.00 £2,000.00 £€2,207  ¥301,943 43%
1zliGY 4130, £10,800.00 £12,000.00 €13,240 ¥1,811,688 11%
13 Hothouse Design 4131 £72000  £720.00. €798  ¥108,701 0%
14 iBinnaccount 4132 £1,680.00  £2,400.00 £2,648  ¥362,338 43%
15 |Hothouse Design 4133 £4,500.00  £5,000.00 €5,517  ¥754,870 11%
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Activity 14dm

Open the file that you saved in Activity 14g.

In cell A41, place the label ‘Total’.

in cell B41, add the total number of students in all houses.

in cell C36, add the label 'Percent’.

In cells C37 to C40, calculate, using absolute and relative referencing, the percentage of
students in each house. Format these cells as a percentage with 1 decimal place.

Activity 14n

Open the file ITEMS.CSV.

Format cells A4 and A5 so that they are bold, italic and 20 points high.

In cells C3 to F3, place current exchange rates for each currency shown. Use the internet (or
exchange rates supplied by your teacher) to do this. Do not format these cells as currency.
For each cell in the range C8 to F22, calculate the price of each item in the correct currency.
Format each of the cells in the range B8 to F22 in the appropriate currency with the appropriate
number of decimal places.

Adjusting rows and

columns 1 |Current jobs
In Section 4.2, you learnt how to —jCalibd ,
expand column widths using the drag _ jate
handle to make sure that all data is e
visible in the spreadsheet. Row heights ‘ 1340.00
can be adjusted in exactly the same way. -/ 43 Copy ,000.00
The settings for row heights can also /] .. | ,050.00
be changed by right clicking the mouse /- 320,00
button on the row number on the left / .5 77 . 428000
to obtain this drop-down menu. 1 Insert ,250.00
The row can be hidden from view 1 Delete ,400.00
by selecting the Hide option, or can R Clear Contents ,800.00
have a different row height set using Y % Format cels... ‘ £720.00
the Row Height... option. This option .4 Row Height... 680.00
opens the Row Height window, where & 500.00
you can adjust the height setting before| 2 -
clicking on Zoc.. 4 Unhide

The column width can be hidden or
adjusted in a similar way. To get the drop-

) ‘ Row Height
down menu click the right mouse button
. PR ——
on the column heading at the top of the N Row height: | B |

column.

Adjusting page orientation

You may need to change the page orientation
from portrait to landscape, especially when
displaying the formulae that you have used.
To change this select the Page Layout tab, :

and find the Page Setup section. Click on the TR
Orientation icon, then select either Portrait Partialt
or Landscape from the drop-down menu.

tandscape

Exchange turope Japa

s S S
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Hint When preparing your spreadsheet for printing, you can adjust the layout of the
spreadsheet on the printed page/s using Print Preview. To do this, sclect the Office
button and then Print from the drop-down menu. Select the Print Preview option
from the sub-menu. The print preview of the spreadsheet is shown. If you need to
adjust how your spreadsheet appears, you can click on the Page Setup icon in the
Print Preview tab to open the Page Setup window.

This window can be
used as another
way of changing
the page
orientation.

Preview and print the document

Select a printer, number of copies, and
ather printing optians before printing.

=

i g :

L8 Quick Print b e Show Marging
Send the dacument directly 1o the default : ’

printer without making changes.

Prnt Preview

Freiiew and mske hangis to pagRy befe
printing. = 2

If you need to change the
number of pages wide or tall in
the printout use the Fit to:

Page Setup

Crientation

radio button in the Scaling © Portait € Landscape
section and select the number
of pages. | 5=

@ Adjust to: % normal size

Ensure that if you set a
printout to a single page wide
that all the formulae/ values and || rapersize: a2
labels can be clearly seen. If print qualty: | 1200 cp
the font size 1s so small that it is || Fistpagenumber: [aute |
not clearly readable by an
examiner, you may not be
awarded the marks for that
section. When you have

changed the page settings click .

on ok .

3 Fitto:

[

Qptions... .

14.7 Save and print data

Save your work regularly. As recommended in Section 13.1, it is a good idea to save
difterent versions, both in your work and in the practical examinations, cach with a
difterent version number. It you make a mistake and corrupt a file, you can always
go back and redo a small part of the task without losing too much time.

When printing your spreadsheets, make sure that you have adjusted all column
widths and row heights to ensure that all printouts show all:
@ labels in full
@ formulac in full
@ data in full.

217
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14.8

Do not used
stacked column
charts or stacked
bar charts for the
practical
examinations

Remember that the examiner can only mark what can be seen. If you don’t show
that you have done, it will not get you any marks. Many candidates forget to submit
printouts showing the formulae used — check that you have worked through how to
display formulae in Section 14.2. You can use screenshots to show how you
achieved your results. Make sure that all printouts contain your name, candidate and
centre number. To print, select the Office button followed by Print.

You may be required to export your spreadsheet data into different formats. In
Excel, this is done by selecting the Office button followed by Save As. This will
allow you to export the data into common text formats like .txt (text format), .rtf
(rich text format) and .csv (comma separated values). Although other export
features exist, these should be sufficient for the practical examinations.

Produce a graph or chart

In the examination, you may be asked to select an appropriate chart for a purpose.
Which chart is the most appropriate is often very difficult to work out. For the practical
examination, the choice will be between a pie chart, a bar chart and a line graph.

@ Pie charts: if you are asked to compare percentage values, a pie chart is often the
most appropriate type because pie charts compare parts of a whole. An example would
be comparing the percentage of children who preferred ice cream, jelly or trifle.

© Bar charts: these show the diffevence between different things. A bar chart is
traditionally a graph with vertical bars, but is called a column graph in Excel. This
is a little confusing but in the practical examinations to create a vertical bar chart
you would need to use the ‘column chart’ and for a horizontal bar chart (with the
bars going across the page) you would need to use the ‘bar chart’. An example
would be showing the number of items sold by five people in the same month.

@ Line graphs: these are used to plot trends between two variables. An example would
be plotting the temperature of water as it was heated against time. You could then
find any point in time on the graph and be able to read the corresponding
temperature, even if the temperature had not been taken at that time.

Creating a chart

To create a chart, you have to highlight the data that you wish to use. This is
highlighted in the same way as before. If all the data is together (contiguous data)
this 1s easy. Sometimes in the practical examinations you will need to highlight data
that is not kept together in the spreadsheet (non-contiguous data). To do this, hold
down the <Ctrl> key whilst making your selections.

Open the file EMPLOYEES.CSV. This shows the job types, the number of employees with that
job type and the percentage of employees with that job type.
Create an appropriate graph or chart to show the number of employees with that job type.
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Hing

Keep your charts
simple — do not use
3D charts or add
features that are
not a necessary part
of a task. A simple
chart is more
effective.

Open the file and highlight only cells Al to B8. The highlighted data should look like
this. This highlighted area will be the cells used to produce the graph. Notice that
the cells containing the column headings (Al and B1) have been included in this
selection as these will be used as the labels in the chart (they can be changed later if
the question asks for different labels).

C
( o] -Kumber of staff |Percentage
|pirector 3| 0.0483871
[Engineer 12| 0.19354839
|Analyst .4 0.06451613
sales  16/0.25806452
Programmer , 9] 0.1451612%
|Tester 5| 0.08064516
[Clerical 13| 0.20967742

8 62

Decide what type of chart you will need for this task. Look at the data and decide if
it compares parts of a whole; shows trends between two variables; or shows the
difference. In this task, the data shows the different numbers of employees in each job
type, so a bar chart is the most appropriate chart type and in this case you can use a
vertical bar chart.

Select the Insert tab and find the Charts section. Then select a vertical bar chart
(labelled Column in Excel) and select a Clustered Column chart from the drop-
down options. The finished bar chart will look like|this. Save this chart for later use.

(I

,‘"
5%
Gl

b
ko

Seatter

‘Cowmen tine B O Bart . Area Scafer (Ofher
» e < S - s ChargsT

\' g Compare waiues aCross Crleygories
Nu b er Of Staff | by using vestical rectangles.
Use it swhen the order of categoris:
L P e not importent or for di

20 e e counks sudlas & §
1 5 s 5 - SR
10

5 -

0 % Number of

staff

Tester
Yerical

3
2
15
j3)
=
)

Engineer
Analyst
S

Programm
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Taslk 4y

Open the file EMPLOYEES.CSV. Create an appropriate graph or chart to show the
percentage of employees with that job type.

Open the file and, using the <Ctrl> key

B

and the mouse, highlight cells Al to A8 and Number of staff
C1 to C8. Do not highlight any other cells. 3 0.0483871
The highlighted spreadsheet should look 12 0.19354839
like this. 4 006451613

Decide what type of chart you will need 16° 0,25806452
for this task. Again, look at the data and |Programmer. 9: 0.14516128'
decide if it compares parts of a whole; Tester 5°0:08064516,
shows trends between two variables; or ;z 0.20967742

shows the difference. In this task, the data
compares parts of the whole, so a pie chart is the most appropriate chart type. Select
the Insert tab and find the Charts section. Then select a Pie chart and the 2-D Pie.
The finished pie chart will look like this. Save this chart for|later use.

|
Percentage l

ular

- @ ol |
Director : i ; e T

. | Column ling - cPie o Bars Area Scatber Qther ¢t
B Engincer 1 - - A - *  Chars~
& Analyst Lo G Gnes oo
2 Sales

& Programmer

# Tester

Task 14z

Open the file RAINFALL.CSV. Create an appropriate graph or chart to show a comparison of
the monthly data for towns A and B.

Open the file and highlight cells Al to C15. Decide what type of chart you will need
for this task. Again, look at the data and decide if it compares parts of a whole;
shows trends between two variables; or shows the difference. In this task, the data
shows trends between the date and the total amount of rainfall that had fallen by
that date. Because specific dates are used
and the rainfall is cumulative, a line graph
is the most appropriate type. As there are
two towns shown in the data, you will
make a comparative line graph using both
data sets. Select the Insert tab and in the
Charts section select a Line graph and the
2-D Line (the top left icon).

Bar . frea’ Seatter . Other
A v v Charts

alumn  Line M2

s - -
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The finished line graph will look 0
like this. Save this chart for later use. — 3; o
%88 === Rainfall in
100 millimetres
g 3
8 e d g v i Town A
<r <r <r <t <t =t sl e .
T 2 2 2 3 3 3 — Rainfall in
g g g9 g 9« millimetres
—_— o v o~ [ —_— —_—
2 2 2 2 2 T 2 Town B
Modifying a chart S35 333553

Task idaa

Open the chart saved in Task 14x. Add a chart title ‘Employees’, category axis label ‘Job type’
and value axis label ‘Number of staff’. Do not display a legend.

Open the chart that vou saved in Task 14x. Move the cursor onto the chart title and
click the left mouse button on the title to select it, like this. With the title selected,
highlight the title and replace the text with the new title ‘Employees’.

= .. y 3

‘I\Il*n:ber of staff] Employees

& Number of staff | & Number of staff |

You have to add a new axis label to the category axis. To do this select the Insert
tab, then in the Text section select Text Box. Click the left mouse button on the
chart near the category axis and type in ‘Job type’. Resize the text box and change
the font style, size, etc. to match the rest of the chart. Move the text box if necessary.
It should look similar to this.

. You can repeat this process to add

T the value axis label “Number of staff,
but you may find it quicker to highlight
the text box for Job type’, copy and
paste it, then edit and move it. This will
save time formatting the new text box
to match the existing one. You can
rotate the text through 90 degrees
using the green handle.

Employees +

B Number of staff |

Employees
After rotating the text, move the chart and ety
place the value axis label to the left of the axis. To Bl
remove the legend (the key), click the left mouse g o
button on the legend and then press the <Delete> E ;.
key. Again, edit the layout of the chart so that it =y
looks like this. >

>
c\o‘ & & @é & &
& o

< Job type
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Hint

It is worth spending
time browsing
through each of
these chart layouts
to see what is
available.

Activity 14o

Open the file that you saved in Activity 14a. Use this data to produce a vertical bar chart
comparing the number of days worked for each person, except Aminat and Sukrit. Add an
appropriate title and labels to the chart. Do not include a legend.

Activity [4p
Open the file WEBHITS.CSV. This contains data about the number of members for an online

book club and the average number of website hits each week over a nine year period. Create
and label an appropriate graph or chart to show a comparison of these two sets of data.

Tasl 14bb

Open the chart saved in Task 14y.
Display all segment labels and percentage values on the chart. Do not display a legend.
Extract the segment for engineers.

Open the chart saved in Task 14y, click on the chart with _»-
the left mouse button and select the Design tab. Select from
the Chart Layouts one which displays the segment labels
and percentage values. Other layouts display the segment
labels and values, some include a legend. Selecting the first
option changes the chart from this to this.

Percentage

Percentage oirector

B Director

& Enginegr

B Anzhyst

1 Sales

B Programmer
B Tester

1 Clerical

Percentage

Director

To extract the segment for engineers, click the left
mouse button on the segment for engineers and
then click again. Now click and hold the mouse
button to drag the segment out from the pie in the
direction of the red arrow shown in the diagram

above. This pulls out the segment so that it looks
like this. Save this chart for later use.

st
4

¥

oA

Open the file that you saved in Activity 14m.

Create a pie chart showing the name of each house (the colours) and the percentage of the
class in that house. Add the title ‘Percentage of students in each house’. Extract the segment
for the Yellow house.
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Using secondary axes

Taslc 14ec
Open the file RAINFALL.CSV.

Create an appropriate graph or chart to show a comparison of the rainfall and average
temperatures for each month in only town A. Add a second value axis to the chart for the
temperature series and label and scale these axes appropriately.

Open the file RAINFALL.CSV and highlight
the dates and data for Town A; this is in cells
Al to B15 and D1 to D15. Select the Insert

tab and then in the Charts section select a Line

graph. Use the top left option from those
available (this will generally be the most
frequently used choice). The line graph will
look similar to this.

300
250
200
150
100

N

It 1s difficult to read the values for the

temperature, so adding and scaling a 200

01/07/2014
01/10/2014
01/01/2015

01/01/201
01/04/2014

second value axis will make it easier to o

read the graph. o

Click the left mouse button on the
150

data series for the temperatures (the —
100

red data line in this example), so that
50

it shows each of the points plotted like
this. Right click the mouse button on

. . . o O O O .©
this data series to obtain the drop- '\5&\@ \&d‘” \&\»"” \Qb\“i‘\' \&\w& \»Qv“& \0\*»N
down menu and select Format Data SO G

Series.... This opens the Format
Data Series window.

Select the Series Options section on the
left (it may already be selected), and use the

= Rainfall in
millimetres
Town A

== Average
temperature

centigrade
Town A

Rainfall in millimetres
Town A

Average temperature
centigrade Town A

Format Data Series

o Series Options
Marker Opti Plot Series On
Marker Fill

£ Primary Axis

radio button to change the axis type from a
Primary Axis to a Secondary Axis. Click on
&= Your graph will now look similar to this.

300 25
250 //’\ S
200 / 15 Rainfall in
150 10 millimetres
/ fV \ Town A
100 // T 5
50 :;bv 0
0+~ .5 Average
T T T *T *T T 0 temperature
8 8 8 L 88 8 centigrade
= 8 B T & = = Town A
LT
S 5 5 3 3 o o

Line Color @ Secondary Axds
Line Style

Marker Line Color
Marker Line Style
Shadew

3D Format

The secondary axis is now visible. Excel has attempted to scale these axes but you
are now going to adjust them further. You will change the primary axis so that it is set
between 0 and 240 and the secondary axis so that it is set between -1 and 23. These
values have been extracted from the original data: the total cumulative rainfall is

240 millimetres, and the temperature changes between -1 and 23 degrees. It would be
acceptable to use values like -2 to 24 or even the -5 to 25 suggested by Excel for this.
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To change the primary axis

‘Cumulative rainfall in millimetres’ and

——Rainfall in miflimetres Town A

250 25
Cl o) c 1 C < 1"\‘ 1 C l 1 ‘. /
values click on the axis labels like this NS /\ 2
) [ X s
150
" // rioe Rainfall in millimetres
0 Town A
{// \_F5
A Average temperature
so //d 0 centigrade Town A
0 T T T T ¥ 5
d o Qo o o Qo o
IS S L S LA < SO Ca o
51§ g
6»\.»’\/ 0\0’\/ \QV °b \Qq) \.»Q °'»\.»’\/
Format A Right mouse click within the axis
= | Axis Options labels to obtain the drop-down menu and
Number MR ) agto € B select Format Axis... to open the
Fil j Haimm: Format Axis window. In the Axis
Line Colt Majar unit: . . .
f Lf"es;m Mor it & A Options section, change the Maximum
ne e - Al o L. . N .
’ ™ value to a Fixed value using the radio
Format s button. Change the value to 240.0 and
’ Axis Options L~ CIiCk OnN Cee.,
umber Minimum: g Follow a similar procedure for the
Filt Maximum: . .
' o secondarv axis. Click the left mouse
Line Color Major unit: / | . .
Line Style | [soorunts & mug & Fee button on the axis, then right mouse click
Shadow and select Format Axis... to open the
30 Farmat | Format Axis window. In the Axis
Algnment | Options section, change the Minimum
Major tick mark type: value to a Fixed value of -1 and the
Minor tick mark type: Maximum value to a Fixed value of 23.
Axis labels: ’
Horizontal axis crosses:’ ‘ T
‘ @ Automatic 240
L 1 Axis valug: g /\ .
T Maximum axis value _E 190 19 g
: 7/< E‘
é 140 14 i
z g ; \ 3
| ; 2 9 9
‘ ’ £
T = 40 / 4
c AR VA 1
It 1s important to label these axes ‘°\ & &o FEFFT TS S 0 & ’
. . . i W “l Oh 5\ o o) O\ "
appropriately. Label the primary axis VT oo o T T e\ o

Average temperature centigrade Town A

the secondary axis “Average /
temperature’. These changes should leave the chart looking like this.

The legend has been moved so that all of the category axis labels are fully visible.
In the earlier printout only every second label was visible. The category axis should
also be labelled and the halt given a title betore it is submitted for assessment. Save
the file.

K

vt iveitay 18w
Sctivity (4

Open the file that you saved in Activity 14p.

Add a second value axis to the chart for the number of members and set the maximum
value for this axis to 3200.
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Formatting graphs and charts

You have already learnt how to enhance a pie chart by extracting a segment or
segments. Charts can also be enhanced using colour and/or shading. In some
circumstances, the use of colour can be used to ensure that the person reading a
document has their attention drawn to one specific part of a chart.

Task l4dd

Open the chart saved in Task 14bb. Change this chart so that the segments for ‘Programmer’
and for ‘Engineer’ attract a reader’s attention.

Open the chart saved in Task 14bb and click the Percentage
left mouse button on the segment for ‘Programmer’
and then click again, so that only that segment is
selected. Sclect the Home tab and in the Font
section click on the Fill icon. Select a bright colour,
for example red, from the colour palette. Repeat
this process for the “Engineer’ segment, this time
selecting bright yellow (bright orange may be
better if printing the chart). Now select other softer
colours for the other segments. The chart should
look similar to this. -
You can see that the brighter colours for the two

segments stand out and the softer pastel colours are not as prominent.

Activity i4s

Open the file that you saved in Activity 14q. Change the segment colours to match the
labels for each segment.

Using colour to enhance your charts is useful if you have a colour printer, but
printing a document created in colour on a black-and-white printer can cause
problems. This book has sections of coloured text designed to outline key elements,
like words in the glossary shown in red, instructions to follow in blue and field
names in green. If'a page containing these three colours was printed on a black-and-
white printer, each of the three colours would appear as a shade of grey. It would be
impossible to identify which words were glossary terms, instructions or fieldnames.
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With a black and white printer it is sometimes difficult to ensure that there is enough
contrast between different parts of a graph or chart, for example this chart, appears like
this if it is printed in greyscale (black and white).

2000

1500

1000

500

2000 \
Sales Sales

- 1500

2 Product A 1000 & Product A

Product B Product B
500

[ g -
2009 2010 2009 2010

Hint

An alternative is to
use gradient fills
which are also in
the Fill section of
the Format Data
Series window.

Format Data Series

Series Options

Border Color

Border Styles /
Shadow

3-D Format

7 Invertif negative

Fill

o fil

Sotid fif

Gradient fill

Picture or texture fi
Automatic

Transparef]
7} notats

i

L. Texture: box. Click on®

In this case, choose more contrasting colours, like a very light and a dark colour,
or use a patterned fill for one of the columns. To choose a patterned fill, click the
right mouse button on one of the bars, in this case the right-hand bar. From the
drop-down menu, select Format Data Series..., then in the Format Data Series
window select the Fill section. Select the radio button for Picture or texture fill
and choose a pattern from those available in the drop-down menu from the

Texture fills can also be applied to pie charts. Select a segment and right click the
mouse button, then select Format Data Point... to edit the fill type.

distinctive when printed in black and white.




Website authoring

CHAPTER

In this chapter you will learn how to:

& define and use HTML tags

use a text editor to create a webpage

display your webpages in a web browser

format text using pre-defined styles

I align and enhance text

create, edit and attach a cascading stylesheet

i create styles using specific and generic font families

set font sizes using absolute and relative values

use classes within a stylesheet

annotate your markup with comments

create numbered, bulleted and nested lists

use colour names and hexadecimal colour codes

i apply colour to text and backgrounds

i use anchors and hyperlinks within a webpage, to external pages and to
send email

open a webpage in a new window

design and create page layout using tables

create and format tables, including header, footer and body sections
insert, place and manipulate an image within a webpage
manipulate an image in a graphics package

create a hyperlink from an image.

For this chapter you will need these source files from the CD:
ALIGN.CSS SUBSCRIPT.HTM
COLOUR_CODES.HTM TURTLE.JPG

CLASS1.CSS
HTMLTIPS.HTM
PCTC.IPG
REMORA.HTM
REMORA.JPG
STYLE1.CSS
STYLE2.CSS

WEBPAGET.HTM
WEBPAGE2.HTM
WEBPAGE3.HTM
WEBPAGE4.HTM
WEBPAGES5.HTM
WEBPAGE6.HTM
WEBPAGE7.HTM

STYLE3.CSS

15.1 Introduction
What is a website?

A website is a collection of individual but related webpages that are usually stored
together and hosted by a web server. These can be programmed or created using
different languages including HTML, Sun Microsystems Java and Microsoft ASP. Each
webpage can include a variety of different objects such as text, images (including
moving images) and sound. You are going to develop your webpages in HTML.
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What is HTML?

HTML is an abbreviation for HyperText Markup Language. It is a text-based
language used to develop websites, and 1s often used within an intranet or on the
Internet. Files are written in HTML using a simple text editor (or web-authoring
package like Macromedia Dreamweaver or Microsoft FrontPayge). Files are written in
text format and are usually saved with an .htm file extension. These are file formats
that are recognised as webpages by web browsers like Microsoft Internet Explover or
Mozilla Firefox. You are going to develop your webpages using a simple text editor.

Getting started

A good technique for working on webpages is to tile three windows on the screen at
the same time: this means to fit them side by side like tiles. Whenever you do any
work in HTML, it 1s recommended that you have a text editor, a web browser and a
list of your files in their storage folder visible. Select the Start button, followed by
LDocuments. This opens the Documents window, which will look similar to this.

@‘ Internet
& tmeine: Bplorer
vy E-mai [ Graham

ot Live Mait 8
DBocumants ‘ T

3 Mucrozoft Offsce Excel 2007

Pictures

& Name Date madified Type

N
i
FHZ ricronott Otfrce Word 2007 U B Ch_15_version 1 15/12/2008 17:05 Microsoft]
) Music | ¥ Documents = ) X
. i i =) Ch_15_version_2 15/12/2008 17:06 Microsoft]
£ windows Meda Piyer N [| & Pictures
Games [
e p— ' | B tusic
Recent ems L i Mare »
i A Adobe Actobat8 Professionsl . :
7 Camputer § Folders v
Network a E,’E Graham
C
Cannect To % UD":m
» & Desktop
Control Panet 4 T Documents

& 0317 Textbook
i Chapter§

Chapter 10

Chapter11

4 Chapter12
Chapter13
Chapter 14

Cha‘p(er‘ls

2 items

Unfault Programs

A $Help and Suppoit

Place this window in the lower left
of the screen and resize it to fill about
a quarter of the screen.

Create a new folder for your
HTML work in your user area by
clicking the right mouse button on
the background for the file list on the

right and selecting New followed by |, dbid B

Folder. Rename this HTML. The

location of this will depend on the fome L Thisfuma;;;i):;;mmed
structure of the system you are using. || © ponument

Go into this folder and create new T Music

sub-folders for each task in this | taore »
chapter. Call these folders Task 15a || ***
to Task 15w. For cach task in this ‘
chapter you masst save all the tiles for
that task in the correct folder.

Make sure you are in the folder
Task 15a. This is where all the work
from the first part of this chapter will
be stored. The window should look
similar to this.

0 items
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Hint

When using
stylesheets later in
this chapter you will
have more than one
copy of the text
editor open and
may need to tile
these on the screen.

Hint

Note that all text in
HTML tags should
be in lower case so
that if it is
structured correctly
it would need little
editing to become
XHTML.

Open your text editor; in this case you are going to open Notepad. This can be
opened by selecting the Start button, followed by All Programs, Accessories and
selecting Notepad from the list of programs. Place this window in the top left of the
screen and resize it so that it fills about a quarter of the screen. The text editor will
be where we write the HTML markup to create each webpage.

Open your web browser and resize this window so that it fills the remaining half of
your screen. Make sure that the windows fit together and do not overlap. The screen
will look similar to this.

} hitp/fecowagitbesd.com/

Folders
5. Chagter 10
i, Chagter 1t 3
b Chapteriz
#1 Chaptes13
L Chspter1t
e Chapter1S
i HIMG
G TesklSa _°

Speits Day

0 items.

e

) Intermet | Protectad Mode: On

Although many people refer to HTML as a programming language, that is not
strictly true. It is a markup language that uses a set of markup tags to describe a
webpage to the browser. HTML tags are shown using angle brackets around them
like this:

<html>

The angle brackets tell the browser that this is a markup tag and not text to be
placed on the webpage. The browser does not display the HTML tags, but uses the
tags to display the content of the page. Most HTML commands have pairs of tags,
one to open the command and one to close the command. Each tag has a pair of
angle brackets around it.

The first tag that will usually appear in any webpage will be <html>. This tag
tells the browser that everything following this tag will be written in hypertext
markup language. The tag </html> tells the browser that this is the end of the
markup language. The forward slash shows that it is a closing tag. All other HTML
tags will appear between these tags.

Each webpage will have two clearly defined sections, the head and the body. The
head section starts with <head> and closes with </head> and objects between
these tags are not usually displayed by the web browser. Only a few tags are
universally accepted within the head section of a webpage, these are: <base>,
<link>, <meta>, <title>, <style> and <script>. The body section starts with
<body> and closes with </body> and objects between these tags should be
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Hint

If you look at other
websites’ HTML
markup you may
find a doctype
definition before
the <html> tag.
This is normal but it
is beyond the scope
of this book. It will
be needed if you
wish to validate
your webpages.

15.2

Hint

It is essential that
the text is typed
exactly as shown
here. One typing
error may cause the
webpage not to
function as
expected.

Hint

It is acceptable to
use capital letters in
the text that is
displayed on the
page, but notin
the tags.

displayed by the browser. The body
section should always contain a title. g cntm1>

This is the name displayed in the <head> '
browser toolbar. It is the page title if a <title>Webpage name</title>
</head>

page is added to Favorites and is the
title displayed in search engine results.
The basic structure of any webpage </body>
. </html>
should therefore include these tags. —
Insert tags for the head section here.
Insert objects to be displayed by the browser in the body section here.

<body>

Format text using pre-defined styles

All text added to a webpage should have a tag telling the browser what the text style
should look like. There are a number of pre-defined styles available for use in a
webpage. The normal paragraph style is obtained using <p> and ended with </p>.

Likewise, six heading styles are available and are defined with the style names <hl>
to <h6>.

Task {5a

Create and save a new webpage showing paragraph and heading styles.

Click the cursor into the text editor. Type this markup into the editor, replacing MY
NAME HERE with your name. Remember to always add your name, centre
number and candidate number to all of your printouts.

<html>
<head>
<title>Task 1%a/titles>
</head>
<pody>
<p>My first webpage by MY NAME HERE</p>
<hl>This is style hl, the largest heading style</hl>
<h2>This is style h2<«/h2>
<h3>This is style h3</h3>
<h4>This is style hd</héi>
<h5>This 1s style hb5</h5>
h6>This 1s style h6, smaliest heading style</hé6>
<p>This 1g style p, the paragraph style</p>
</body>
</html>

<
-
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&

Some browser
settings will make
this open in a new
browser window,
rather than the one
that you have just
opened.

When this has been entered and carefully verified (by checking this original
document with your typed copy), you must select File followed by Save As...,
which will open the Save As window. Click on Browse Folders to expand the
window. The expanded window will look similar to this. J

File names g

Save as fype: | Text Documents (“bd) oo

v Browse Folders

Encoding: | ANSL: omiman s X

Click on the folder names
until you find the Task 15a
folder created earlier in this
chapter.

You need to enter a filename
for the webpage. This filename
must be saved with an .htm
extension. If you do not use an
.htm file extension, this will
operate as a text file rather than as
a webpage. Enter the filename

Task_15a.htm and click on “seve N
N

The file should appear in the
Documents window and may
- look similar to this.

Make sure that the file displays
the browser symbol 2! to show
that this i1s a webpage and not the
text document symbol. The text

e

<« Task15a

i Pictures

' B Music
Bore »

Folders v

% Chapter1t  +
Chapter12 -
s Chapter13 ™

7 Documents

More »

Folders

; Adobe Scripts

H| My Data Sources

0417 Textbook My Received Files =
Adobe Scripts My Stationery
i GE

i OCR

Filename: “.ixt

Save 2s type: | Tt Documents (b} oo e oo

& Hide Folders

Encoding: |ANSk: o0 e n

i « HTML » Task15a

Type
& Documents This folder is empty.
bicre »
Folders v

£ Chapter12 -
Chapter13 !

File ﬂamz‘fask_liih!m

Save as types { Text Documents (W0 s, s

| 48/ Hide Folders

appears if you forget to add the
Jhtm extension to the filename.
Select the file Task_15a from
the Documents window and drag
this file (holding the left mouse
button down) into the browser
window. The screen should now
look similar to the screen shown
overleaf. The browser view now
contains your first webpage.
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|<htm>
<head>
<title>Task 15a</title>
</head>
<body>
ﬂwy first webpage by Graham Brown</p>
<nl>This is style hi, the largest head\ng style</hl>
<h2>This is style h2</h2>
<h3>This is style h3</h3>
<h4>This is style hd</h4>
<hS$>This is style h5</h5>
<h6>This s style h6, the smallest heading style</h6>
<p>This is sty¥e P, the paragraph style</p>
</body>
</html>

v first webpage by Graham Brown

This is style h1, the largest
heading style

This is style h2

4 This is style h3
i This is style b4
| Thisis solehs

Thix fa style b6, e szalied Beading siyie

& Muzic Task 152

Mere »

This s style p, the paragraph style

Folders v

' Task_15a HTML Dacument & sk 08/07/2009 17:09

8 Computer | Protected Mode: Off H100% v

15.3 Opening existing webpages and enhancing fext

To open an existing webpage in both the text editor and the web browser you must
first find the website in the Documents window. For all webpage files, including

those given in the examination, it is advisable to copy the files into a sub-folder of
vour HTML directory before starting.

Taslk [5b

Open the file WEBPAGE1.HTM and view this webpage in both the text editor and browser.
Improve this webpage by emboldening the word ‘bold’, setting the word ‘italic’ to an italic

font, setting the 3 in x3 as a superscripted character and setting the 2 in H20 as a
subscripted character.

Copy the file WEBPAGEL.HTM into your Task 15b folder. Drag this file from the
Documents window into your text editor. Drag another copy of this file from
the Documents window into your browser. The screen should look like this.

535 5 i
mHint

Editing is easier if
you ensure that the
word wrap is

S >‘~xy second x\hpn?e by MY NAME WERE</|
Emrex: can be enfianced in HFeeren Bays. Here are
some of those ways.
<p>Text can be Lax “hola</p
<Text can be made iralic</p»
Text cannot be underlined in latar versions

fy sccond webpage by MY NAME HERE

. it orarse 1o S5oke Yo ined In Jarer vorsjons of, | Text can be enhanced in different ways. Here are some
selected in DTSR Gn e BB 41 of those ways. |
Notepad. To do this, et ext m be made bl ’
use the Format | Tetcsabe madaaic

menu and check ext carmot be underred i Liter versioas of hml becanse it books Eie the text s a hyperkolc

that the Word Wrap
option is ticked.

i Computer | Protected Mode: OFF HINY v
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Hint

If you prefer you
can click the mouse
on the browser
window and then
press the function
key <f5> to refresh
the browser view
each time you have
saved the file.

Move the cursor into the text editor window and make the following changes to
the markup.

Replace the word
“first’ with ‘second’.

Replace MY
NAME HERE with
your name.

Place the tags <b
and </b> around the
word ‘bold’.

Place the tags <i>
and </i> around
word ‘talic’.

Place the tags </body>
<sup> and </sup> /hemt
around the number 3.

Place the tags <sub> and </sub>
around the number 2.

When you have made all these
changes to the webpage, save the page
by selecting the text editor, followed by
File, Save As..., sclecting the Task 15b
folder and entering the filename
Task_15b.htm before clicking on swe .

Test the webpage works by dragging
this new filename from the Documents
window into the browser window. The
new browser view should look like this.

<htmlz=

i

My second webpage by Graham Br

>Text can be enhanced in di
those ways.</h2*
be

I8 can be made <j>i
n>Text cannob be und

<
because it looks like the

syngn e e ]

s Dot o Y

<p=Text can be su

@ | & causernGrabam\C | 4] X |

/| File- Edit View Favorites * Tools™ Help

oo @Task15b P

i My second webpage by Graham Brown

Text can be enhanced in different
it ways. Here are some of those ways.

 Text can be made bold
| Text can be made izalic

Text cannot be underlined in later versions of html because it
| looks like the text is a hyperlink

: Text can be superscripted like ©

Text can be subscripted like H,

FMCTIVICLY 24

Open the file SUBSCRIPT.HTM and view this webpage in both the text editor and browser.
Improve this website by emboldening the word ‘emboldened’ and setting the word ‘italic’
to an italic font.

Set the 2 in 10 metres? and the 3 in 500 cm3 as superscripted characters and set the 2 in CO,
as a subscripted character.
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15.4

Hint

Remember to always
add your name,
centre number and
candidate number to
all of your printouts.
You will not gain
any credit in the
practical
examinations if
there is nothing to
identify the
candidate on the
printout.

Hint
If you attach more
than one stylesheet
to a webpage at
the same time,
those attached
later in the markup
have priority over
earlier ones.

Copy all HTML
exactly as shown,
including any
spaces.

Working with styles

Using styles in your webpages helps you to be consistent in the way the pages look.
Using styles is much quicker and easier than applying individual settings, such as
font face, font size, text alignment and font colours, to every piece of text in each
webpage that you create.

You have already met the heading styles h1 to h6 and the paragraph style p
earlier in the chapter. When you used these styles the web browser did not find any
of these style definitions in your HTML markup so used its own default settings.
However, you can set your own definitions for each style and the web browser will
attempt to apply these styles to the page. Styles are not only set for text, but can also
be used to define page layout, colour schemes and default settings for other objects
and links on the page. Using consistent styles is often important to give a ‘corporate
feel’ to a website. Particular elements like colour schemes, logos and font faces are
sometimes used to aid recognition of well-known companies or brands.

Styles are always defined in the head section of a webpage. They may be defined
in each webpage or defined in a stylesheet. If stylesheets are used, the stylesheet is
attached to the webpage in the head section of the markup. Although styles can be
applied individually to each page, it is more efficient to write, edit and attach one or
more common stylesheet/s to all the pages in a website.

Using stylesheets

You have already used different styles in your webpages, for example text set as a
heading style (hl to h6) or paragraph style. These styles are often gathered together
and held in a stylesheet. This is a collection of styles saved in a different file in
cascading stylesheet (.css) format.

One or more of these cascading stylesheets can be attached to a webpage, and the
styles in the stylesheet will be apphcd to this page. Where more than one webpage 1s
used, the styles only have to be defined once and attached to all webpages. This allows
companies to develop different stylesheets for specific items like corporate colour
schemes, corporate text styles and styles for a particular document or set of documents.

Open a copy of the webpage that you saved in Task 15a.
Apply the stylesheet STYLE1.CSS to this page and save this webpage.
Change the attached stylesheet to STYLE2.CSS and save this with a new filename.

Sclect the folder called Task 15¢ in your Documents window. Copy the file
Task_15a.htm into this folder. Rename this file as Task_15c¢.htm. Open this file in
your text editor and in your web browser. Copy the files STYLE1.CSS and
STYLE2.CSS into this folder.

Change the title of the webpage to Task 15¢. To apply the styles trom the
stylesheet STYLEL.CSS you must attach it to the webpage. Move the cursor to the
text editor containing the HTML and add this line of text below the title tags in the
head section of the markup.
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This defines the relationship of this link as a stylesheet, in cascading stylesheet
format and searches for the file stylel.css and applies this to the page. Your finished
— markup should look like this. Save this webpage. View this webpage in your browser.

<link rel="stylesheet" type="text/css" href="stylel.css">

<html>
<head>
<title>Task 15c</title>
<link rel="stylesheet" type=‘"text/css" href="stylel.css">
</head>
<pody >
<p>My first webpage by MY NAME HERE</p>
<hl>This is style hl, the largest heading style</hl>
<h2>This 1s stvle h2</h2>
<h3>Thisg is style h3</h3>
<hd>This is style hd</h4d>
b3 <n5>This is style h5</hb>
<h6>This is style h6, the smallest heading style</h6>
<p>This is style p, the paragragh style</p>
</body>
</html>

Hint You will notice that your webpage has changed from this to this.
The browser
settings on your
computer may
show you different

fonts to those ' My frst webpage by Grabam Browa My First wobpage by Graham Brown

shown here. This is style h1, the largest heading style This is style hi, the largest
This is style h2 headﬁﬂg Sﬁy%@
This is style b3

This is style bd

s te sl s
is is style b2

i

| Thisis sryiens

ER—— _ This is style h3
{ Tiss sk .o pageph s | || This is style h4
This 15 stgle bS

This is style b6, the smallest haading style | |

d This is style p, the paragraph style

/Done B Computer | Protected Mods: OFF 100w~ Done 18 Computer | Protected bode: OIF

The page content has not changed but the
styles applied to the page are very
different. Notice that the font face, sizes,
colours and alignment have all been My first web page by Graham Brown

Reminder i . ,
in this book: §pec1hed in the stylesheet. Tfhls stylcsheet This 1s S{{ﬁ(‘ }}1 The kﬁ”i}ﬂﬁ‘t hﬁ{iﬁﬂ{j
is a poor example because it contains too § : :
HTML markup isin  many variations. If you change the “"(:{ﬂ%
blue text. . markup to attach STYLE2.CSS to the This s sgle b
A stylesheet is in page rather than STYLE1.CSS, you i ) o ]
red text. should see something like this. This Is stile b3
This 1s the same webpage again, but :
with the slightly improved stylesheet
STYLE2.CSS, which has a background

colour defined in the stylesheet. You will s sviep e pargephsse s
discover how to create and amend these
stylesheets in Section 15.5.
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15.5

Hint

A serif font is one
which has small
lines or strokes
(called serifs) at the
ends of characters
like this:

NSerif L

A font that does
not contain serifs is
known as a sans
serif font.

Mint

Any number of
spaces can be
placed between the
style name and the
opening bracket.
This does not
change how the
browser interprets
the markup, but
sometimes makes it
easier for us to read
the markup.

Creating a cascading stylesheet

It is very easy to create a cascading stylesheet in your text editor. The structure of a
.css file has a few very simple rules. Stylesheets do not have tags in them as they are
not a markup language. Each style has a style name which is called a selector. The
selector is tollowed by curly brackets {}. Inside these curly brackets go the property
tor the style, followed by a colon and the property’s value. For example, if you want
to set the text in style hl to be centre aligned it .
would appear like this. (Note the American —— M1 {Text-align:
spelling of ‘center’.)

Each style can have a number of properties and values. If there is more than one
property then each property is followed by a

center}

semi-colon. For example if you want to set the hl {text-align: center;
: e : font-size: lépt;
text in style hl to be centre aligned, 16 points — A
font-weight: bold}

high and bold it would appear like this,. ——
It a value within a

style contains more than h2

one word, it must be

placed in speech marks like this.
Stylesheets are saved with a .css format (in a similar way to saving in .htm

tormat) from the text editor.

{font-family: "Times New Roman", serif}

Font families

Individual fonts can be specified, but these are not always available in all browsers,
so there are a number of generic font families, including serif and sans serif fonts,
that can also be used. These include ‘serif’, ‘sans-serif’, ‘cursive’, ‘fantasy’ and
‘monospace’, which has proportional spacing. The generic font family must always
be listed after the other preferred font/s. The font-family property must contain a
hyphen. In the example above, the font-family is set so that the browser will look at
the list of fonts installed in the machine, and will try to find Times New Roman first
(it 1s in speech marks in the stylesheet because there are spaces in the font name); if
it cannot find it, it will find any generic serif font that is available.

by §OE A8
fasi {a¢

Open a copy of the webpage that you saved in Task 15¢. Create a new stylesheet called
SERIF.CSS that sets all the styles as generic serif fonts. Apply this stylesheet to your
webpage. View the webpage in your browser.

Change the generic settings in the stylesheet to a different generic font style. Save the

stylesheet with a new name. Try all the generic style settings to see what each one
looks like.

Select the folder called Task 15d in your Documents window. Copy the webpage you
saved in Task 15¢ into this folder and rename the file as Task_15d.htm. Open this file
n your text editor and m your web browser. Edit the title of the webpage so it
becomes Task 15d. To attach the stylesheet to the webpage you must edit the third
line of the markup so that it becomes:

<link rel="stylesheel" type="text/css" href="serif.css">
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Hint

This technique
could save you time
which can be
invaluable in a
practical
examination.

Save the webpage. You are going to create the

hi {font-family: serif}

stylesheet by opening a second copy of the text ho amily: serif}
editor. Enter the following style definitions into it. h3  {font family:
Carefully verify your stylesheet by checking h4 {font family:
this original document with your typed copy. ho o (font family:
Save the file using the filename SERIF.CSS. ne Family:

Refresh your browser so that you can see the
effects that this has on the webpage.

Grouping style definitions

As all the styles have the same values for the font-family property, you can group all
of the styles together and change the value only once. This stylesheet can be
simplified to this single line.

Edit it and save it so that it N7 12 w3 04, 05,06, {font-family: serif}
replaces the old version.
Refresh the browser to check that it still works.

Edit this stylesheet so that it sets the font-family to ‘sans-serit’. Save this file using
the filename SANS-SERIF.CSS. Change the markup in the HTML to link to this file
and save this webpage. Repeat this process for each of the other generic font families.

Font size

Font size can be specified by setting absolute values, by setting values relative to each
other, or a mixture of both.

Absolute values can be used to set the number of points or picas or the number
of pixels high for cach character. If point sizes are used, there are 72 points to an
inch, so a 28 point font will be about 1 centimetre tall. This will not be affected by
the size or resolution of the monitor. The sizes specified are set as numbers with ‘pt’
to show it is in points, for example an 18 point font is written as 18pt. Some
webpages are created using the measurement in picas, which is abbreviated as ‘pc’
and is the equivalent of 12 points, so a 2 pica tfont size would the same as a 24 point
font. A pixel is one dot on a computer monitor. This means that pages will appear
differently depending upon the size and resolution of the monitor used. For older
style monitors, 1 pixel was often about the same size as 1 point, but full high
definition (HD) monitors now mean that characters appear much smaller on these
devices. The abbreviation for pixels is ‘px’. Other absolute values include ‘in’ to show
the measurement in inches, ‘em’ for centimetres or ‘mm’ for millimetres.

Tasl 152

Open a copy of the webpage and stylesheet that you saved in Task 15d. Edit this stylesheet
so that style h1 is 36 points high, h2 is 24 points, h3 18 points, h4 16 points, h5 14 points, hé
12 points and the paragraph style is 12 points high.

Change these settings to try and get similar results using the settings for pixels (the number
will depend upon your monitor display settings), picas, inches, centimetres and millimetres.
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Because all of the font settings are different in this case, it is more sensible to keep all
of the settings for each style together. It is possible to produce a stylesheet that gives
these results like this.

Although this works, it would be easier to edit if all of the settings for each style
definition are together like this.

Amend the markup for the
hi,h2,h3,hd,h5,hé,p {font~family: serif} chpage to link to the new
"7‘- {font-size: 3?-‘3“ stylesheet (SIZE.CSS) and save
h2 {font-size: 24pt} .
! onoTEnEer Anbe this in your Task 15¢ folder.
h3 {font-size: 18pt}
T L. (font-size: 16pt) Save the new stylesheet as
ns (font-size: l4pt} SIZE.CSS in the same folder.
né {font-size: 12pt} Refresh your browser so that
D {font-size: 10pt} you can see the effect that this
has on the webpage. Use trial
) ) . , 6‘1/ and error to try and get similar
hi font-family: serif; font-size: DL} :
LontToamt Y Serasy contTsize Y results with the other absolute
h2 {font-family: serif; font-size: 24pt} . .
h3 {font-family: serif; font-size: 18pt} si1ze settl.ngs.
h4 {font-family: serif; font-size: lépt} Relative Value.S are often
h5 {font-family: serif; font-size: l4pt} based upon prcwously defined
hé {font-family: serif; font-size: 12pt}  values for the fonts, as defined
8 {font-family: serif; font-size: 10pi)}

by the default browser settings.
Two values are show using the
abbreviations ‘em’ and ‘ex’. 1 em is the same as the current font size, 2 em is twice
the current font size, etc. This can be useful as this automatically selects the default
fonts set by the user in other stylesheets or by the browser. 1 ex is about half the
height of the current font size and is the measured height of the letter ¥,

Task 15§

Open a copy of the webpage and stylesheet that you saved in Task 15e. Edit the stylesheet
so that the paragraph style is 16 points high. Set style h1 so thatitis 3em, h2is 2 em, h3
1.5 em, h4 3 ex, h5 2 ex and h6 so that it is 1.5 ex.

Open the webpage saved in Task 15e and edit this to attach the stylesheet
SIZE2.CSS to it. Save this as Task_15f.htm in the folder Task_5f. Open the
stylesheet SIZE.CSS and edit it so that it changes the font sizes like this. Save this
stylesheet as SIZE2.CSS. View the webpage with this stylesheet attached. Notice the
difference in the em and ex sizes.
Other relative values
frequently used in cascading P
stylesheets are percentage

7
i h2
values, for example setting the \ -
font size to 200 per cent ha
would force the font to be ho font-size:
twice the size of the current s font-si

setting. Using percentage

values allows you more flexibility in the relative sizes of the fonts, which can be very
useful if classes are used. You will meet these later in this section. There is also a set
of pre-defined relative sizes that can be used. These are: “xx-small’, x-small’; ‘small’,
‘medium’, ‘large’, x-large’ and ‘xx-large’. Other acceptable relative values are ‘smaller’
and ‘larger’, which can be very useful if defining different classes within a style.
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For centre aligned
text, note the
American spelling
for center.

q

Hint

Line breaks should
not be used to split
a paragraph into
two. Each
paragraph should
have its own style
definition.

Task 15¢

Open a copy of the webpage and stylesheet that you saved in Task 15f. Edit this stylesheet
so that style h1 is xx-large, h2 is x-large, h3 is large, h4 is medium, h5 is small, h6 is x-small
and the paragraph style is xx-small.

Open the webpage saved in Task 15t and edit this so that the stylesheet SIZE3.CSS
is attached to it. Save this as Task 15g.htm. Open the stylesheet SIZE.CSS and edit
this so that it changes

. R . . hi f fant— fami . G E. Fontogioo- _ .
the font sizes like this. 1”; };OHE Ea’n?%y' Ser.l;’ Jontmeszes Xxllargf}
. . . g ronc-ramily: serlr; font-size: x- arge
Save this Stylesheet s h3 {font-family: serif; font-size: large}
SIZE3.CSS. View the h4 {font-family: serif; font-size: medium}
webpage with this h5 {font-family: serif; font-size: small}
stvlesheet attached. ne {font-family: serif; font-size: x-small}
o) {font-family: serif; font-size: xx-small}
Aligning text
A font style (or class within a style) can be
aligned in one of four different ways. You can h {text-align: left}
use the text-align property to format text so h2 {text-align: center}
that it is left aligned, centre aligned, right h3 {text-align: right}
aligned or fully justified, as shown in this hd  {text-align: justify}

sample stylesheet.

Taslk 15
asi is

5h
Open the file you saved in Task 15b. Add a new title ‘Aligning text’ in style h1. Change the
word ‘second’ to read ‘third".

Set the heading style h1 to be centre aligned. Set style h2 to be right aligned. Set style p to
be left aligned. Place a horizontal line below the title ‘Aligning text’.

Place additional blank lines before the title at the top of the page and after the horizontal
line.

Open the webpage saved in Task 15b and edit this by attaching a new stylesheet
called ALIGN.CSS. Add the title ‘Aligning text’ in style hl. Change the word
‘second’ in the paragraph style so that it becomes ‘third’. Save this as Task_15h.htm
in your Task_15h folder.

Create a new stylesheet like this called ;i te“‘al T Cer‘;ex ’
T 12 {text~align: right}
ALIGN.CSS. 2 13 {text-align: left}

Set hl to be centre aligned, h2 right
aligned and p to be left aligned. Save this
stylesheet. Check that this works and that the
styles have been applied correctly like this.

To place a horizontal line below the title
you use the horizontal rule tag. This is one of
the few single tags that are used in HTML. It
does not have an open tag and a close tag.

The tag appears like this.\

Aligning text

My thixd webpage by Graham Brosm

, Text can be enhanced in different ways. Here are some
of those ways.

Text can be made bold

Text can be made italic

Text cannot be underkined in fatex versions of hirml because it books B the text is 2 hypertnk

Text can be superscripted fke ¥

NS
<ar> Tent can be subscripted Bke H,
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Hint

The carriage
returns within the
HTML have no
effect on the layout
of the webpage.

Hint

Although the
underline
command is no
fonger part of html,
it can still be used
by setting it within
a style in the
stylesheet.

To insert a blank line before the title, move to the correct position in the markup
and insert a line break tag. Again this is a single tag and appears like this. _
This tag must appear within a style, for example between the <hl> e
and </h1> tags, or between the <p> and </p> tags. Place another line
break below the horizontal rule. Save the webpage again. The markup and page
should look like this.

Aligning text

My third webpage by Graham Brown

Text can be enhanced in different ways. Here are |
some of those ways

Text can be made bold
Text can be made italic

Text cannot be underlined in later versions of btnl because it fooks ke the lextis a
hypertink

Text can be superscripted lke x*

Text can be subscripted ke H,

{Denc i Computer | Protected Mode: Off H100% v

Enhancing text within a stylesheet

You are going to use some similar techniques to those used for Task 15b. This time
the enhancements will apply to the whole style (or class of style as you will see later
in this chapter). Each of the enhancements uses a different property setting. The
default value tor all three enhancements is normal. To get bold text, set the font-
weight property to ‘bold’, like this.
To italicise text, set the font-style property to ‘italic’, like this.
To underline text, set the text- '
decoration property to ‘underline’, like
this.

i w
g P
iasik §5i

Create a new stylesheet called MYSTYLE1.CSS and attach this to the webpage called
WEBPAGE2.HTM. This stylesheet will set style h1 to a bold, italic, 18 point font. If ‘Times New
Roman’ is available the browser will use that, otherwise it will choose ‘Times’, but if this is
not available any other serif font will be used. Make this text centre aligned.
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Notice that each
property and its
value/s are on a
new line. This
makes it easier to
read and check for
mistakes.

Copy the file WEBPAGE2.HTM into your Task 151 folder. Open this file in your
web browser and text editor. Enter this markup to create a new stylesheet called
MYSTYLEL.CSS. Refresh this file in your web browser.

hil {font-family:

New Roman", es,
font-s 18pt;
text-allign: center;

font-weight: bold;
font-style: italic}

Activity 15b

Create a new stylesheet called MYSTYLE2.CSS and attach this to the webpage called

WEBPAGE3.HTM. This stylesheet will set style:

@ h1 as an italic, centre aligned, 24 point font. If ‘Helvetica’ is available the browser will
use that, otherwise it will choose ‘Arial Narrow’ but if this is not available any other sans-
serif font will be used.

® h2 as abold, right aligned, 16 point font. If ‘Courier Narrow’ is available the browser will
use that, otherwise it will choose ‘Courier’ but if this is not available any other
proportional spaced font will be used.

@® h3 as an underlined, left aligned, 16 point font. If ‘Courier Narrow’ is available the
browser will use that, otherwise it will choose ‘Courier’ but if this is not available any
other proportional spaced font will be used.

@ p as a 14 point, left aligned, serif font.

Print evidence of your stylesheet and the browser view of the webpage with the stylesheet

attached.

Using classes within a cascading stylesheet

You can define difterent classes which are sub-types within an element in a
stylesheet. You can define a class in the stylesheet by using the . (dot or full stop)
symbol. These are very useful for adding to or changing styles without defining
completely new styles. For example, this stylesheet defines the style hl in the normal
way. It also defines a class that can be used with any style to change the colour and
alignment of the style that it is applied to.

1 [+ . - M . 1 Fa
nl {text-align: left)

{color: blue;

text-align: right)

~
@
=

Task 15

Open the stylesheet called CLASS1.CSS and add a new class within this stylesheet that changes
the default style to be right aligned and biue. Open the webpage called WEBPAGE4.HTM and
apply this class to each line of text that starts with the word ‘This’.

Copy the files CLASS1.CSS and WEBPAGE4.HTM into yvour Task 15 folder and
rename WEBPAGE4.HTM as Task_15j.htm. Open these files in your text editor
and the file Task_15j.htm in your web browser. Add this markup to the

stylesheet and save this in cascading stylesheet (.css) format.
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Enter the highlighted markup to the webpage to add a class sub-type to each line
starting with the word “This’. It should look like this.

<html>
<head>
<title>Task 15j</title>
<link rels="stylesheet" type="text/css" href="classl.css">

</head>

<body>
<hl>Task 15j</hls>
<hr>
<hl>Style hl is a sans serif, 20 point, centre aligned font.</hl>
<hl class="right">This is the sub-type of hl called .right</hl>
<h2>Style h2 is a sans-serif, 14 point, left aligned font.</h2>
<h?2 class="right"sThis is the sub-type of h2 called .right</h2>
<h3>Style h3 is a sans-serif, 12 point, left aligned font.</h3>
<h3 class="right!>This is the sub-type of h3 called .right</h3>
<p>Style p is a serif, 10 point, left aligned font.</p>

<p-class="right *>This is the sub-type of p called .right</p>
</body>
</html>

The screen should now look similar to this.

S sers\Graharm\Documents'
<htmi> : .
s| <head>

<t1:t'|e>Task 151</1:1'1:1e>
<1ink_rel="stylesheet” type="text/css”
‘|href="classl.cs5">

File' ~ Edit: ~ View " Favorites.. Toals * « Help:

Task 15f

<hl>Style hl i5 a sans-serif, 20 point, centre aligned

font.</hl>
<hl class="right">This is the sub-type of hl called
.right</hl>
< 2>5t¥'le h2 is a sans-serif, 14 point, left aligned . . .
font. o/he> - L Style h1 is a sans-serif, 20 point, centre
<h2 class="right">This is the sub-type of h2 called
.right</h2> H
<ga>sty1e h3 is a sans-serif, 12 point, left aligned, a“gned font-

iralic font.</h3>
<h3 class="right">This is the sub-type of h3 called

.right</h3>

This is the sub-type of h1 called .right

T Sy P , | Style h2 is a sans-serif, 14 point, left aligned font.
“'{"font-family: sans-serif;
font-size:” 20pt;
text-align: center}

This is the sub-type of h2 called .right

h2 { font-family: sans-serif; P N : N o
fnnt_size:yupt; Style h3 is a sans-serif, 12 point, left aligned, italic font.
text-align: left}
his is the s, Wil
h3 { font-family: sans-serif; Thisis U ub-type of h3 called .right

font-size: 12pt;
text-align: lefrt;

| Styls pis a serif, 10 point, left aligned font.
font-style: italic}

This is the sub-type of p called .right

i Documents

More » &7 |

: acadl ]
il Folders CLASSE Tasi 15] WEBPAGES

E 5@» Task_15) HTML Document Date modified: 0/07/2008 2005
| S !
b4

¢ Computer | Protected Mode: Off H10% v

You can see from this printout that the original style definitions (except for the
text alignment) have all been applied to the page. The text alignment and colour
have been added to the styles using the class called ‘right’.
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15.6

Using comments in your markup

Comments can be used to annotate your markup. Each comment appears within a
single tag. The exclamation mark followed by two hyphens (dashes) opens the
comment and two hyphens close the comment. An example of comments in the
markup looks like this.

<html>

<!-- This is a comment. Comments are not displayed in
the browser -->

<!-- Markup created by Graham Brown-->

<!-- This section defines the header of the webpage-->
<head>

Working with lists

You can include on a webpage either a numbered list, which is called an ordered
list, or a bulleted list, which is called an unordered list. Bulleted (unordered) lists
can also be nested (placed one inside the other) to give you more flexibility in the
design of your webpages. Items to be placed in a list start with the markup <li>
and close with </1i>. These are used in the same way as the style definitions for
headings (styles hl to h6) and paragraph styles. Each item in the list must have the
list tags around it. An example of an item placed in a list would look like this.

/

<1i>This 1s one item from a bulleted or numbered list </li>

Numbered lists

Numbered lists are called ordered lists in HMTL. Place the tag <ol> at the start of
the numbered list and the tag </ol> at the end.

Task 15k

Create a webpage containing the heading ‘Fruit’ and a numbered list for the following
items: Apple, Orange, Pear, Banana and Lemon.

Enter this markup into your text editor. Save the webpage, which should look like
this in your browser.

<html>
<!-- Task 15k by vour name -->
| & C\Users\Grahad <head>»
it View~ Favorites <title>Task l5k</title>
. g%’g; f” </head>
ST & R 2 -
AR G| H@C\U <body>
: <hi>Friut</hi>
i .
1 Fruit
Apple </1li>
1. Apple - Orange «/1ix
2. Orange pear </li-
3. Pear Pear </ ,;,,»'
4. Banana Banana </li>
s 5. Lemon - i> Lemon </1ix
| 5 Restricted sites | Protected </ol>
</body >
</himl>
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Bulleted lists

Bulleted lists are called unordered lists in HMTL. Place the tag <ul> at the start of
the numbered list and the tag </ul> at the end.

Tasl 15§

Create a webpage containing the heading ‘Colours’ and a bulleted list for the following
items: Red, Yellow, Blue, Green and Cyan.

Enter this markup into your text editor. Save the webpage, which should look like

this in your browser. \

<htmls>
— <!-- Task 151 by your name -->
& CaUsers\Gfahanmid v | 45 | » i -
D . o e <head>
.| Fite ' Edit - View  Favoritd <title>Task 1b5k</title>
Y </head>
<body >
, <hi>Friut</hli>
<ul>
olou ‘ T .
C l rs ; <li> Apple </li>
- <li> Orange </lix
sfd | <li> Pear </li>
ellow <li» Banana </lix
Bhe { 13 Tl
i <li>» Lemon </1li>
Green i :
Cvan </ul>
- </body>
| () Restricted sites | Protected  #,100%  « </html>

o

Nested lists

Bulleted lists can be nested, by having sub-lists. These are created by placing one
unordered list within another list.

Taslk {5m

Create a webpage containing the names of two resorts as a bulleted list. These resorts are:

Ellmau in Austria and Sharm El Sheikh in Egypt. For each resort, list the main activities
available.

Enter this markup into your web editor to create the primary list.

chtmls /

<!-- Task 15m by your name -->
<heads>

<title>Task 15km/titlex
</head:>
<body >

i> BEllmau </1i>
nrarm Bl Sheikh </1i>
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After each resort, enter a new sub-list that contains the activities offered in each
of these places. Note that the sub-list fits between the list item name and the close
tag for that item. The finished markup will look like this.

Save the webpage, which should look like this in your browser. l
<html>
<!-- Task 15m by your name -->
<head>
<title>Task 1%m</title>
</head>
<hody >
- ‘g C\Users\Graham\C ~ <ul? L
e <li> Ellumau
<ul>
— <li> Skiing </1li>
SisershGraham'\Docy., <1li> Snowboarding </li>
<li> Sledging </1li>
<1li> Mountalneering </1i>
» Ellmau </uls

o Skiing <li>

¢ Spowboarding <1li> Sharm El Sheikh

o Sledgng <uls>

a }ﬂomﬁamﬂadng <}%> Scuba diying<{%i>

o Sharm Fi Sheikh //;;i/ Snorkelling</li>

o Scuba diving <11'\>

¢ Snorkelling </uls
</body>

| i Computer | Protected Mode </html>

Create a new webpage containing the heading "Winter sports’, a brief introduction and an
unordered list of the following winter sports: skiing, tobogganing and snowboarding. For
each winter sport, make a sub-list of the items of clothing required. Set these sub-lists as
unordered lists.

Print the webpage as viewed in your browser and as html.

Change these sub-lists to ordered lists. Again, print the webpage as viewed in your browser and
as html.

15.7 Working with colour

Colour in HTML can be defined in two ways. One method is to use colour names,
like red, green and blue within the html code. There are currently only 16 colour
names accepted as web standards in HTML, CSS and by the World Wide Web
Consortium (known as W3C) . These are: aqua, black, blue, fuchsia, gray (note the
American spelling), green, lime, maroon, navy, olive, purple, red, silver, teal, white
and yellow. Other colour names are, however, accepted by the major browsers and a
table showing these colours and their names 1s included on the CD. This can be
found on the webpage called COLOURCODES. You can open this webpage and
use these colours in your own stylesheets attached to your webpages.

It is not always easy to remember the names of the colours, and many web
designers prefer to use hexadecimal codes (often referred to as hex codes) to define
the colour of text, backgrounds or objects. Hexadecimal is a counting system where
counting is done in 16s rather than in the 10s used in the decimal system. Because
we do not have sixteen different characters for numbers, we use letters and numbers
as shown in Table 15.1.
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|
11203

Decimal ‘ E 4|5 ‘; 6 7189 ]10/11,12{13;14[15:16 17 ‘lé 1912012122 |231241252627 é
Hexadecimal ( 1 Z 2:3 14 g 5 ; 617,89 i Ai B/ C D;E ( F 10 11 | 1211314115116 (17118 |19 [1A| 1B |- é
i i i : i H 1 i ¢ i |
Decimal ‘; 152 é 1531154 1 155 ‘156‘ 157 11581159160 161 \ 162163164 |165| 166|167 | 168169170171 172% é
Hexadecimal . % 98£ 99 | 9A} 9B | 9C | 9D SE | OF A0 A‘lé A2 A3 A4{ A5 | A6 A7[ A8 A9[ AA| AB ACE ;

Table 15.1 The hexadecimal counting system

This table will help
you work out which
hex codes are
useful in the
practical
examinations.

The largest number that can be stored in a single byte of information is the decimal
number 255, which is FF in hexadecimal.

Each pixel (dot) on a monitor or projected onto a screen is made up of three
different colours. The primary colours when using light (which is very different
from the primary colours used in painting) are red, green and blue. You will notice
that the initial letters are RGB, hence RGB monitors. Each of these colours can be
off, partially on or fully on. In hexadecimal, if a colour is off it is set to 00 and if it is
fully on it is set to FE. To create the colour for any pixel you must tell the computer
how much red, green and blue light to show. This means that all colour codes have
six characters, the first two being red, the next two green and the final two blue.
This example is the hex code for red, as the red component is fully on (FF), the
green component is off (00) and the blue component is also off (00).

color = #Fr000O0

All of the different combinations of red , green and blue allow more than 16
million different colours to be used. You do #ot need to learn the hex codes for the
exam. Using a small number of values for each colour (like those shown in the table
in the hint box) is more than enough.

e
e

Fully on FF FF0000

3/4 on o 00000

M on 80 800000
1/4 on e 400000
off 00 000000

The webpage COLOURCODES contains the hex codes (as well as the names) for the
most popular colours. It is interesting to note that, working with light, mixing red and
green gives yellow, green and blue gives cyan and mixing red and blue gives magenta.
If all three colours are fully on, the result is white and no colours on gives black.
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Task 15n

Create a new stylesheet called MYSTYLE3.CSS which sets the font styles:
@ h1to Times New Roman, or Times, or any serif font

@ h1to be 36 points high, black and centre aligned

@ h2 to Arial, or Helvetica, or any sans-serif font

® h2 to be 24 points high, red and left aligned

® h3 to Arial, or Helvetica, or any sans-serif font

@ h3 to be 18 points high, blue and right aligned

® p and li to Arial, or Helvetica, or any sans-serif font

@ p and li to be 14 points high, dark blue, left aligned.
Open the webpage called WEBPAGE5.HTM and attach this stylesheet to it.

Copy the file WEBPAGES.HTM into your Task 15n folder. Open this file in your
text editor and in your web browser. Create a new stylesheet in a second copy of
your text editor. For each style, add the font family, size and alighment as shown in
previous sections.

The colour for each style is added using the color property and the value (note the
American spelling of colour). For this example, the values will be in hexadecimal so
that we can select from any of the 16 million available colours. You use the # symbol
to tell the browser that the following six characters are hexadecimal. For h1 we will set
the colour to black using #000000, h2 to red with #FF0000, h3 to blue with
#0000FF and dark blue for the paragraph style with #000080. The final markup
should look like this.

\\\\hl {font-famlily: “"Times New Roman", Times,serlf;
font-size; 36pt;

text-align: center;

color: #000000}
n2 {font-f ly: Arial,Helvetica,sans serif;
font-siz
rext-ali
color:
h3 {font-£ v: Arial,Helvelica,sans serif;

font-size; 18pt;

text-align:

o, 11

text-align:
color: #0000

Style h1 is black | Save your webpage and test it in your browser. The finished page

Save this with the filename MYSTYLE3.CSS. Add this markup
to the head section of the webpage to attach your new stylesheet.

The paragraph style is a 14 point dark blue font. AN

cle>Task 15n</titlex

| Style h2 is red

n

ink rel ="stylesheet" type="text/css" href

\ \llx i
="mystylield.css">

\\ </head>

should look like this.

Style h3 is blue
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Using the webpage and stylesheet from Task 15n, add an extra stylesheet called MYSTYLE4.CSS
that defines classes to change the text colour to red, yellow or green and adds enhancements
like black bold and blue italic. Apply these styles in the webpage, so that each of the bulleted
items has the correct colours and enhancements.

Set a khaki background to the webpage and make sure that all text is clearly visible.

“ask

Hint Copy all the files from your Task 15n folder into the Task 150 folder. From the
Even though you Task 150 folder, open the file MYSTYLE3.CSS in your text editor and the webpage
;nv?rﬁ i?;gsfaﬁssr in in both the text editor and your web browser. In another copy of your text editor,
the practical create a new stylesheet called MYSTYLE4.CSS. In this stylesheet you are going to
examinations, tryto  add classes. Some will change the font colours and some will add enhancements to
make them short make text bold or italic.

and meaningful. Like each style, each class is given a name. You will need to decide on the name

Try to avoid using for each class, which should be short but meaningful. In this example you can use
words that mean

something in htm| the names ‘rd’ for the red class, ‘yllw” for yellow, ‘grn’ for green, ‘ital’ for italic and
e.g. use 'rd’ rather blue, and bld” for the bold and black class. Create each class in your stylesheet. The
than 'red’. tinal markup should look like this. Save this with the filename MYSTYLE4.CSS.

PRl

{color:

{font-style:
color:

Lbhid {font-welght: bold;
colcr: #000000}

Add this markup
to the head section
of the webpage to o
attach your new
stylesheet. — heads

Note that this
stylesheet has been attached after the previous stylesheet, so if there were any clashes
in style definitions, those in MYSTYLE4.CSS would take priority. These classes
need adding to each style definition within the webpage. Edit the markup and save
the webpage. The markup should look like this.
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The Webpagc will look similar to this.\

% C:\Usees\Graham\ Documents\331

‘| <html>
7| <!-- Task 150 by your name -->
<head>
<title>Task 15o0</Titles>
<link rel=" scy'lesheet Type="text/css"
hrefa"mystyle3.css
<link rel=" scy'lesheet Type="text/css"
href="mystyled.css
</h d
<bod
<hi>sty'|e hi is black</hi>

Bw Fa»cn(es Tnnls Help

,@ Tnsk 15n

Style h1 is black

- . B

<p>The paragraph style is a 14 point dark blue
font.

<hr>
<h2>style h2 is red</h2>
<h3>5t¥1€ h3 is blue</h3>
<p>Different classes can be used within a style
.ito give extra enhancement to the text. Text can be
turned:</p>
<ul>
<11 class = “rd" >red</h>
<1i class = "yllw">yeliow</1i>
<11 class = "grn">green</1i>
<li>ar left unchanged</li>
</ul>
<p>In fact any other colour could be used to
enhance previously defined text. Other enhancements
could be added 1ike having classes to make parts of
.|the werk_enhanced and coloured like:</p>
<ul>

The paragraph style is a 14 point dark blue font.

Style h2 is red
Style h3 is blue

Different classes can be used within a style to give extra

enhancement to the text. Text can be turned:
<}i class = "{tal”>blue and {talic</1i>
<1i class = "bld">black_and bold</1i>
/<11>or left unchanged</11>
<
<p>0other features found earher in the chapter

» red

« green
« orleft unchanged

In fact any other colour could be used to enhance previously
defined text. Other enhancements could be added like having
classes to make parts of the work enhanced and coloured like:

size: 36pc
text-align: center;
color: #000000;
h2 {font~-family: Arial,Helvetica,sans-serif;
font-size: 24pt;
text-align: 1efc,
color: #FF0000}
h3 {font-family: Arial,Helvetica,sans-serif;
font-size: 18pt;
text-align: right;
calor: #0000FF
p,1i {font- famly arial,Helvetica,sans-serif;
font-size: 14
text-align: Neft
color: #D00080}

« blue and italic
« black and boid
« orleft unchanged

Other features found earlier in the chapter can be added ina
similar way.

Done
ekl

8 Comp

B FOO
1w ccﬂnr SEFEFO0;
.grn color: *00FF005
Lital ifont-style: italic;
color: #0000FF}
.bld {font-weight: bold; i
color: #000000} ~iF

Background colour

Background colour can be added to many features of webpages, including the entire
WprAOC text on the page or, as you will see in Section 15. 9, other Ob]LCtS like
tables. In the original versions of HTML the colour was set in markup of the page
rather than in a stylesheut, but many of the original commands have now been
deprecated so all background colour settings are performed within the stylesheet.

The background colour for a page is set in the body style of the stylesheet. Edit
the stylesheet MYSTYLE4.CSS to add the body style setting for the khaki (hex code
#FOE68C) background like this.

body {background-color:

When you have applied this
to the webpage, it is difficult to
read the yellow text, so to make
sure that all the text is fully
visible, you are going to change
the background colour of the » or left unchanged
vellow text to a contrasting ,
colour. In fact any other colour could be used to enhance
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This again is set in the stylesheet, by adding the background colour to the definition

1n the class ‘yllw’, so the stylesheet looks like this. \

.rd {color: #¥¥Q0000}

yildw {color: #FFFF00;background-color: #00008B}
.grn {color: #OOFF0O}

ltal {font-style: italic; color: #0000FF}

.bld {font-welght: bold; color: #000000}

body {background-color: #FOE68C)

The backgronund colour has been applied with the yellow font colour like this.

extra enhancement to the text. Text can be turned: /

- red - , o
= green ~
« or left unchanged

in fact any other colour could be used to enhance

Activity 154

Create a webpage with a pale biue background that is about using colour in websites.
Attach a stylesheet that defines classes to change the text colour to red, yellow, green, dark
green, blue, dark blue or magenta. Have three different styles for the dark blue text, one
for left aligned, one for centre and one for right. Apply these styles in the webpage, so that
each colour is used appropriately.

15.8 Using hyperlinks

A hyperlink is a method of accessing another document or resource from your current
application. Hyperlinks do not just relate to webpages: other applications software can
also use them. Hyperlinks are often used to create menu options with webpages, using
either text or images. When you select a hyperlink (usually by clicking the left mouse
button), the hyperlink will perform an action. It may move your position within a
page, open another page either locally or on the internet, or open your email editor so
that you can send an email to a specified place or company.

Anchors

An anchor is a point of reference within a webpage. It is similar to a bookmark
when using word-processing or desktop publishing software. If you create a
webpage that will not fit in a single window, it is useful to use one anchor for each
section of the webpage (or document), so the user can move to any section without
having to scroll through the whole document. An anchor starts with an <a> tag
and closes with a </a> tag. One common use of an anchor is to define the top of a
page. This anchor is often called ‘top” or ‘start’. To create an anchor called ‘top’ enter
this markup in the body section of the page. This anchor will work without any text

between the open and close rags. \

<body>
<a name="top">Any content could appear here</ax
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Hyperlinks within a webpage

g 1, &0,
;

Open the webpage WEBPAGE6.HTM and stylesheet STYLE3.CSS. Edit the webpage so that each
new section contains an anchor. Use these anchors to create hyperlinks from the appropriate
text in the first paragraph. Make the word "top’ in the last line a hyperlink to the top of the
page. Make the words 'CIE website’ a hyperlink to the website www.cie.org.uk and the words
'W3C website’ a hyperlink to www.w3.org.

Copy the files WEBPAGE6.HTM and STYLE3.CSS into your Task 15p folder.
Open the webpage in your text editor and in your web browser. Each section needs
an anchor with a name. Each anchor name must be different. You should always
choose short yet meaningful names for each anchor. For this webpage you will use
the anchor names top, 15a, 15b, 15¢, 15d, 15¢ and 15f as these relate directly to the
sections within the webpage. It is sensible to place all the anchor names into the
document before creating the hyperlinks to these anchor names. Each anchor name

is created like this. \

<hl><a name="top">»></a>Chapter 15</hl>

You can see that the anchor tags are inside the tags defining the style for the text.
The initial anchor tag contains the anchor name which is placed in speech marks.
This name will be used 1n all hyperlinks to this point. Add the other anchors to the
markup, one for each section of the document like t:y

<hr>
<h2»><a name="15%a"></a>15a Understand what html is</h2>
<p>Many students sit the practical examinations without really

<hr>
<h2><a name="15b"></a>15b Problems with WYSIWYGs</h2>
<p>There are many well designed WYSIWYG packages on the market, some are

<hr>
<h2>»<a name="15c"></a>15c Use the correct terms</h2>
<p> Over the past few years, as the practical examinations have developed

Add anchors for 15d, 15¢ and 15f with similar markup. In the final sentence, find

the word ‘top’. This will be used to create a hyperlink to the anchor with the name
top that you created earlier. The hyperlink is also created using an anchor. The two
anchor tags are placed each side of the word top. The markup includes a hyperlink
reference (the markup for this is href) and the name of the destination anchor. This
anchor name is always inside speech marks and preceded by the # symbol like this.

<p>Back to the <a href="#top'stop</a></p>
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In the first paragraph find the text ‘what is html’. Edit the markup for this text so
that it creates a hyperlink to the anchor named 15a. It will look like this.

h3>Here are practical tips for the exams, if you follow them you are
ikely to increase your marks. First you need

know <a href="#15a">what is html? </a> Once you have a

sound understanding of html, it is worth

4/\

You need to add similar markup to the text WYSIWYGs’, ‘use the right terms’,
‘create and attach stylesheets’, ‘work with tables’ and ‘other resources’. The finished
markup for this section should look like this. \

<hl>Hints and tips for the practical examinations?</hl>

<h3»Here are practical tips for the exams, if vou follow them you are

likely to increase your marks. First vou need know <a href:"“131">w at
is htwml?</a> Once you have a sound understanding of html, it is worth
considering the use of <a href="#15b">WYSIWYGs</a> and the potential

problems of using these packages. Make sure that you <a href="#lbhc">

use the right terms</a> to describe what vou have done, are doing
or could be asked to do. Learn how to <a href="#15d">create and
attach stylesheets</a> to your webpages. Make sure that yvou can
<a href="#15e">work with tables</a>. These provide a fundamental
structure to webpages and seem to be rveplacing fram

S in many areas.
There are other methods of

formatting layout inclu
DIVs, but these are curre » beyond the scope of .S book. Look for
<a href="#15f"sother resources</a» LO help vou prepare for the
practical examinations.</h3>

Now that the hyperlinks have been created, each one needs testing. Save the
webpage and refresh your browser, then try each hyperlink in turn and make sure
that it directs you to the correct placc in the webpage. It the name that you have
used in the h vpuhnk reference does not exist, your b10\v9u will go to the top of th
page and the browser does not show you that there is an error.

Hyperlinks to other webpages

Hyperlinks can be created to another webpage stored locally, usually in the same
folder as the current webpage, or to an external website on the internet. The markup
for both of these links has the same syntax (structure). The only ditterence is the
address of the webpage that the hyperlink is to go to. To complete task 15p, two
hyperlinks need adding to external web addresses. These tollow a similar format,
with the URL for the web address appearing as the hyperlink. The markup for these
two hyperlinks is shown overleaf.




Website authoring

Hint

Make sure that you
do not put an
absolute address in
a hyperlink
reference (for
example, <a href
="Cmy
documents/my
folder/html/next_pa
ge.htm">) as this is
only likely to work
on your computer.
Other computers
are unlikely to have
the same folder
structure and
filename.

Although in these
simpie examples
the target
attributes open
new windows, they
operate in new
frames. Frames are
beyond the scope
of this book. Some
recent browsers
with multiple tabs
(like Internet
Explorer 7 and 8)
over-ride these
settings, as frames
are not used.

15f Other useful links</h2>

>1h
here are other places that can be used to gain valuable

Gl

include the

Add these hyperlinks in to the last section of your markup and save your webpage.
Test the hyperlinks to make sure they work as you expected.

References to pages stored in the same folder as your webpage just have an
address without the URL. To link to a local file called ‘next_page.htm’, you would
include a hyperlink reference like this.

\

<p><a name="next_page.htm">Click here for the next page</a>.<p>

P itgiinr 1T
FHCTIVITY 1 oe

Open the webpage HTMLTIPS.HTM and stylesheet STYLE3.CSS. Replace the text "YOUR
NAME’ with your name.

Edit the webpage so that each new section contains an anchor. Use these anchors to create
hyperlinks from the appropriate text in the first section. Make the word 'top’ in the last line
a hyperlink to the top of the page.

Make the word ‘CIE’ a hyperlink to the website www.cie.org.uk, the words ‘Hodder
Education’ a hyperlink to the website www.hoddereducation.co.uk and the text ‘W3C’ a
hyperlink to www.w3.org.

Print the html view of this webpage.

Opening a webpage in a new browser window

When a webpage is opened, it may open in the current window or it may open in a
new window. This is set using the target attribute. An attribute 1s something that is
added to one of the markup commands to give further information/instructions to
the browser. This attribute is part of the anchor and tells the browser which window
to usc for the webpage that you are going to open. The target attribute can either
be set as a default setting in the head section of the markup, or as an individual
setting for a hyperlink within the body section. If the target attribute is not used,
the browser will decide where to open a webpage.

To set a target window for a single hyperlink, add the target attribute to the first
anchor. Some target attributes have specific functions. If a target name of _blank 1s
applied, this will open in a new target window. If _self is applied it will open in the
current window. Other target names such as _parent and _top are reserved and
perform different functions with frames, which are beyond the scope of this book.
Any other target name that you use will open the specified webpage in a window
with that target name if it exists, or open it in a new window with that target name.

Using the webpage and stylesheet from Task 15p, make the hyperlink to the W3C website
open in the same window and the hyperlink to the CIE website open in a new target
window called _cie.




Information and Communication Technology

Body text could
also be added by
adding
&body=The %20
message %20here
to the markup.

Copy the file STYLE3.CSS and the webpage that you saved in Task15p from your
Task 15p folder into your Task 15q folder. Open the webpage in your text editor
and in your web browser. Edit the markup for the last two hyperlinks to include
target windows like this.

<p>There are other places that can be used to gain valuable
information that may help. These include the <a

href="http://www.cle.org.uk" target="_cie">CIE website</a> and the <a
href="http://www.w3.0rg" target="_sgelf">W3C website</a>.</p>
<p>Back to the <a href="s#top">top</a»</p>

Save your website and test the hyperlinks to make sure that they work as you expected.

Using a hyperlink to send an email message

Hyperlinks from webpages, other applications packages or documents can be used
to open an email editor and prepare a message to be sent to another person orx
company. This is very useful in a website where you can set up your email address
and subject line within the markup and instruct the browser to open the email editor
and insert these details into a new message when the hyperlink is selected.

The format for this is very similar to the hyperlinks shown earlier in this section.
In place of the URL or path of a webpage that is placed within the hyperlink
reference of the anchor, the mailto: instruction is used. This is followed by the email
address of the recipient. To include the subject line for the message, this is included
by specifying subject= followed by the text for the subject line. All the hyperlink
reference is enclosed within speech marks.

Create a new webpage that contains a hyperlink to prepare an email message to be sent to
graham.a.brown@hotmail.co.uk with the subject line ‘IGCSE Book'.

For this task you need to prepare a new markup in your text editor that contains
this line.

<p><a href="mailto:graham.a.brownhotmail.co.uk?subject=IGCSE%20Book">
Click here to contact us page</ax»</p>

Save this in your Task 15r folder and try it in your browser. When you click on
the hyperlink it will open your email editor, place the address in the To: section and
the text TGCSE Book’ in the Subject: line. Note how the space in the text TGCSE
Book’ has been replaced in the markup with “%20°. This is the hex value for the ascii
character 32, which in the ascii code represents a space. There are no spaces inside
the speech marks for the hyperlink reference.
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15.9 Using tables

Hint Tables are used to create the basic structure of many webpages. They are used to

In the practical organise page layout and are often usgd in webpages even though they may not be.
examinations, this visible. If you need to create a table within a webpage, it is always worth planning it
planning stage will on paper before starting to create the markup.

often be given to

you in the question. Task i5s

Create a new webpage that looks like this and has the caption ‘Colours’:

Red 36%
Green 23%
Blue 41%

Basic table structure

Hint Tables in HTML always start with a <table>  _; 1.

In the practical tag and Cnfi with </table>.. Staft by addlng <!! -- »Task 15s by vyour name -->
examinations it will  these tags in the body section of the markup <head> - '

be much easier to like this. Everything between these tags will be ~ <title>Task ISs</title>

use WYSIWYG included 1n the table, except for the captiowz(ii?

software to create This is added using the <caption> and ctables

your tables. This </caption> tags and allows you to display a </tables

section is designed caption (usually centre alionca) above the </body>

to ensure that you p Y o </html>

understand how to table. If a caption 1s used it must be the first
create and edit html tag after the <table> tag.
tables. You will Each table is split into rows. For this task,

need to understand  the rable you need to create has three table
the markup used to

<body>
<table>
<caption>Colours</caption>

. — rows. The tag for a table row is <tr>. Create e
define tables, even | gl 1t bf le()r b v h .Cl 4 </table>
if you decide to use | the three blank rows between the caption an </body >
a WYSIWYG the end of the table like this. </html>
package to develop Each table row will contain two cells of
your tables. table data. Between each <tr> and </tr> <body>

tag place start table data <td> and end table <table>
data </td> tags like this. A table cell can <caption>Colours</caption>
contain text, images, other tables, lists, A
paragraphs, forms, horizontal rules, etc. </tds
<td>
</td>
<body > </tr>
<table> <tr>
<caption>Colours</caption> <td>
<tr> </td>
<od>
</td>

</t

<t >
</td>
<t d>
</td>
</fLr>
</table>
</body>

</body>
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Hint

It is sometimes
quicker to create
one complete table
row first with the
table data cells
included and copy
this row a number
of times using copy
and paste.

The data can now be added to each  _ .,

cell like this. <table

[

Your table will look similar to this.

/

Colours | s
. <td>36%
Red 36% S
) </td>
Green 23% </t
BI’[IE 410/6 <LT> .
<td>Green
</td>
Table borders <td>23%
</td>
This table has been created but does not </trs
have a visible border. To show the table
: : . AR 0
gridlines you must add a border. This is <td>Blue

</td>
<td>4’

added as an attribute within the table
tag which should be changed like this.

<body >
<table border="1">

<caption>Colours</caption:

Setting the border to 1 sets a 1 point border width on the table
like this.

Setting the border to 6 points looks like this.

Setting the border to 0 will hide the table border, yet allow
the table to control the structure of the page.

Headers and footers in tables

Tables can have three sections: a header, a body section and a footer. These are
defined using the <thead>, <tbody> and <tfoot> tags, and closed with
</thead>, </tbody> and </tfoot> respectively.

Create a new webpage that looks like this and has the caption ‘Fruit
sales’. The colour codes you will need are #32879B for the header,
#92CDDC for the footer and #B6DDES for the table body.

_ $2409
Bananac | $4235%

$75¢7

Lemont
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To create this webpage you need to first create the open table and close table tags
within the body section of the markup. Place the caption tag between these in the
same way that did when you completed Task 15s. The mitial markup for this section
of the markup should look like this.

<hody >

<table border
<caption>
</table>
</ pody>

Before continuing with the markup it 1s worth planning the table using a hand-
drawn sketch similar to this. This will help you work out the structure needed for
the markup. For this table, you will need three sections to the table.

Caption /
Todde . o ik 2.
\ -t Prce | Atoble movs W
i— g;&('t CK(S\;Q Eebie headar celds,
Rpple | {1230

Table  (Ororop |§780 , _
ey [por i e iy sor
Bandno | §4235 Joko,

lomon | £75
‘%&@QSW% . 2
e kelow s wikh
—LM. cello ch e‘lbt é\Q‘kC\,

Todle
fookes

These three sections need creating next within the markup. The header section is
created using the table head tags, with <thead> to start the section and </thead >
to finish the section. The footer section uses the tags <tfoot> and </tfoot>and the
body is defined with <tbody> and </tbody>. In HTML you must define the table
header, footer and then body (in that order) if all three sections are to be included.
Create the three sections within the table of your markup like this.

<body >

b
Sl

sales</captions

focot»
<thody:>

NN
gy =

Within each section add the correct number of table rows, using the notes you
made on your sketch to help you.

You can add the table data sections to the footer and body of the table using the
tags <td> and </td>. Do not use these tags in the table header. At cach stage, save
your webpage and check that the markup that you have written gives you the results
that you expected.

In the table header, create heading cells (which are bold and centre aligned) using
the tags <th> and </th> rather than the table data tags. These will set the column
headings in heading style. Heading cells can be used inside the table body and table
footer sections and are useful in the left column of a table if row headings are required.
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Place the contents (in this case text) of
the header section in the header cells and
place the contents of the body and footer
sections in the relevant cells. The finished
markup and resulting table should look

<html>
Task
<head>

<title>Task
</heads>
<body >

<!-- by vour name -->

15¢
20

i5t</title>

like this. .

Fruit | Price
Apple [$1230
iOrange ’3780
Pear [$240
Banana $4235
/Lemcm 1375

Total $6560

Table styles using a
stylesheet

You have created the table, but it does not
yet look like the table shown in Task 15t. To
format the sections of the header you will
attach a styleshect and add the formatting
within the stylesheet. Add the stylesheet link
to the head section of the markup like this.

<head>
<title>Task 15t</title>
<link rel="stylesheet"”
type="text/css"
href="mystyle5.css">
</head>

You will now create a new stylesheet
called MYSTYLES.CSS. This stylesheet
will have the style definitions for the
whole table as well as the header, footer
and body sections. As you are going to

<table border="1">
<caption>Fruit sales</caption>
<thead>
<tr>
<th>Fruilt</th>
<th>Price</th>
</tr>
</thead>
<tfoot>
<tr>
<tds>Total</td>
<td>$6560</td>
</Tr>
</tfoot>
<tbhody>
<tr>
<td>Apple</td>
<td>$1230</td>
</Ly>
<tr>
<td>Orange</td>
<td>5780</td>
</tr>
<tyr>
<td>Pear</td>
<td>$240</td>
</tr>
<tr>
<td>Banana</td>
<Cd>$4235</td>
</Lr>
<CTr>
<tdsLemon</td>
<cd>S7h</td>
</tr>
</thody>
</tablex
</body>
</html>

define some of the table attributes in the stylesheet it will be sensible to move the
table border details into the stylesheet. Remove the border="1" attribute from the
table tag in the markup. In your styleshect, set the table attributes so that the
border-color is black, the border-style is a solid line and the border-width is set to

1 pixel. jy
table {border-color: #000000; border-style: solid; border-width: 1lpx}
thead round-color: #328798}

tfoot ackground-color: #92CDDC; colior: #FF0000}

thody {background-color: #B6DDES}

Set the background-color for cach section of the table and the text color within

the footer to red.
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When this has been saved and is applied to the webpage the
table will Jook like this.

Formatting columns

The prices and heading in the right column need to be right
aligned to match those in the question for the task, and the text
in the left column needs to be left aligned (to override the
centre align within the heading setting). You can set this in the
markup for the page rather than the stylesheet. All of the cells in
a column will be grouped together and have a style attribute set.
In the case of the left column, this will be the alignment set to left and in the second
column the alignment set to right.

These are set with tags for <colgroup> and </colgroup>. The colgroup tags
always appear immediately after the caption but before the table header <thead>
tag if it is used. The markup for this section looks like this. The table should then
look like this. / l

<table> i

<captilon>Fruit sales</captions
<colgroup align="left"></colgroup>

<colgroup align="right"></colgroup>
<thead>

Formatting cells

This table still does not look exactly the same as that shown in
the task. The ruled lines between the cells are not visible. To
turn these on add to the table tag the
rules attribute, with a value of ‘all’ to <body>
show ruled gridlines for all of the table. <table rules="all"s>
Pﬂthough this sets the ruled <caption>Fruit sales</caption>
gridlines within the table, they have not
appeared the same as the border. This
is beyond the scope of this book as the practical examinations are likely to require
you to set the rules attribute to “all” or ‘none’, although it is worth knowing that they
could also be used to rule in ‘rows’, ‘cols’ or ‘groups’. Try each
of these settings and see how the table appears for each value.
Cell padding and cell spacing are used to improve the
layout of a table. Cell padding is the amount of space between
the contents of the cell (in this case text) and the cell border. In
the table for Task 15t, you can sce that there is no spacing /
around the text so the table looks crowded.
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By adding cell padding of 4 pixels to the table, you can make
it appear like the one in the original task. To add cell padding
insert this markup as a second attribute to the table tag. This
has the ettect of adding 4 pixels of whitespace between the text

and the ruled gridlines of the cell like this. o
Hint
Values for table <bhody >
borders, cell l—»» <table rules="all" cellpadding="4px">
padding and cell <caption»Frult sales</caption>

spacing can be set
in pixels (px) or
points (pt). Save both your webpage and stylesheet.

Task 15u
Create a new webpage with a table that looks like this and has the caption ‘Sales team’. Set
the border to 5 points, the cell spacing to 5 points and the cell padding to 10 points.

The background colour code that you will need is #548DD4. The image that you require is
called TURTLE.JPG.

Plan the table using a hand-drawn sketch similar to this.

Captaon
Image here |(A/Cel]_thigk cBlufng uidle,/
Toble | 4 pps ST _ / 2. todle WS wikh 4 colwmag,
Hander 2rows dep| /é% / n}/ 2cells in first row meroed, 3cekly
- b, 0 Sz T 100ed,, 3 bekia hapdingy calls,

ﬁ'/nﬁyf/ $162,20 | 928575 | §i50

Tokde

Body

N 3 towle ouss, each w4 handing celd
oA B240 (St |$32 003 e defi cols,
\%94 Juw6.50 |§é210 | Few.50

Shadung Showas cells wi R Vo on e )
todole dﬁi’_o\ EYTT\(RJ: ] > wikh O\M Rirmek reddhor thon
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Hint

When creating a
new table like this,
it is wise to add a
single character as
contents of the cell
when you create it.
In this case a single
letter ‘A’ has been
added to the top
left cell, the letter
‘B’ to the next cell
and so on. This is
because some
browsers, including
Internet Explorer
do not display a
table cell without
contents. By adding
these single letters
it allows you to test
the table as you are
creating it.

Create the basic markup as you did with
Task 15t, starting with the table tags, the
caption, the two sections of the table and

<body >
<tablex>

<caption>Sales

then mserting the table rows. The markup <thead>
so far will look like this. .

The top row of the table header has
only two cells. The first of these is a cell

that covers two rows. For this you use a </thead>
rowspan attribute to tell the browser this <tb_OdY>
cell is going to span the two rows. The ;;Lj/
—markup for this section will look like this. P
</Lr>
<theads <trs
<tr> </tr>
L g <td rowspan="2">A</td> </thodys>
3 <th colspan="3">B</th>» </rablex
</tr> </body>
<th
The second cell in the top row is a cell that </tr>

covers three columns. For this you use the <tre

. J . <th>C</th>
colspan attribute to tell the browser that this hene /b,n>
cell is going to span three columns. This cell ctheBe/ths

</tr>

was identified in your sketch as a being a

—heading cell, so the colspan attribute is used
within the table heading tag.

Using the sketch to work trom, add the
cells to each row of the table. In the body of
the table, set the first cell of each row as a table
heading and the next three cells as table data.
This section of the table will look like this. —

In the table tag near the top of the
markup, add the attributes for the border,
rules and cellpadding. Also, include the
cellspacing attribute, which increases the
spacing between cach cell in the table. The
markup for the table tag will look like this.

[SAN

The background colour cannot be added
to the table tag so create a new stylesheet
called MYSTYLEG.CSS and include
the style definition like this. Save this

stylesheet and attach this to your >
HTML markup.

team</captions

table {packground-color:
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15.10

Enter all the text and currency values into the Sales team
correct cells in the table. The webpage should look
like this. This task is continued in the next section.

Using images

Images are frequently used on webpages, sometimes
as a picture and sometimes in the form of icons that
can be used for hyperlinks.

Inserting an image

To complete the webpage for Task 15u, you need to replace the letter ‘A’ in the top left
cell of the table with the image TURTLE.JPG. To do this you have to tell the web
browser the name of the image source, which should be stored in the same folder as
your webpage. Make sure that you have copied the file TURTLE.JPG into your Task
15u folder. Add the following to the markup. As some browsers do not support
graphics, you can tell the browser to replace the image with alternative text. This usually
describes the image so that the user can still understand what is being shown, even
though they cannot see the image. The marlup will look like this.

<thead>
<L
<td rowspan="2"»<img src="TURTLE.JPG" alt="Company Logo"></td>
<th colspan="3">Expenses</th>
</tr>

Where to store an image

Images must be stored in the same folder as the webpage. This 1s called the current
folder. Notice in the markup shown above how the filename TURTLE.JPG is given as
the image source. This does not contain any reference to which folder the image is
stored. Because there is no absolute reference to a folder, the browser automatically
looks in the current folder for the image. This means that if this webpage is opened on
another computer, as long as the image is stored in the same folder as the webpage it
will work properly. It an absolute reference had been used for a file, for example:

<img src="C:\My webgites\My pilctures\TURTLE.JPG"
alt="Company Logo"></td>

Sales team

this would prevent the file being found unless the
folders i all the computers were structured in this
way. If the file TURLE.JPG is not in the current
tfolder, the webpage will look like this. The image
has been replaced by the text ‘Company Logo’ to
tell the user what the missing image should be.
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A common mistake
made by candidates
in the practical
examinations is to
use absolute
pathways for files,
like images,
stylesheets, etc.

s

The attributes to
align elements
within the table
can be applied to
the tags for a table,
columns, rows,
table headings and
table data.

Sales team

If the image file is stored in the current
tolder, this will be displaved.

Placing an image

Images are usually placed within tables. How an
object (often an image or text) is viewed within
a table cell will depend upon the alignment of
the cells. The horizontal alignment has been
covered earlier in the chapter using the align
attribute, which can be applied to columns (as
seen earlier), rows (to format all cells in that
row), or individual cells in the table heading or table data tags.

sle §
21N

Open the WEBPAGE7.HTM. In the top row, align the images in the second column to the top
left of the cell, the third column to be centre aligned both vertically and horizontally, and
the last column to be placed in the bottom right corner of the cell.

Copy the files WEBPAGE7 HTM, TURTLE.JPG and REMORA.JPG into your
Task 15v folder. View the webpage in your browser.

You will edit the markup in the table data tags for the three images of a turtle in
WEBPAGE7.HTM, adding new attributes to these tags to change the alignment in
these cells. To align the image (or any other object) to the top of a cell of table data, use
the valign attribute with the value set to top.

You can use the values of ‘middle’ or ‘bottom’ for this —s-<td valign="top">
attribute to obtain these positions within the cell. The
horizontal alignment is set using the align attribute, as seen
in Task 15u.

For this task, apply the vertical alignment attributes to the table data tag as you
did in Task 15t. Save the completed markup, which should look like that shown on
the next page.

The finished webpage will look like this.

Image alignment

* This image is left
aligned and aligned to
the top of the table

This image is centre
aligned both
horizontally and

“ cell. vertically.

This image is right
aligned and aligned to
the bottom of the
table cell,

ne % Compoter | Protected Mode: O3 Hiwy -
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<html>
<l-- Tagk 15v by yvour name -->
<head>

<title>Task lbSv«/titlex>
</head>

<body>
<table width = "100%" border="10px" rules="all" cellpadding="10px"
cellspacing="10px">
<tbody>
<kby>
<td rowspan="3"><img src="REMORA.JPG" alt="Remora"s</td>
<td colspan="3"><hl>TInnage alignment</hl></td>
</tr>
<t >

<td valign="top" align="left"><img src="TURTLE.JPG"
alt="Logo"></td>

<td valign="middle" align="center"><im
alt="Logo"></td>

<td valign="bottom" align="right"><img src="TURTLE.JPG"

src="TURTLE.JPG"

(e}

alt="Logo"></td>
</tr>
<Lr>
<td><h3>This image is left aligned and aligned to the top of the
table cell.</h3></td>
<td><h3>This image is centre aligned both horizontally and
vertically.</h3></td>
<td><h3>This image is right aligned and aligned to the bottom of
the table cell.</h3></td>

</Lr>
</tbody>
</table>
</body>
</html >

Resizing an image

Images can be resized using two methods:

@ The first method is to change the size of the displayed image in the markup. This
1s the casier of the two methods, but often uses large image files, which are
slower to upload and can delay the display of a completed webpage.

@ The second method is to physically resize the image in a graphics package and
then save the new image. This method has the advantage of being able to reduce
the file size of an image so that a webpage will be displayed more quickly. It has
the disadvantage of using low resolution images, which can appear pixelated,
particularly if you wish to enlarge them.

Open the webpage that you saved in Task 15v. Resize the image REMORA.JPG to a width of
80 pixels and maintain the aspect ratio. Use both methods to resize this image and compare
the relative file sizes of the two images. Save both versions of your webpage. Make this
image a hyperlink to the webpage REMORA.HTM.
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Resizing an image in the markup

Copy the webpage and supporting files from Task 15v into your Task 15w folder.
Also copy the file REMORA.HTM into your Task 15w folder.

To change the size of an image in the markup use either the width or height
attributes within the image tag. For this question the width needs setting to 80 pixels.
If you change the width of the image to 80 pixels and do not specify a height for the
image, it will maintain its aspect ratio. This means that it will keep the same
proportions. Sometimes you may be asked to distort an image to give a different eftect
within a webpage. This is done by specifying both width and height but not keeping
the aspect ratio of the original image. Find the markup for the image REMORA.JPG
which looks like this.

<td rowspan="3"»<img src="REMORA.JPG" alt="Remora"></td>
<td colspan="3"><hl>Image alignment</hi></td>

Add a new attribute to the image tag to specify the new width of the image, like this.

<Cr> //

<td rowspan="3"><img src="REMORA.JPG" alt="Remora" width="80px"></td>
<td colspan="3"><hl>Image alignment</hl></td>

The webpage will change from this to this.

Image alignment

Image alignment

This lmage i left aligned Tuls Jmage Is centee This fmage I right aligned
and allgned ta the tap of aligned both borizontally  amd aligned ta the boltom
the table cell. and vertleally. of the table cell

we A Campuer ctncted Mode S0

This mage bs fent Thhs Image bs ceatre  ; This Image bs right

aligned and atigned to  aligned hoth aligned and aligned to
the top of the table borizantally and the hotiom of the
cell vertieally. tabile eell
Fie Edt [imsge View Window Help
{psne T Mo Petenshageor KW 5 E

Although the vertical alignment of all
three turtle images has not been changed in =
the markup, the eftect is to make the images 8 R §
appear to have the same vertical alignment. ; -
This is because the row height has been
reduced to fit with the new row height for
the image of the remora.

Resizing an image in an external
package

Open the image REMORA.JPG in yvour
graphics manipulation package. In.Adobe
Photoshop images are resized using the ITmage
menu, followed by the Image Size... option.
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This opens the Image Size Image Size
window. To set the image width to
80 pixels, change the value in the

~ Pixel Dimensions: 318.2K

Width: box. e ;ﬁvl pueb - ]@
The image will maintain its aspect Helght: 600 pxes  ~ (CAuto... ] ||

ratio as long as there is a tick in the ~ Document Sze: -

Constrain Proportions box. To Width: 538" T |

intentionally distort an image you weghts T :l‘ﬁ

would remove this tick and enter a

: : ﬂesolution: Dixels/in H N v §
height as well as a width for the pixels/ind |
image. Click on Zo&. This will alter 7] Scale Styles
the size of the image within the & Constrain Proportions

1 4 [l Resample Image:
package like this. T -
Bicubic (best for smooth gradients) -

To save the new image, sclect File,

then Save As... and enter the

new filename before clicking

on _se_. As this image will be

saved in JPEG format, you are

given options on the image

quality that you require. These

can be selected by typing a

number between 1 and 12, using—

the slide bar, or selecting from
—the drop-down menu. 1 is the
smallest file size that you can
have, also gives the poorest
quality images. 12 1s the highest
quality but results in large file
sizes, which are much slower to
download over the internet.

JPEG Options

f

— Image Options -
Qualty: [

review

311K

\/4 — Format Options -~y
@ Baseline ("Standard”} |
Baseline Optirrized
Progressive

Resampling an image

This process of changing the image quality is called resampling. Images can be
downsampled, meaning fewer pixels are used for the image, as you have just done by
reducing the image quality. Images can also be upsampled by adding more pixels.
Downsampling reduces the file size and therefore makes the webpage load more
quickly. A good technique is to have a small, low resolution image (called a
thumbnail) on a webpage. If the user wants to see more detail they can click on the
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image and a new window will open containing a high resolution version of the same
image. The webpage needs amending so that the width attribute is no longer
present, and the source attribute within the image tag points to the new filename.

<tr>
<td rowspan="3"><img src="REMORAL.JPG" alt="Remora"></td>
<td colspan="3"><hl>Image alignment</hl></td>

Save your amended webpage with a new filename. Now open the Documents
window and navigate to the Task 15w folder. This folder contains the files saved during
this task and shows you the
difference 1n file sizes between
the two methods. Your image
sizes may vary from this,

Chapter15 » HTML » Task15w

depending upon the resolution || """ o oy —_— 1
you selected when you saved f« Prewres e A% e e e
the file. As can be seen here, in ||~ s e wvesion s BRI ML oo e
this case the new image should || ™= v 2 it woms e
load in less than 60 per cent of Tz 3 IR TR T E“‘s '
the time the original will take. | siems i |

Hyperlinks from images

Images can be used as hyperlinks in the same way as text. To create a hyperlink to
the webpage REMORA.HTM, add this hyperlink reference to an anchor
surrounding the image tab.

<tr>
<td
src="REMORAL.JPG" alt="Remora"></a></td>
<t alignment</hi></td>

This hyperlink will open the partially constructed webpage called REMORA.HTM.

File types for images

There are three common file types for images used in websites. These are JPEG
files, GIF files or PNG files. You can use a graphics package like Adobe Photoshop to
change images from one format to another by opening them and using Save As... to
change the file format for the new image.
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Printing webpages

You will be required to print different views of your webpages for the practical
examinations. You must ensure that your name is included on the webpage before it
is sent to the printer, in whichever view is specitied. Printing the HTML view is
trequently required, and even if you are using a WYSIWYG package you will need
to open the webpage in a text editor to print the html. Browsers will often do this
tor you. In Microsoft Internet Explover this is opened using Page and View Source.

This image bs len aligned This lnuage is ceatre ,
and allgacd to the top of aligned both horizontatly™™ 0 15 16 BoTiom of
the table cell. 204 vertically. the table cell.

T N

It is worth noting that the image above would not gain any credit in the practical
examinations as there is nothing to identify the candidate on the printout. Browser
views like this are acceptable, but you must ensure that, if you choose to use a
WYSIWYG package, vou test the webpage in a browser and not just within the
package. Some products will display what appears to be the browser view, but is
only a development tool and does not necessarily display the page as it should.
Taking screenshots of your pages; using the <Print Screen> button on your
keyboard to copy the screen contents into the clipboard, then pasting the clipboard
into another package (usually a word processor) is a usetul method of providing
evidence of your work. If you have used stylesheets in your webpage make sure that
you print evidence of these as well. It is more difficult to include your name in a
stylesheet, so copying and pasting the stylesheet into a word-processed document
containing vour details is a good method ot producing this evidence.

Create a new webpage with a table that looks like this and has the caption ‘Last week'. Set
the border, cell spacing and cell padding to 4 pixels.

R =

Expenses

' PTC Travel — |
# L Anne Dan Lisa Udoka
| o

Petrol $182.20 | $185.75 $260.00 $322.00

Food $80.00 | $62.40 $54.00 $40.00
Hotel $420.00 | $382.10 $104.50 $260.00

The background colour code that you will need is #FFFF00. The image that you require is
called PCTCJPG. Print your webpage as html and as it is viewed in your browser.




CHAPTER

16

Presentation authoring

In this chapter you will learn how to:

use a master slide to set up a presentation
create presentation slides

add and edit text

insert an image

create and add a chart to a slide

insert other graphical features to a slide
use transitions between slides

animate objects on a slide

save and print a presentation.

For this chapter you will need these source files from the CD:
| HTML.RTF

POWERPOINT.RTF

SLOGAN.JPG

WEBSITE.JPG

16.1

What is a presentation?

A presentation is a series of slides used to give information to an audience. A presentation
can be used in many different ways: to teach or inform as a visual aid in a lecture, or as a
constant on-screen carousel giving information or advertising, for example in a shopping
centre or mall. The media for delivery and type of presentation developed will depend
upon the purpose of the presentation and the target audience. For example, you would
design a puscntanon on road safety to a class of hvc -year-old children to be short (for a
h(nt attention span), have only a few simple words (as they cannot read tluently) and
contain bright colourful moving images (to keep their attcntlon). The medium for the
delivery of this presentation would be using a multimedia projector and large screen.

It is important to understand all of this information before starting to design and
develop the presentation, as different media will require different screen/page sizes.
Most presentations will require a consistent colour scheme and consistently applied
styles to all slides. In the practical examination, you will be given details of these
colour schemes and styles.

Using the master slide

Fe

You are going to create and save a short presentation for IGCSE students telling them how to use

Microsoft PowerPoint. The medium for delivery will be a multimedia
projector. ]

Create a master slide with a pale yellow background on the right-hand
side (about 1/4 of the width) with one vertical dark blue stripe as a
border for the yellow background and two horizontal dark blue stripes.
Each stripe should be 4 points wide. It should look like this.
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A master slide allows you to design the layout of your slides before you start adding
objects (like text or images) to the slides. It holds the information on colours, fonts,
effects and the positioning of objects on the slides.

Open PowerPoint and select the View tab. Find the Presentation Views section
and click on the Slide Master icon.

Presentationl - Microsoft PowerPaint

Honie " < Inzert

Animations - Be “fview © Acobat

T Raler
Gridfines

. i Zo0m  Fitto | Color/Graysésie
TH Sude Show £ Hotes Master window -

Pre:

| Mormat Slide Motes Slide ;
Sorter  Page Sh tisdaster: Master Master |

| Pregéntation Views

3ting

Click to edit Master title style

Click to edit Master subtitle style

Shide Ktsster ™ Ofticefineme™  English fUnited i

The display will change to this. The Jayout of a presentation will depend on the
medium for its delivery. In this task, you are told that the medium for delivery will
be a multimedia projector. To change the medium for delivery you must select the
Slide Master tab and find the Page Setup section. Click on the Page Setup icon,
which will open the Page Setup window.

Use the Slides sized for: drop-down list to select an On- Screen Show. You can
also change the orientation of slides and h'mdouts/notes pages in this window. When
you have selected the settings, click on

Page Setup

| Slides sized for:

Delivery of a presentation with a multimedia projector may include the use of
audience notes and/or presenter notes. Audience notes are paper copies of the
slides of a presentation that are given to the audience so that they can take them
away and refer to them after the presentation. These can be in difterent formats,
with several slides on a page, or just one slide with space for the person to add their
own notes. Presenter notes are a single printed copy of the slides from a
presentation, with prompts and/or key facts that need to be told to the audience by
the person delivering the presentation. These notes are not usually given to the
audience. More information will be given on these Jater in this chapter.
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When you look at the presentation, Prasen it erereet
you will see a list of master slides will
appear down the left side of the screen.
You must select the Office Theme
Slide Master at the top of the list.

Working in this master slide will
affect all of the other master slides for
each different style of page you may
decide to use later. The master slide now
appears like this.

Click to edit Master title style

Click to edit Master subtitle style

Presentationl ~ Microsoft PowerPoint Drawing Tools ©

Click to edit Master title style

'+ Click to edit Master text szIes
© —Second level

* Third level
— Fourthlevel
» Fifthfevel

“Otfice Theme” ¢ ~English (United States) -4

For this task, the master slide has to contain a number of lines and one filled area.
You should start with the filled area. This will be created by placing a filled rectangle
in the right place. However, this rectangle will cover some of the objects already on
the slide, so these objects need resizing or moving out of the way first.

Select the title text box and use the drag handle to resize the text box.

Presentation] - Microsoft PowesPoint Orawing Tools L |

Click to edit Master title style

« Click to edit Master text styles
— Second level

* Third level
— Fourth level
» Fifth level

4 Side piaster
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Repeat this for the body text box on the master slide. This box has also been

made less deep using the lower drag handle, in order to create space to move the
slide numbering.

w G
Draw:ng Tools

o Fomat

Clase
- Master View

- style
¢ Click to edit Magter text siyles

— Second level

*« Third level
— Fourth level
» Fifthlevel

G English Uniten Statesy

The text box containing the slide numbering is too small to resize, so this will
need to be moved trom the right-hand side. Drag the entire text box into the space
created below the body text box.

4 - «

The page layout should now look like this.

. Drawing Tn)/

oft PawetPoint

Click to edit Master title
style

* Click to edit Master text styles
— Second level
* Third level

— Fourthlevel
» Fifth fevel

Select the Insert tab and find the Ilustrations section. Click on the Shapes icon
and select the Rectangle option from the drop-down menu.
Use the drag tool to drag a new rectangle that fills about a quarter of the slide.

Make sure that this rectangle fits to the top, bottom and right edges of the slide and
leaves no white space.

Many shapes like the rectangle can also be found in the Drawing section of the Home tab.
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Hoiding down the
<Shift> key whilst
placing the line
forces it to be
either vertical,
horizontal or at 45
degrees.

You may find it
easier to copy the
first line and paste
it twice, rotate the
two new copies and
resize and place
them as required by
the task.

You now need to edit the appearance of the rectangle. Select the Home tab and
tind the Drawing section. Use the Shape Fill icon to select the fill colour and click
on the Shape Outline icon, tollowed by Weight from the sub-menu. Select the
More Lines... option to remove the border from the rectangle. This can be done
by setting the width of the line to 0. The master slide should look like this.

iont - Micraroft Pewedioint rawing Toot

Click to edit Master title
style

* Click to edit Master text styles
—Second level
* Third lavel
~ Fourthlevel
» FifthTevel

More Qutlirfe Colors...
== -Woeight >

. Dashes »

You will notice that all the other master slides (down the lett-hand side of the
window) now show the yellow background.

Next you need to add the three blue
lines to the slide. Select the Home tab,
then in the Drawing section sclect the
Shapes icon and click on the Line
option from the drop-down menu. Use
the drag tool to draw a vertical line on
the border between the yellow and
white areas.

Use the Shape Outline icon to
change the line colour to dark blue. The
Shape Outline icon can also be used to
change the line thickness. Select Weight
and from the sub-menu select the line
weight. For this task, the line weight
should be 4 points. This option is not
available from this menu so select the
nearest weight available, in this case 4Y2.

Right mouse click on the line and select i
Format Shape... from the drop-down menu. =
From the Format Shape window adjust the line =7 shtex

e A% L amange Quitk [
AL P TV e Theme

Drawitig

1T

Standard C
BE

_Recent Colors |

No Outline

»  More Outline Colors...
Weight *

Daghes 4

Afrows 4

Line Style

Compound type: |

Dash type: i
Width: to 4 points. Click on T ot e [7]
3-D Rotation b o
Repeat this process to add the two horizontal || e | 2007 05 -
lines to the master slide, in the positions shown TR e

in the task. Save the presentation with the
filename Ch_16 Task 16a.

Bagin size:
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Open the presentation that you saved in Task 16a. Include the heading ‘Using PowerPoint’,
left aligned in a dark blue, 60 point serif font above the blue line at the top of the master
slide. Include an automated slide number in the bottom left of the footer.

Enter your name, centre aligned in the white area, at the bottom of the master slide. Use a
black, 14 point, italic, serif font.

Place a clipart image of a computer or peripheral in the right-hand area. Crop and/or resize
the image so that it fits within the yellow area and will not overlay the dark blue lines. Do
not distort the image. Make sure that the image fills more than 50 per cent of the available
space. Save your presentation.

P Moo poneto o, e To include the heading, add a
o a4 new text box in the top left
section of the slide. This text
box will replace the title text
box, so move the title text box
down the slide to below the

Using PowerPoint

" Click to edit Master title blue line. Go to the Insert tab
style gnd click on the Text Box icon
'+ Click to edit Master text styles in the Text section. Drag out a
— Second level ~ new text box, select the Home
Thirdleve ; tab and find the Font section.
» Fifthlevel Set the font size to 60 points

and select a serif font, ¢.g.
Times New Roman.

Enter the text ‘Using PowerPoint’ into this text box. The window should now
look like this. Highlight the text and set the font colour to dark blue, using the Font
Color icon.

As the text 1s already left aligned, do not adjust the alignment. Notice how the
text box has been aligned with the other objects on the slide so that the examiner can
check that the text is left aligned.

The automated slide number is in the object moved from the right side of the
footer. The task asks for this to be placed on the left in the footer. Resize this object
(as shown previously) and change its alignment to left aligned by clicking on the
Align Text Left icon in the Paragraph section under the Home tab. Drag the box
into the bottom left corner. As the date is not required on all pages, this object can
be deleted before moving the automated slide number.

Enlarge the automated footer so that it fills the width of the white space, as
shown. Make sure that you enlarge the footer so that it overlaps the slide number,
which will ensure that the examiner can see that the object is centre aligned. Change
the text and the slide number to a black, 14 point, serif font, as described above. The
finished footer area should look like this.
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Although you have set the footer area [ seosersns oo
of the master slide, you have not yet = T
added your name to the footer, nor told Cimsamims
PowerPoint to display the page numbers.
To do this, select the Insert tab, then in
the Text area click on the Header and
Footer icon. This opens the Header and
Footer window.

Tick the box for Slide numbér and the /f]| Domwmasezs
box for Footer. Move the cursor into the
text box for Footer and type in your
name. To set this on all slides, click on st

Restore the full height of the body text box on the master slide using the drag
handle. Now move down into each of the other master slides and resize all text
boxes to ensure that they fit within the white space, for example from this to this.

by Graham Brozn

Using PowerPoint Using PowerPoint

Click to edit Master title s ; | Clickto edit Master title
' ' style

Click to edit Master subtitle styfe j Click to edit Master subtitle style

If the task required particular font styles or sizes for each of these objects, these
can also be set in these master slides as described earlier.
Clipart images

To insert a clipart image, return to the Office Theme Slide Master and select the Insert
tab. In the Illustrations section, click on the Clip Art icon to open the Clip Art pane.

Using PowerPont

© Click to edit Master title '
‘ style :

Click to edit Master text styles
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For this task you need to find an image of a computer, so e R
enter Computer in the Search for: box and click on | Go.|. (See jsenfor
Section 10.5 for further details on clip art options.) :::r:t: e

This searches the clip art library and finds pictures that may | ™

match what vou are scarching for. Look through the images to | fesssodbte: P
find one that will fit well in the available space — remember that T
you can crop and resize the image, but cannot distort it. When
you have chosen the image, click the left mouse button on it to
select it. This places this clip art image onto the master slide.
Move and resize it so that it tits into the correct arca. To crop
the image, select the image and click on the Format tab. In the
Size section, click on the Crop icon.

=t 11 Height: T74m

{8] organize dips...

o+ ¢ - i

) o % Clip act on Office Online
Crop  — Width | S >
Nidth: 7-57 CF“" - @) Tips for finding dips

Size fa

With the crop tool selected use the drag handles of the image to crop the edges so
that 1t changes from this to this.

Using PowerPoint : Using Power

Click to edit Master fitie
style
« Click to edit Master text stylas

~Second level
- Th

Click to edit Master title
style

* Click to edit Master text styias

When the master slide is complete, select the View tab and in the Presentation
Views scction click on the icon for Normal page lavout. Save your presentation.

16.3 Creating slides

There are two methods of creating presentation slides. The first method is to import
the page contents from a text file. The text file could be stored in .txt or .rtf format.
The method for creating these slides is the same. With rich text format, the styles
saved within the document apply to the presentation, whereas with text format there
are no styles saved within the document, so these need adding after the slides have
been created.

Open the presentation that you saved in Task 16b. Import the file POWERPOINT.RTF, placing
the text as slides in your presentation software. Save the presentation.
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Open the presentation. Select the Home tab and in the Slides section select the drop-
down menu from the New Slide option. Select Slides from Outline... near the
bottom of this menu. Browse through your files until you locate the file
POWERPOINT.RTF; click on this filename followed by _iset . This leaves the
original title slide but adds five extra slides to the presentation. Save the presentation.

The second method used to create presentation slides is by inserting a new slide
into an existing presentation.

o

Task 164

Open the presentation that you saved in Task 16¢. Insert a new slide between slides 4 and 5.
This slide will contain the heading ‘Ease of use’, a chart and a bulleted list:

@ 86% of students found it easy to use
@ 120 students in the sample

Use this data to create a chart: Easy — 103, Difficult - 12, No response - 5. Show the
percentage of students in each category.

On slide 1, add the heading ‘Hints and tips’ and add the subheading ‘for IGCSE students’.

Set the following styles of text throughout the entire presentation:

@ heading: dark blue, serif, left aligned, 40 point
® sub-heading: blue, sans serif, centre aligned, 30 point
@ bulleted list: black, sans serif, left aligned, 24 point.

Save the presentation.

Open the presentation. Move into the left pane and select the Slides tab (if it is
not already visible). Click the cursor between slides 4 and 5 so that it flashes as a
horizontal line like this.

Select the Home tab and in the Slides section select the drop-
down menu for New Slide. Look at the different slide layouts
available from this menu and select the layout that matches the slide
you are going to produce. This slide needs a small bulleted list and a
chart, so the most appropriate slide type will be Comparison.

Office Themne

Tdle Grty
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Although the option for “Content with Caption’ looks correct, it is more difficult to
manipulate the caption box. Click once on this icon to get the new slide.

Delete both of the text boxes that say ‘Click to add text’. These are not needed in
this slide. To do this click on the line for the text box and press the < Backspace> or
<Delete> key. Use the drag handles to edit the two larger objects below them to
make them fit the available space. Move the title text box down, so it sits below the
blue line. The slide will change from this to this.

- UsimgcPowerRoint - : Using PowerPoint

§  iClicktoadd text Click to add text . . )
. Chckioaddtent .\ Clickto add test < Click to add title

- Clicktoadd text .+ Clicktoadd text

Click in the title text box and add the heading ‘Ease of use’. Select the left object
below the title. Click on the bulleted text ‘Click to add text’. This will change this
object into a text box. Type in the text ‘86% of students found it easy to use’,
<Return>, ‘120 students in the sample’, so that it looks similar to this.

It is sensible to complete all the text parts /
of this task together and then add the chart e
at the end. Move onto slide 1. Add the
heading ‘Hints and tips’ in the title text
box. In the subheading text box add the
text ‘for IGCSE students’ so that slide 1
looks like this.

Ouaming Tosic.,

Using PowerPoint

o Easeof use

86% of studznts Chickto add text
foundit rasy ta u:

i+ 120stadents in the |
. zamgle .

Presertven Yervicn 5 « Mratot Powerdomt - Drweng Tosks

T AR
B W B2

Using PowerPomt
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You may find it
easier to define all
the styles in the
master slides before
adding the
contents to any of
the slides. The
instructions given
in this task (and the
practical
examinations) may
not be in the
easiest order within
PowerPoint. It is
sensible to read
through the task
before starting. For
example, setting
the styles first may
save you a lot of
time later.
Remember that the
practical
examinations are
created for all
platforms and
many types of
software.

Select the View tab followed by Slide
Master and select the Office Theme
Slide Master (the top master slide).
Highlight all the text m the heading
(title) style and click the right mouse
button to obtain a drop-down menu and . Click to edit Master title
miniature toolbar to allow you to edit 3 e ST

« Clickto edit Master text styles
the text style. — second level

The heading style needs to be a dark “Thidlewe
blue, left aligned serif font; so select a e
serif font like Times New Roman, using
the font list. Use the Text Color icon to
select a dark blue colour and use the
Align Text Left icon to change the text
alignment. Use the drop-down list for
the font size to change it to 40 points.
The text box should now look like this. \

Using PowerPoin;.bb,L,f,L

in o EEEa
o

S

o TormatTen ey

B Famstsnape..

Use a similar method to set the first
level of the bulleted list, to a black sans
serif, left aligned font (no changes
needed for these parts), 24 points high.
Adjust the font sizes for the other levels
of bullet points so that they are smaller
relative to this one.

The sub-heading stvle is not visible in
this master slide, so you need to move
into the master slide for the Title Slide
Layout (the first master slide down).

In the master slide for the Title Slide
Layout, highlight the text for the Master
subtitle style and set this to a blue, sans \
serif, centre aligned, 30 point font. Use
the same method as you did for the
Master title style.

Move through cach slide master in
turn and edit any of the styles on other
page layouts that need to be set.

Select the View tab and the Normal
icon. Check each slide carefully to ensure
that the styles that you have changed
have been applied to each slide of the
presentation. If they have not been
applied, you can right mouse click on the slide background (not on an object) and
select Reset Slide from the drop-down menu to ensure that cach slide matches the
expected styles. You should not need to do this very often, but in this example,
because you imported pre-defined styles into the presentation, added a new page and
then set the styles, it may be necessary.

It is very important to make sure that all slides are consistent. A significant number of
marks are lost in the practical examinations by students who assume that the software
will format their slides correctly and do not check each slide carefully themselves.

This task is continued in the next section.

Click to edit Ma
— Second level
* Third level

— Fourth level
» Fifth level

Bctoroh Pogeoine. Draning tact

Using PowerPoint

{Click to edit Master tithe
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16.4 Creating a chart

Move into slide 5. In the task you were instructed to ‘use this data to create a chart:
Easy — 103, Difficult — 12, No response — 5. Show the percentage of students in each
category.” There are two ways of doing this: to create the chart within PowerPoint; or
to create the chart in Excel and then copy and paste in onto the required slide.

Creating a chart in PowerPoint

Click on the chart icon in the unused object on this slide. This opens the
Insert Chart window.

Insert Chart 5

Ease of ty

+ 26% of students

{ Bade 5 ot h ¢ Qiice Thomest \3h- Engiin Wsaed gt

You must decide which type of chart is the most appropriate for the task. In this
case, you are told to show the percentage of students in each category and therce is a
clue to the need for percentage
values in the bullet points on
the left of the slide. Because the
chart needs to show percentage || <%
values (parts of a whole), a pie

chart 1s the most approPriate ; Using PowerPoint
type of chart. Select a simple

pie chart from the available Ease of use

chart types and click on "o » -+ sesof sudents

foundt easy 1o use

This opens a default pie chart, - 1 stdencin
but does not use the correct ’

data. The slide should now look
like this.

lick to add notes

< Englin United Kingdony 10 ¢ 3

Blome
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As you can see, the chart does not
relate to the data for this task. Instead, it
1s about quarterly sales in a company. It
may also open an Excel spreadsheet like
this that contains the data. If this does
not appear, select the Design tab under
Chart Tools, find the Data section and B:m -
click on the Edit data icon. "3 andarr

Move into cell B and replace the e
label ‘Sales’ with the word ‘Students’. In =~ |I's
cell A2, enter the text ‘Easy’ so that it
replaces the existing text, in A3 type
‘Difticult’ and in A4 ‘No response’.
Replace the sales figures in B2 with 103,

in B3 with 12 and in B4 with 5. Delete the contents of cells A5 and B5. Drag the
blue range marker using the drag handle so that it includes cells Al to B4 only. It
should now look like this.

Using PowerPoint

Ease of use

* B86% of students ’ Students
foundit easy to use wasy
+ 120students in the N
z 8 C samale mOifcus ;oo
Students
103
12
| 4 INoresponse 5 7 to add notes

The slide now contains the correct chart. Close the spreadsheet containing the data.

inserting a chart into PowerPoint

The second way of placing a chart into the slide is to create a chart in Excel and then
insert this chart into the slide. This method 1s usually more flexible than the first
method, as it allows you to create and edit the chart before adding it to the slide.

Charts may be Open Excel and enter the data into cells Al to B3.
created from

3

s

contiguous or non- s TR

contiguous data and |1 | Easy 103

can have features | 2| Difficult 12

like titles, legends, |3 | No response 5

and labels for axes Using PowerPoint
and segments. All Select the Insert tab, and in the Charts

the features that section click on Pie Chart. Manipulate and Ease of use
you studied in label the chart as shown in Section 14.8. " seotyon
Chapter 14 can be o . D ™
applied o a graph (}opy thc chart and paste it into thc.shdc.

or chart before it is For this task you can paste it into slide 6.

cut and pasted into Resize both the chart and the text

the slide. containing the bullet point so that they do

not overlap. The completed slide will look
like this.
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16.5

Take great care
when entering
presenter notes. A
large number of
marks are lost in
the practical
examinations each
year through
careless data entry
in presenter notes.
Take great care
with the use of
capital letters and
punctuation.

You are going to create a short presentation for IGCSE students giving them hints on

website authoring. The medium for delivery will be a multimedia projector.

Create a master slide with a green background at the top (about % of the height) and at the
bottom of each slide (about s of the height) with a dark green horizontal line as a border
between the white and green backgrounds. Add two vertical dark green lines to the left of

the slide. Each line should be six points wide. It should look like this.

Include the heading ‘HTML’, right aligned in a black 40 point sans serif |

HTML

font at the top of the master slide (as shown above). include an
automated slide number in the green area to the left of the two vertical
lines. Make this a 14 point black sans serif font. Include your name right
aligned in the footer in the same style as the page numbering.

Set the following styles of text throughout the entire presentation: i

® heading: black, sans serif, left aligned, 40 point, within the green ‘header’ section

® subheading: red, serif, centre aligned, 40 point
® bulleted list: dark green, serif, left aligned, 32 point
@ level 2 bulleted list: dark green, serif, left aligned, 24 point.

Place a very small clipart image of a computer or peripheral in the bottom right corner of

the white space. Crop and/or resize the image so that it fits. Do not distort the image.

Import the file HTML.RTF, placing the text as slides in your presentation software. On slide 1,

add the heading ‘Hints and tips’ and add the subheading ‘for IGCSE and Level 2 students’.

Use this data to create a chart: Text editor - 42, FrontPage — 37, Dreamweaver — 31. Show
the percentage of students in each category. Insert this chart into slide 5 with the heading

‘Percentage of users from the survey'.

Adding presenter notes

Tasi

5]

P

Open the presentation that you saved in Task 16d. Add the following presenter notes to the

slides:

Slide 1: Welcome to this presentation giving you useful hints and tips on using Microsoft

PowerPoint for your IGCSE practical examinations.

Slide 2: The presentation that you are watching is made using PowerPoint.

Slide 4: Hyperlinks can be used to give different paths or to open external websites or

documents,

Slide 5: Graphs and charts can be added to enhance a presentation.

Open the presentation that you
saved in Task 16d. As you open

the presentation in Normal view,

it looks like this. Using PowerPoint

Move the cursor to the Notes
area of the screen. Click the
cursor into this box and type the
presenter notes for slide 1. Use
the Slides tab to select the next
slide and continue with this
process until all of the presenter

Hints and tips

for JGCSE

notes have been entered. Not all

of the slides have presenter notes.
These notes will not appear on

the slides when the presentation is run. You will learn how to print these so that the

presenter can read from them in Section 16.9. Save the presentation.
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16.6

It is easier
manipulate these
objects if the ruler
is showing. To
select the ruler,
select the View tab,
find the Show/Hide
section and click on
the tick box for
Ruler.

Using images

Opent
bottom of the final slide, above the blue line. Crop the image so that the red line and all
contents below it are removed. Resize the image so that it fits about 1 centimetre from the
left edge of the slide, 1 centimetre above the lower blue line and 1 centimetre to the left of
the vertical blue line, maintaining its aspect ratio. Adjust the brightness and contrast of the
image so that the background colour (pale yellow) is not visible.

In Task 16b, you inserted a new image from clip art into the master slide. For this
task, you are going to insert an image given to you as a file.

Open the presentation saved in Task 16e and use the Slides tab to open slide 7.
Select the Insert tab and then click on the Picture icon. This opens the Insert
Picture window. Search through the files until you locate SLOGAN.JPG, select the
file and click on to insert the image into the slide. Click the left mouse button on
the image and from the Format tab select click on-the Crop tool icon.

Using PowerPoint

Working with PowerPoint

Drag the lower handle up the screen above the red line, but below the red text,
to crop the image.
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Click the left mouse button off the image then back on it and drag the image
down so that the left and bottom edges are in the correct place on the slide.

Using PowerPoint

Now experiment

* Play with PowerPoint

. Try its features

Grab the top right drag handle and drag this to resize the 1mage to the correct
position to the left of the vertical blue line.
The image should now look like this.

¢ Have fun!

Workmg i PowerPoint |
s fun

To remove the pale yellow background colour

from this image, you need to adjust the image 5 | piawe M

brightness and contrast. Click the right mouse e | |
| . [ Lo stie erchmess:

button on the image and select Format Picture... | o - e

from the drop-down menu. This opens the Format —s 7> | fGaspe | ’

Picture window. Select the Picture option from the |#a=1
left side of the window. Move the sliders for the |
Brightness: and Contrast:, so that the pale yellow
background disappears but the other colours remain
unaffected. These figures are found using trial and
error: both settings change from 0% to a brightness ;
of around 35% and a contrast of cuound 7‘30/) When |/ 1
you have completed this, click on * Lo

#
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The slide should now look
like this. >
Notice how the red colour
in the text has changed from its

Using PowerPoint

original dark red colour (see Now experiment
the previous page) to this shade
of red. Save the presentation. - Play with PowerPoint

« Tryits features
* Have fun!

Working with PowerPoint
Is fum

S

6o

Open the presentation that you saved in Task 16f. Add:
@ an arrow to slide 5 pointing from the first bullet point to the largest segment of the pie
chart

@ a callout box to slide 6 telling the reader that the image of a computer is placed on the
master slide

@ the text ‘© Microsoft’ to the end of the first bullet point on slide 7 in a in a black, 12 point
sans serif font

@ a 6 point horizontal red line to slide 7, above the image you inserted in Task 16f.

Open the presentation and select slide 5 using the Slides tab. Select the Insert tab
and click on the Shapes icon. This drop-down menu of available shapes will appear.
Select an arrow to be included on the slide. Click the left ~

Recently Used Shapes w
mouse button where you want the arrow to start and B EY SRR A
drag the point of the arrow to the position that you AN
want it to finish. NNALLL L AR
~ v . . . _Reclangies
The finished slide should look like this. 58 Lt e e
Basic Shapes .
[ Wefatotolalolole

. v 4sleluls]
J O ADOQT GO

T : ™o 00014

Using PowerPoint

R RCRt e R e

Ease of use e

Flawchart
oo/

» 86% of students Students
found it easy to use

« 120students in the
sample

mEasy

Slwluile]

Stars and Banness

CEEP
Caljouts

wiwfeYe

@ Difficult

LAOES A e

#z No
respon
se

Action Buttons.
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To place the callout box on slide 6, select slide 6 and again select the Insert tab
and Shapes icon. This time select a callout box from the Callouts section of the
drop-down menu. Click on the slide and drag the callout box to draw it. It is easier
if you make the box too large and reduce the size later. When you have placed the
box, grab and drag the yellow handle to move the point of the callout box so that it

points to the image. /

srPoint 2rPoint ‘Point

Type the text that you require into the callout box (you cannot see the cursor as
you can with a text box) and then resize the callout box using the drag handles. It
may look similar to this.

Select slide 7. To insert the copyright symbol, click the left mouse button to place the
cursor after the °t at the end of the first bullet point. Select the Insert tab and click on
the Symbol icon. This opens the Symbol window. Scroll through the available list of

followed by Zdee”. Add the text ‘Microsoft” after the symbol and highlight both the
symbol and the new text. Set this to a black, 12 point sans serif font using the methods
learned carlier in the chapter.

Symbol
T Subcet: Lot Suppler
(BEHEEEREE - ORI RN
slzs el el e %% %l A
AlAJR|AJA|&lclElEle[E | T]T1]T,D
N0 6 O6|O|OIx|@|U|0I0|U|Y|p|RIa
|a]alda/alelce|elelei|i t]i]o
10616 8lel+lglululalulylply|A .
% Recently used symbals: ‘
olelelel¥[v]e|e[m|+]z][<|2]+]x]=
COPYRIGHT SIGN Character code: f00A9 | from: ;l;}){que (hex)E
¢ (st ] [cond ] )
S e e
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16.7

For the practical
examinations,
always use the same
transition effect
between slides and
the same animation
effect throughout
the whole
presentation.
Consistency in these
areas is just as
important as using
consistent styles and
colour schemes.

To insert the red line, select the Insert tab, then click on the Shapes icon and
select a line. Drag the line horizontally across the page. Click the right mouse button
on the line to open the Format Shape window. Use the Line color and Line style
sections to change the colour and thickness of the line. The completed slide should
look similar to this. Save the presentation.

Using PowerPoint

Now experiment

+ Play with PowerPoint owmcrason
¢ Tryits features
+ Have fun!

Working with PowerPoint
1§ fun

Transitions between slides

Open the presentation that you saved in Task 16g. Apply transitions between all slides in
your presentation. In slide 3 animate all the bullets so that they appear one at a time.

The transitions between the slides are the methods used to introduce a new slide. This
can be simply replacing the existing slide with a new slide or using a number of
different features to change from one to another. All transitions are Jocated in the tab.
Open the presentation. Select the Animations tab and find the Transition to
This Slide section. Hold the mouse over each of the slide transitions to see the
effect that it uses. There are more transitions available; you can use the scroll bar to
sce these.

Click on the icon to select the transition that you wish to use and then click on
the Apply To All icon to apply the same transition to all slides. This task is
continued in the next section.
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16.8

Animation effects

Select slide 3 and highlight only the bulleted list.
Select the Animations tab and find the 3 Animate: NQ Animation
Animations section on the left. Select the drop- ]
down list next to the Animate: icon, which will
look like this. The task instructed you to ‘animate
all the bullets so that they appear one at a time’,
so select Fade, Wipe or Fly In with By 1st Level
Paragraphs. This sets the animation.

§
3 Custom Al No Animation =
i MNo-Animation

Fade

All At Onee

By 1st Level Paragraphs

Wipe

It is a good idea to have the Custom T T Al At Once
Animation pane open, so that when you need to =% By 1st Level Paragraphs
show evidence of your animation effects these can = =+ = Fiyln
be seen. To do this, still in the Animations tab, All At Once
click on the Custom Animation icon. The —_|Byistlevel Paragraphs

. . st
button at the bottom of the Custom Animation Custom

pane allows you to test your animation and see if
it works as you intended. Each individual
animation can be edited in the Custom Animation pane by clicking on the item in
the pane and clicking the right mouse button to obtain the options. The order of
animation can also be changed by dragging the items up or down in the Custom
Animation pane list. Save the presentation.

Custom Animation...

h

g PowerPomt

Saving and printing a presentation

As with all your work, make sure that you save your presentations regularly using
the Office button and Save. To print evidence of your work, you must identify what
types of printouts are required. Sometimes you will be expected to print only the
slides, but more often you will need to print audience or presenter notes; for these
printouts you will need to select the Office button and Print. To print evidence of
the transitions and animations, screenshot evidence is the best method.

Open the presentation that you saved in Task 16h. Print your presentation showing:

® only the slides

® presenter notes

® audience notes with three slides per page and space for the audience to make notes
® evidence of the transitions between slides

@ evidence of the animations used on slide 3.
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Printing slides

Select the Office button and Print, to open the Print window. In the Print what:

drop-down list, select Stides. This will print only the slide/s content with no
additional notes or space. /

P~ T /

Printer

Name: @ \igig-vaio\HP Desklet S;&:/‘sﬂc/sﬂc Joo| 7] | Properties -

Staus:  Ide ) Find Printer...

Type: HP Desklet 840C/841C/8A42C/843C - - —

Where: LPT1: .

Comment: ¢ 1Print to file
% print range Copies

© Al I S ) Number of copies:

st |/ B

% Slides: 1 / 11

Enter slide numbérs and/or slide ranges. For example,

1,3,5-12

@] Callae

Print what; Handouts

“Sldes

4| |Notes Pages
“| [Qutline View

I scale to fit paper

Frame slides

o (o

Printing presenter notes

In the Print what: section, select Notes Pages. This will print the content of the
slides and the presenter notes that you typed in the Notes section for each slide.

Printing audience notes

In the Print what: section, select [prin:
Handouts. This will give you
several options~ to sclect from. Neme: i \pigmvio P Deset scisiC ey (<] [ Boperies |
The task asks for three slides per status: e = mg\
page, so in the Slides per page Tipe: P Deslet 3RC/BHIC/C/C R —
section, select the number 3 from || comment: FJPrint to fie
the drop-down list. The small | printrange Copies
image to the right shows you NN i
what the printed pages will look ;
like. In this case, the three slides £ sies:

~ Enter slide numbers a2t
are to the left and space to make 1,3,5-12
notes on the right. This matches

Printer

Mumber of copies:

{or slide ranges. For example,

¥} Colfate

. - Print what: Handouts

the requirements of the task. S _ —

. Handouts Slides per page L=

You can click on = freves to Colorfaraysceles: %E

. . oot — — 3 =

check the printout is as you oo

ntended before printing or click |
on o to print.

t m;;‘iew B
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Printing evidence of slide transitions

Select the View tab and click on the icon for Slide Sorter view. Use the <Print
Screen> key on your keyboard to copy this into the clipboard and paste the image
into a word-processed document so that you can add your name and other details
before sending it to the printer.

Cal Sy
et By Chedage
Hew

Using PowerPamt

You can see from the Slide Sorter view the evidence that transitions have been
added to each slide.

Printing evidence of animations

Select the View tab and click on the Normal icon to return to the Normal view of
the slides. Select slide 3. Make sure that the Custom Animation pane is visible to
the right of the slide. If it is not visible, open it using the Animations tab followed
by the Custom Animation icon. Use the <Print Screen> key on your keyboard to
copy this into the clipboard and paste the image into a word-processed document so
that you can add your name and other details before sending it to the printer.

Using PowerPoint

What objects can be used

* Text
+ Staticimages

= Movingimages

* Graphs and charts
* Sound

+ Transitions

* Animations

The numbering next to each bullet point shows that each bullet is animated
separately from the others. Further detail about the animation of bullet point 1 can
be seen in the Custom Animation pane. If the individual bullets are not visible,
click on the icon in the Custom Animation panc to pull down the list.
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Activity 16b

Open the presentation that you saved in Activity 16a.
Add the following presenter notes to the slides:

@ Slide 1: Welcome to my presentation giving tips about website authoring using html.

@ Slide 4: An intranet is internal within an organisation and is managed. The internet is
global and is not managed.

@ Slide 6: There are many other websites that can offer you help.

Place the image WEBSITE.JPG on the right side of slide 6. Crop this image so that only the

crest and name are visible like this.

UNIVERSITY of CAMBRIDGE
J International Examinations

Add a red arrow, 3 points wide, from the text ‘CIE website’ to point to this image.

Apply transitions between all the slides in your presentation.

In slide 3 animate all the bullets so that they appear one at a time, in the order that they are
in the list.

Print the presentation showing:

@ presenter notes

@ audience notes with six slides per page

@ evidence of the transitions between slides
@ evidence of the animations used on slide 3.
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50

89

BIOS (basic mput/output system) 3

blogs (web logs) 67

bluetooth 41

blu-ray disks 34-5

body section, webpages 229-30

bold text 139

booking systems, online 88

Boolean fields 152

Boolean (logical) data 50-3

boot file 3

bridges 42

broadband modems 42, 45

bulleted lists  140-1
webpages 244

bus networks  38-9

buzzers 27

cable modems 42, 45
callout boxes 286
camera images 1234
cascading stylesheets 23642
aligning text 239
classes 241-2
enhancing text 24041
font-families 236-7
font size 237-9
cathode ray tube (CRT) monitors 21
Cc: box, email 108-9

CDhs 32-3
cell padding  259-60
cells

spreadsheets 188
tables 145-7
HTMI 259-61
cell spacing 261
central processing unit (CPU) 3
centre aligned text  147-8
changeover methods  98-100
character checks 97
charts 218-21
colour and shading  225-6
insertion into word-processed documents
modification 221-2
in presentations  280-81
printing 186
secondary axes 2234

182



check digits 87, 97
chemical processes, control 84
chip and PIN system 9, 14, 90
classes, cascading stylesheets 241-2
clipart 122, 275-6
club records, databases 76
CMOS (complementary metal oxide
semiconductor) 3
CODEC 48
colour
in documents 139
in graphs and charts 225-6
printing  184-5
in spreadsheets 212
in webpages  245-50
COLOURCODES webpage 245, 246
column breaks 134
columns
in spreadsheets 188, 216
in tables 143, 144, 146
HTML 259
of text 135-6
command line interfaces (CLIs) 4
comma separated values (.csv) files 117
communication methods 48-9, 71-3
satellite and mobile network technology  73-5
complementary metal oxide semiconductor
(CMOS) 3
computer aided design (CAD), graphics tablets 20
computer name, URLs 44
computer systems, main components 2-3
computer types 57
concept keyboards 9
consistency checks 97
contacts, email 107, 110
control applications
turtle graphics 81
use of sensors 824
control devices 26-7
control systems 58
cookies 67
copy, paste and delete 121
copyright rules, software 59-60

COUNTA function 198
COUNT function 198
COUNTIF function 199
country codes 44
cropping images 129

current folders, webpages 262
cut and paste 121

data
access methods 29
analogue and digital 57-8
testing 98

data backups 28-9

databases 54, 151
combination with word-processed documents
179-80
creation from existing files 153-6
data entry 156-7
evidence for examinations 179-80

field types 151-2
label production
printing 186
queries 158-61
using formulae
reasons for use
relational  55-7
reports 161-6
exporting data  166-7
hiding data  167-9
using formulae  173-6
sorting data  176-7
data entry
databases 156-7
spreadsheets 190
data handling applications
club and society records 76
surveys 75
tuck shop records 76
data models 187, 189-91
see also spreadsheets
data protection act  76-7
data structures 54
data types 50-3
date data 53
design stage, systems analysis 95-7
desktop computers (PCs) 5
development of systems  97-8
dial-up modems 42, 45
digital cameras 17-18
digital data 57
digital media sharing websites 68
digital subscriber line (IDSL) internet access 44-5
digital to analogue converters (DACs) 25, 58, 82
direct access 29
direct changeover 99, 100
documentation of systems
documents
columns

169-71

171-3
54-5

100-1

135-6
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documents (continued)
data entry from existing files 118-19
editing text  120-1
emphasising text 13940
error correction 150
font styles and sizes 137-8
formatting pages 130-1
headers and footers 131-3
images
cropping 129
importing 122-4
resizing 125-6
text wrapping 126-9
keying in text 120
line spacing 148-9
lists 140-2
page, section and column breaks 134-5
tables 143-7
text alignment  147-8
windows and orphans 1334
domain name and type, URLs 44
dongles 35
dot matrix printers 24
double entry verification checks 95
draft copies 185
drag and drop 121
DVDs 324

echo cancellation software 48

editing text 120-1

electrically erasable programmable read only
memory (EEPROM) 36

electrocution risk 70

clectronic fund transfer (EFT) 90

electronic point of sale (EPOS) terminals 9, 86

electrostatic plotters 25
email 44,48, 104
accounts 110
attachments 112
ctiquette 106
hyperlinks 254
opening your mailbox 104-5
organising mail  105-6
phishing 66
receiving mail 112
screenshots 186
sending mail 107-8
spam 66
email addresses 44
embedded objects 118
embedded web technology (EWT) 74

employment, impact of ICT 61-2
encryption 46-7, 61
enhancing data
charts 225-6
spreadsheets 212
enhancing text 13940
webpages  240-1
environmental monitoring 83
ergonomic keyboards 8
error correction
databases 157
documents 150
evaluation of systems 101
Excel see spreadsheets
expert systems  92-3
extreme data 98
eyestrain 69

Facebook 68
fact finding 95, 96
fax (facsimile) 48
feasibility studies 94-5
fields 54, 151
changing field types and properties
field types, databases 151-3
filenames, URLs 44
files
databases 151
email attachments 112
structure 54
version numbering 183
file servers 37
fire risk 70
firewalls 61
fixed hard disk drives 30
flash memory 35-6
flat file structure 54, 56
Flickr 68
floppy disk drives 31
flyers 72
folksonomies 68
font-families 236-7
fonts 137-81
tont size, webpages 237-9
footers
database reports 163
documents 131, 132-3
HTML tables 256-8
presentations 2745
format checks 97
format painter 140

155-6
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tormatting cells, spreadsheets  213-15
tormatting pages 130-1
tormulae
in database queries 171-3
in database reports  173-6
spreadsheets 188, 190, 191-2
nesting 201
tully justified alignment 147-8
functions 194-200
LOOKUP functions 2024
nested 201
SUMIF 202

generic file types 117

global positioning satellite (GPS) systems
(sat navs) 74-5

grammar checks 150

graphical user interfaces (GUIs) 4-5

graphics tablets 20

graph plotters 25

graphs see charts

greenhouses, environmental control 834

groups, email contacts 110

hacking 60-1
hard disk drives 3, 30
hardware 2

safety considerations 70
headaches 69
headers

database reports 163

documents 131-2

HTML tables 256-8
head section, webpages 229-30
health and safety issues  68-70
heaters 27
height of fonts 137
hexadecimal counting system 245-6
hiding data, database reports 167-9
HLOOKUP function 203
hospitals, use of sensors 82
host name, emails 44

household devices, microprocessor-controlled 645
HTML (HyperText Markup Language) 228-30

adding comments 243

colour 245-50

enhancing text 233

images 262-7

lists  243-5

opening existing webpages 232

saving files 231
styles 234
stylesheets 23442
tables 255-62
text formatting 230, 233
see also webpages
HTTP proxy servers 43
hubs 39, 42
humidity sensors 19
hyperlinks 44, 250
trom images 267
to other webpages 252-3
to send email messages 254
within webpages 251-2
HyperText Markup Language see HTML

IF function 200
images

cropping 129

file types 267

in HTML 262-6

hyperlinks from 267

importing 1224

in presentations 283-7

resampling 2667

resizing 125-6, 264-6

text wrapping 126-9
implementation of systems 98-100
importing objects  122—4, 178-9
indents

lists 141

paragraph settings 149
induction loop sensors 78
inference engines/inference rules 93
information reliability, internet 65
infrared, use in WLANs 40
inkjet plotters 25
inkjet printers 23—4
input devices 2, 8-21
nserting images 124
integer fields 152
integrated documents 178-82
internet 43, 113

access 445

control 634

cookies 67

reliability of information 65

search engines 114-16

security issues  66-7

URLs 113
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websites 434 memory 3
undesirable 65 memory sticks  35-6
see also HTML (HyperText Markup Language); mice 9-10
webpages microphones 18-19
internet developments 67-8 microprocessor-controlled devices 64-5
internet service providers (ISPs) 44 microprocessors 3
interviewing, fact finding 96 MIN function 196
INT function 197 mobile phone networks 734
intranets  45-6 modelling applications 77-80
italics 139 modems 41-2
moisture sensors 19
job queues 80 monitoring applications 82-3
joysticks 12 monitors 21-2
morphing 73
keyboards 8-9 motors 26
key field 54 multimedia presentations 72
kinowledge base 93 multimedia projectors  25-6
music production 73
labels Myspace 68
production from databases 171
spreadsheets 188 neck problems 69
laptop (notebook) computers 6 nested formulae and functions 201
monitors 22 nested lists, webpages 2445
laser pointers 25 : netbooks 6
laser printers  22-3 network devices 41-3
ozone irritation 69 network hubs 39, 42
left aligned text 147-8 networks 37
length checks 97 bluetooth 41
library systems 91 communication methods 48-9
light pens 20-1 intranets  45-6
lights 27 local area networks (LANs) 37-9
light sensors 19 mobile phone technology 73-4
limit checks 97 wide area networks (WANs) 41
line graphs 218, 220-21 WiFi 40-1
line spacing 148 wireless LANs (WLANs) 40
lists  140-2 see also internet
on webpages  243-5 network security 46-7
local area networks (LANs) 37-9 normal data 98
bridges 42 numbered lists 140, 142
logical (Boolean) data  50-3 webpages 243
LOGO 81 number filters 206-7
LOOKUP functions 2024 numeric data 53
numeric fields 151-2
magnetic ink character recognition (MICR) 17 numeric keypads 9
magnetic stripe readers 13
magnetic tapes 29, 31-2 observation, fact finding 96
mainframe computers 7 online booking systems 88
master slides 269-75 online processing 80
MAX function 196 online shopping and banking 62-3

media access control (MAC) addresses 42 operating systems 3—4




optical character recognition (OCR) 16, 75
optical mark recognition (OMR) 16, 75
optical mice 10

optical storage media  32-5

ordered lists, webpages 243

OR operator  52-3

orphans 133-4, 150

output devices 2, 21-6

oxygen level monitoring, rivers 83

ozone irritation 69

page breaks 134
page layout 130-1, 216-17
page numbers, automated 132
paper-based presentations 72
paperwork, fact finding 96
paragraph setting 141, 148-9
parallel running 99, 100
passwords 46, 61
paths, URLs 44
payrolls, batch processing 86
PCs/desktop computers 5
pen drives  35-6
pen plotters 25
personal digital assistants (PDAs) 6-7
pharming 66
phased implementation 99, 100
phishing 49, 66
photography, digital cameras 17-18
pH sensors 19
picture checks 97
pie charts 218, 220
pilot implementation 99, 100
piracy, software 60
pixels 22
plotters 25
points, font sizes 137
policing of the internet 63—4
portable hard disk drives 30
posters 72
PowerPoint see presentations
presence checks 97
presentations 72, 269
animation effects 288
charts 280-81
creating slides 276-8
evidence for examinations 290
images 283-7
clipart 275-6
master slides 269-75

presenter notes 282
saving and printing 288-90
transitions between slides 287
presenter notes 282, 289
pressure sensors 19
primary key 54
printers 22—4
printer servers 37
printing 184-6
processing types  80-1
programming, robots 85
proofreading 150
protocols, URLs 44
prototypes, 3D inkjet printers 23
proxy servers 37

queries, databases 158-61, 162
using formulae 171-3
questionnaires 75
fact finding 96
QWERTY keyboards 8

radio buttons 47
random access memory (RAM) 3
DVD-RAMs 334
range checks 97
read only memory (ROM) 3
CD-ROM and DVD-ROM 32
real-time process control  80-1, 824
real-time (transaction) processing 80, 81
record keeping 77
records 151
relational databases 55-7
remote controls 11
repetitive strain injury (RSI) 69
replying to email 111
reports 161, 177
databases 162-5
exporting data  166-7
hiding data  167-9
using formulae  173-6
resampling images 2667
resizing images 125-6, 2646
rich text format (.rtf) files 117
right aligned text  147-8
ring networks 38
rivers, oxygen level monitoring 83
robotics 85
robust passwords 61
ROUND function 197
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routers 42-3
rows

spreadsheets 216
tables 143, 144
rules base 93

safety issues 70
sans serif fonts 137,236
satellite communication, GPS systems (sat navs)
74-5
saving documents
formats 184
version numbering 183
scanners 14-15
scanning images 123
screenshots  179-80, 185
webpages 268
search engines 114-16
information overload 65
searching databases 158-61
secondary axes 223-4
secondary storage devices 2
section breaks 134, 135
security
ATMs 89
databases 55
data protection 76-7
encryption 46-7, 61
internet 667
online shopping and banking 63
networks 46-7
software protection 35, 60
VOIP 49
selectors 236
sensors  19-20, 58
applications 82-4
in robotics 85
serial access 29, 31
serif fonts 137, 236
servers 37
shopping, online 62-3
simulations 77-80
site addresses 44
slides, creation 276-8
shide transitions 287, 290
smart cards 13-14
social networking sites 68
society, impact of ICT  61-5
society records, databases 76
software 2
copyright rules  59-60

solid state backing store 35-6

sorting data 176-7
spreadsheets 210-12

sound sensors 19

spam 49, 66

speakers 25

spell checks 150

spreadsheets 187-8
display features 212-17
formulae 190, 191-2
functions 194-200
named cells and ranges 193-4
nested formulace and functions
saving and printing 217-18
searching

using more than one criteria  207-8

using number filters 206-7
using text filters 205-6
using wildcards 208-10
sorting data  210-12
testing data models 204-5
tuck shop model 76, 77-8
see also data models
spread spectrum technology 40
spyware 67
star networks 39
stock control systems 86-8
stylesheets 234-3
table styles 258-9
SUM function 194-5
SUMIF function 202
surveys 75
switches 39, 42
systems analysis  94-5
systems design 95
systems development 97-8
systems documentation 100-1
systems evaluation 101
systems implementation 98-100
systems software 2
systems testing 98

tables 118-19, 143-7

in HTML 255-62

placing images 263-4

in relational databases 53—4
tag clouds 68
tagging 68
target attributes 253
technical documentation 100-1
temperature sensors 19
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testing systems 98
text alignment 147-8
webpages 239
text data 53
text fields 151
text filters  205-6
text (.xt) files 117
text wrapping 126-9
thin film transistor (TFT) monitors 22
tomography 23
touchpads 10
touch screens 5, 12
trackerballs 11
traffic, data collecuon 78
traffic light simulation  78-9
transaction (real-time) processing 80
tree networks 39
trip hazard 70
tuck shop model, spreadsheets 76, 77-8
turtle graphics 81
tweening 73
type checks 97

underscoring 140
universal serial bus (USB) connectors 17
uniform resource locations (URLs) 44, 113
user documentation 100
user IDs 46, 61
user interfaces 4-5
systems development 98
user name, emails 44

validation 95, 97
verification 95

video conferencing 49-50
virtual mice 25

viruses 28-9, 60

in email attachments 112

pharming 66
visual verification checks 95, 157
VLOOKUP function 2034
voice over internet protocol (VOIP) 49
voice recognition software 19

war driving 41
Web 2.0 67
web browsers 43
webcams 18
webpages 43
evidence for examinations 268
see also HTML (HyperText Markup Language)
websites 43-4, 227
importing objects 178-9
undesirable 63, 65
use in communication 72-3
‘what if” scenario (‘what if modelling) 187
wide area networks (WANs) 41
Wik 40-1
Wikipedia 68
wikis 68
wildcard searches
databases 160-1
spreadsheets  208-10
widows 133-4, 150
windows icons menu and pointing device
(WIMP) 4
wireless local area networks (WLANs) 40
wireless personal area networking (WPAN) 41
world wide web (WWW/web) 43

YouTube 68







